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Introduction

This tutorial teaches you how to maintain a payroll application written in ILE RPG
using the Remote System Explorer.

You will learn how to start the product and open the Remote System Explorer
perspective, use tools and views in this perspective to connect to an iSeries’"
system and edit, verify, compile and debug a payroll application.

Prerequisites

To complete this tutorial, you should be familiar with:

* Basic Microsoft® Windows® operations such as working with the desktop and
basic mouse operations such as opening folders and performing drag-and-drop
operations.

It will also help if you understand:
+ ILE RPG
+ DDS

The file(s) required for this tutorial are available for download at
http:/ /ibm.com /software/awdtools/wdt400/library.

Time required

To complete the modules of this tutorial, you will need approximately 3 hours.
Learning objectives

This tutorial is divided into eight modules, each with its own learning objectives.
You can choose to skip modules 7 and 8 and you can complete modules 5, 6, 7 and

8 in any order after module 4. Each module contains several exercises that must be
completed in order for the tutorial to work properly.

Chapter 1, “Module 1. Starting the product and the Remote System Explorer,” on|
page 1] teaches you about the workbench, a perspective, and specifically the
Remote System Explorer perspective. In this module, you will:

e Start the product
* Specify the workspace for your project resources
* Open the iSeries default perspective

Chapter 2, “Module 2. Configuring a connection to an iSeries system and|
connecting to an iSeries,” on page 7] teaches you how to create a connection to an
iSeries server and select objects using the Remote System Explorer perspective. In
this module, you will:

* Create a connection to an iSeries system

* Connect to an iSeries system

* Add a library to your library list

* View libraries in your job’s library list from the Remote Systems view
* Find a source physical file in you library
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* View members in a source physical file using the iSeries Table view

* Customize the columns in the iSeries Table view

* Open a member for edit from the iSeries Table view or the Remote Systems view
* Maximize the editor window

* Open another member for edit

* Switch from one edit session to another edit session

 Display a structural outline of items defined in a source member

[Chapter 3, “Module 3. Editing source,” on page 25| teaches you how to use the
Remote Systems LPEX Editor to edit source. In this module, you will:

¢ Change the default settings of the LPEX Editor Parsers
* Change the color settings and font used by the Editor
¢ Change the default behavior of the Enter key

* Use SEU commands to edit source

¢ Undo and redo source changes

* View language sensitive help for the MOVE operation code

* View a list of all help contents

e Limit the search of help to specific documents

 Search the help

* Request a prompt for a specification line

* Display context sensitive help for any field in the iSeries Source Prompter
¢ View the beginning and ending of constructs in your source

* Use the Find and Replace window to search for an item in your source
* Filter or subset your source

* Filter lines based on line type

* Search through members in a source physical file

* Compare different versions of a program and identify the differences

* Syntax check source by line

* View help on syntax errors

[Chapter 4, “Module 4. Verifying and compiling source,” on page 63| teaches you
how to verify and compile source in the Remote Systems LPEX Editor. In this
module, you will:

* Check for semantic errors on your workstation

e Start the Program Verifier tool

* Use the iSeries Error list to locate each error in the source
* Use content-assist to fix an error

* Save your source

* Re-verify source

* Change compile preferences

¢ Invoke the compile command

* Change the current library using the Command field in the iSeries Table view
* Start an interactive connection

* Invoke the payroll program

[Chapter 5, “Module 5. Debugging a program,” on page 79 teaches you how to
debug your payroll program from the workstation. In this module, you will:
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Invoke the debugger from the Launch Configurations window
Add a breakpoint

Add a conditional breakpoint

Edit a breakpoint

Monitor a variable through the Monitors view
Step into your payroll program

Show a listing view

List the call stack entries in the Debug view
View all breakpoints

Remove a breakpoint

Monitor storage

Set a watch breakpoint

Close the Debugger

[Chapter 6, “Module 6: Exploring Remote System Explorer,” on page 107] teaches

you how easy it is to define filters, perform actions and define your own actions.
In this module, you will:

Know the features of Remote System Explorer
Create a filter to show specific iSeries libraries
Change the filter to add more iSeries libraries

Create a filter to show all the source files in a library
Access members to edit from your filter

Create a user action that copies a source file with data to a new source file in the
same library

Specify user action parameters

Specify a restriction on a user action

Try the user action

Run an 0OS/400® command from the iSeries Table view

[Chapter 7, “Module 7. Designing screens,” on page 125/ teaches you how to use

CODE Designer to modify a display file. In this module, you will:

Open a DDS member for edit with CODE Designer

Show file-level keywords and record-level keywords

View the details of records, record-level keywords and field-level keywords
View the design of the payroll application main menu

Create a group from an existing record format

Create a new group and add a subfile record and a subfile control record
Add columns to the subfile record

Add fields to the subfile control record

Copy existing fields

Set indicators to handle field errors

View and update record and field properties

View keywords and the properties of a keyword

Insert a keyword

View help for a keyword

Check there are no semantic errors in the DDS source
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View help for an error

Launch the editor in read mode from the error list
Launch the editor in write mode to fix the error
Find a keyword in the source

Save source changes

Compile your source changes

Close the Designer

Chapter 8, “Module 8. Introducing the product and Remote System Explorer]

(optional),” on page 151]teaches you about IBM® WebSphere® Development Studio

Client for iSeries and describes its relationship to IBM WebSphere Development
Studio for iSeries. In this module, you will:

Know the goals of the product

Know the editions of the product

Identify the host tools and the client tools

List and describe the iSeries application development tools

When you are ready, begin [Chapter 1, “Module 1. Starting the product and the

[Remote System Explorer,” on page 1]
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Chapter 1. Module 1. Starting the product and the Remote
System Explorer

This module teaches you about the workbench, the workspace, a perspective and
specifically the Remote System Explorer perspective.

In this module, you will:

* Start the product

* Set the default workspace

* Access unique tools and views targeted towards iSeries application development
tasks

Requirement: Before beginning this module, you should have the prerequisite
knowledge outlined in [“Introduction” on page v |

Exercises

The exercises within this module must be completed in order:

* [“Exercise 1.1: Starting the product”|

+ |“Exercise 1.2: Opening the Remote System Explorer perspective” on page 3|

Time required

This module will take approximately 10 minutes to complete.

Exercise 1.1: Starting the product

If you want to know more about the product before you get started you can read
Chapter 8, “Module 8. Introducing the product and Remote System Explorer|
(optional),” on page 151 |

First you must start the product. Follow these steps to start the product:
1. Click Start on the task bar of your desktop.

2. Select Programs > IBM Rational® > IBM WebSphere Development Studio
Client for iSeries V6.0 > WebSphere Development Studio Client for iSeries

'; IEM WebSphere Development Studio Client For iSeries W60 M@  WebSphere Development Studio Client for iSeries

If you are working with the Advanced Edition of the product you will see the
words Advanced Edition in the product name.

3. A dialog will appear. Here you specify the directory of the workspace where
your projects and other resources such as folders, subfolders and files that you
are developing in the workbench will reside.

© Copyright IBM Corp. 2001, 2005 1



Workspace Launcher

Select a workspace

16M Rational Software Development Platform stares your projects in a directory called a workspace.
Select the workspace directory to use for this session,

Workspace: I C:\Documents and Settings)Administrator|IEM\rationalsdpé, Oy selabed El Browse...

I™ Use this as the default and do not ask again

I A

4. (Optional) Change the field in this dialog and use a unique directory name, for
example, RSELABxx (where xx is a unique number).

5. Click OK to open the workbench.

Rational Software Development Platform
X

6. Click the icon in the far right of the Welcome page to go to the Workbench.

2 Development Studio Client: RPG application



@ Remote System Explorer - IBM Rational Software Deyelopment Platiorm = |g| X[:

File Edit Mavigate Search Project Run  Window Help

opment Platform

Workbencn
Go to the workbench

7. Click the maximize button to maximize the workbench.

File Edit Mavigate Search Project Run Window Help

]rj' Al J%'O"%' ],’9 5 | EBremote Syste...
| 4

fngemoteS... XA Teaml =g| (S-?.\\:E

; 3 *“t? eb? Wel to the Rati |
not available.
- l 5 s | = elcome 1o the nationa

A v
5 & NewConnection Software Development

G-l Seris.. Platform
'_ ,j ¥ ] '\Aﬁndm\ls
©ome ) Lnux...
@y Power Linux... Dvemew
i UNiX, .‘)
By AIX., :
B Localic '
= I;? Local

8. Click the X in the Welcome tab to close the Welcome view.

The workbench refers to the desktop development environment. The workbench
aims to achieve seamless tool integration and controlled openness by providing a
common paradigm for the creation, management, and navigation of workbench
resources. Each workbench window contains one or more views and an editor.

You have started the product and now you are ready to begin
[Opening the Remote System Explorer perspective.”|

Exercise 1.2: Opening the Remote System Explorer perspective

Before you begin, you must complete [“Exercise 1.1: Starting the product” on page|

In these steps you will open the Remote System Explorer perspective.

1. Check for the name of the perspective.

File Edit Mavigate Search Project Run Window Help

[[RIIENE"RY, 37 | =
]&mtinezz =8
|nnouli'|eisndtavaiabls.
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A perspective defines the initial set and layout of views in the Workbench
window. Within the window, each perspective shares the same set of editors.
Each perspective provides a set of capabilities aimed at accomplishing a specific
type of task or working with specific types of resources. For example, the Java™
perspective combines views that you would commonly use while editing Java
source files, while the Debug perspective contains views that you would use
while debugging a program. Perspectives contain views and editors and control

what appears in certain menus and tool bars.

If you see a different perspective, not the Remote System Explorer open in the

workbench or no perspective:

2. Click Window > Open Perspective > Remote System Explorer from the

workbench menu.

2@:Remnte System Explorer - IEM Rational Software Developm
File Edit Mavigate Search Project Runfll Window |

|3 -0 - Q-

Help

T Window

Open Perspective

EEiSeries Projects
ahow Yigw

Reset Perspective
Close Perspective
Close All Perspectives

E - (B Windows, .

Cusktomize Perspective...
Save Perspective As..,

ﬁ Lirnee,..

- Y Power Linus..., Mavigation
i L Preferences
W ATY

=10l x|
| ERemote Syste...

U= Qutling 52 = O

n outline is not available,

The Remote System Explorer perspective opens.

You work in the Remote System Explorer perspective in the workbench. This
perspective is for an iSeries programmer to display the connections that you
have already configured, create a new connection, connect to and disconnect
from the connections that you have defined, work with iSeries files, commands,

jobs, and integrated file system files.

This perspective will be active when you start the product with a new
workspace. If you had used the workspace before then, the workbench would
come up with the perspective that you last opened. You will learn more about
the Remote System Explorer perspective in the coming exercises as this is
where you launch the iSeries programmer tools and use the views from the

workbench.

Now you are ready to review your knowledge of this module by taking the quiz.
You can also apply what you have learned in this module by completing the

practice tasks detailed in More practice.

Quiz

1. A workspace:

a. Aims to achieve seamless tool integration and controlled openness by
providing a common paradigm for the creation, management, and

navigation of workbench resources.

Defines the initial set and layout of views in the Workbench window.

Refers to the desktop development environment.

d. Specifies where your projects and other resources such as folders, subfolders
and files that you are developing in the workbench will reside.
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2. A workbench:

a. Aims to achieve seamless tool integration and controlled openness by
providing a common paradigm for the creation, management, and
navigation of workbench resources.

Defines the initial set and layout of views in the Workbench window.
C. Refers to the desktop development environment.

d. Specifies where your projects and other resources such as folders, subfolders
and files that you are developing in the workbench will reside.

e. Aand C
3. A perspective:

a. Aims to achieve seamless tool integration and controlled openness by
providing a common paradigm for the creation, management, and
navigation of workbench resources.

b. Defines the initial set and layout of views in the Workbench window.
Refers to the desktop development environment.

d. Specifies where your projects and other resources such as folders, subfolders
and files that you are developing in the workbench will reside.

4. Match the perspective with its correct definition:

a. Combines tools and views that you would commonly use while editing Java
source files

b. Contains tools and views that you would use while debugging programs

Contains tools and views that you would use while developing Web
applications

d. Contains tools and views that you would use while maintaining iSeries
applications.

Java perspective
Web perspective
Remote System Explorer perspective

aoop

Debug perspective

5. In the Remote System Explorer perspective you can:
a. Display configured connections

Create a new connection

Connect and disconnect defined connections

Work with iSeries files, commands, jobs, IFS files

All of the above

® oo o

More practice

Given your experience in opening the Remote Systems Explorer perspective, now
open the Web perspective. See the list of tools and views available to the Web
developer. Next open the Java perspective. See the list of tools and views available
to the Java developer. Now since you are supposedly in the Java perspective, open
the Web perspective. Be careful not to open another Web perspective.

Tip: Look in the workbench top-right frame for the Web perspective icon. Now
close both the Java perspective and the Web perspective.

Module recap

Chapter 1. Module 1. Starting the product and the Remote System Explorer 5



You have completed [Chapter 1, “Module 1. Starting the product and the Remote]
[System Explorer,” on page 1]You have learned how to:

* Start the product
* Set the default workspace

* Access unique tools and views targeted towards iSeries application development
tasks

Now that you have started the product and have opened the Remote System

Explorer perspective, you can move on to getting connected to an iSeries system.
Continue to [Chapter 2, “Module 2. Configuring a connection to an iSeries system|
fand connecting to an iSeries,” on page 7.
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Chapter 2. Module 2. Configuring a connection to an iSeries
system and connecting to an iSeries

This module teaches you how to create a connection to an iSeries server, find a
library in your library list, select objects from a library and finally open a member
in the Remote Systems LPEX Editor. You also learn about several views such as the
Remote Systems view, iSeries Table view, and the Outline view.

In this module, you will:

* Create a connection to an iSeries system

* Connect to an iSeries system

e Add a library to your library list

* View libraries in your job’s library list from the Remote Systems view
* Find a source physical file in your library

¢ View members in a source physical file using the iSeries Table view

* Customize the columns in the iSeries Table view

* Open a member for edit from the iSeries Table view or the Remote Systems view
* Maximize the editor window

* Open another member for edit

* Switch from one edit session to another edit session

* Display a structural outline of items defined in a source member
Exercises

The exercises within this module must be completed in order:

* |“Exercise 2.1: Configuring a connection to an iSeries system”

* [“Exercise 2.2: Connecting to an iSeries system” on page 10|

* |“Exercise 2.3: Viewing and accessing objects in the Remote System Explorer|
perspective” on page 14|

+ |“Exercise 2.4: Opening a second source member” on page 20|

* |“Exercise 2.5: Displaying an outline of a source member” on page 20|

Time required

This module will take approximately 10 minutes to complete.

Exercise 2.1: Configuring a connection to an iSeries system

When you first open the Remote System Explorer, you are not connected to any
system except your local hard drive on your workstation. To connect to a remote
iSeries system, you need to define a connection. When you define a connection,
you specify the name or IP address of the remote system and you give your
connection a unique name that acts as a label in your workspace so that you can
easily connect and disconnect. When you connect to the iSeries system, the
workbench prompts you for your user ID and password on that host.

© Copyright IBM Corp. 2001, 2005 7



The first time you connect to an iSeries system, you need to specify a profile. All
connections, filters, and filter pools belong to profiles. Filters are described in a
later exercise. Profiles are discussed when you create your first connection.

Ok, let’s get started. Remember you have already opened the Remote System

Explorer perspective in the previous module.

1. In the Remote Systems view, New Connection is automatically expanded to
show the various remote systems types you can connect to through the Remote
System Explorer.

.1 Remote S stems X

b ﬁ Power Linux...
Unix UNECL

e ALR..

. ®-E Local...

& E}' Local

B 58w

Click the plus sign + beside iSeries to configure a connection to an iSeries
system.

The Name personal profile page opens.
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x

Name personal profile

Uniquely name user profile | I

Welcome to Remote Systems, Connections can be sharable by the team or private to
you. Enter a profile name to uniquely identify you from your team members. You wil
decide for each new connection whether it is owned by the team profile or your
prafile,

Profile; | msteckh7tp

< Back MNext = Finish | Cancel I

2. Click Next to accept the default value.
The profile defaults to the name of the workstation. Your profile will be

different from the one shown here.

The Remote iSeries System Connection page opens.

x

Remote iSeries System Connection

Define connection information | I

Parent profile: |m9tedd1?tp j

Connection name: |S4ﬂDa

Host name: | 54003 —ﬂ

Description: |

[V Werify host name

L

< Back I Next > t@, Cancel |

On this second page you specify the information for your connection. The
cursor on this page is positioned in the Host Name field.

In the Host name field, type the IP address or the name of your host system.

The Connection name is automatically filled with the host name. Leave it this
way. This name displays in your Remote Systems view and must be unique to

the profile.

4. Leave the Parent profile default value. You don’t need to change it.
5. Leave the Verify host name check box selected.

Chapter 2. Module 2. Configuring a connection to an iSeries system and connecting to an iSeries
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6. Click Finish to define your system.

You have configured a connection and now you are ready to begin |“Exercise 2.2;

[Connecting to an iSeries system.”]

Exercise 2.2: Connecting to an iSeries system

Before you begin, you must complete [“Exercise 2.1: Configuring a connection to an|
[iSeries system” on page 7/

After you configure a connection to an iSeries system, you can easily connect and
expand your new connection to reveal your subsystems. Subsystems are
pre-defined filters grouping the various types of remote resources that can be
explored in the remote system. There are four subsystems.

iSeries Objects
A PDM-like group, allowing access to libraries, objects and members.

iSeries Commands
Contains predefined commands and allows you to create command sets
each of which contain one or more often used commands. When run, all
commands in a command set are sent to the remote system and executed,
and the results are logged in the iSeries Commands log view.

iSeries Jobs
Allow you to see various jobs, subset by job attributes, and to perform a
number of operations on those jobs.

IFS Files
Allow you to explore folders and files in the Integrated File System of the
remote iSeries system.

B- _&" New Connection
. -y iSeries...
“[¥] Connection created successfully. €
[+ @ Wwindows. ..
- ﬂ Lir, ..
w1 Y Power Linux...
- tnix URBC
- B AIX...
! @& Local...
o) E Local

=-fa

bjects

+ -4 Work with libraries. .,
@ 2 Work with objects...
-5 Work with members. ..
& % Library list
-3 User lbraries

[+ g¥ iSeries Commands

- i iSeries Jobs

[ Ty IFS Files

- Qshells

<] | i

To connect to an iSeries system:
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In the Remote Systems view, your new connection is expanded to reveal your
subsystems. The iSeries Objects subsystem is the subsystem you will use most
often! It is very similar to PDM, in that it allows you to access objects in the
QSYS file system, and perform actions on those objects.

Notice the first three entries under the iSeries Objects subsystem are named
after the PDM options, because they have similar capabilities:

* Work with libraries (similar to WRKLIBPDM)
* Work with objects (similar to WRKOBJPDM)
* Work with members (similar to WRKMBRPDM)
In addition there are entries for working with library lists and user libraries:

— Library list (to simulate PDMs WRKLIBPDM you can start with the
pre-defined Library list filter, that when expanded lists all libraries in your
library list.)

— User libraries (allows you to work with all user libraries you can access
on that iSeries server.)

You also have more entries to work with under the connection itself and you
can see from these entries that Remote System Explorer goes well beyond
PDM! It allows you to explore iSeries jobs and commands and the IFS file
system.

Now let’s work with a library in your library list and add the library that you'll
be using in this tutorial:

a. Right-click iSeries Objects and click Properties on the pop-up menu.

I
& Remote System § Showin Table

File Edit Mavigate ‘Work With L4
i | % 5 Refresh
J ¥ 4 Expand +
.15 Remote Systems ) Sk =
Chanae

Helease Interactive Job

=14 Mew Connecti

3 r P Verify Connection. ..
! ] Conne  Connect..
- Windows. Discannect
w0 Linu... Clear Password
] A Poweer Liny
5, Ui, . Remate Servers »
- ALX.. Shaw Log(B). .
| BBl Loca... Run Command. ..
E-EF Local
=-fig s400a

Sa

T Work with members. ..
[+ Library list

i a:={> User libraries

+-gk iSeries Commands

i+ @ iSeries Jobs

- Ty IFS Files

b. Select Initial Library List on the left pane.

c. Type RSELABXX where XX is a unique number in the Library field and click
Add.

Chapter 2. Module 2. Configuring a connection to an iSeries system and connecting to an iSeries 11



_ioi x|
‘ Initial Library List |
—Library list
urar: |
Library ! Library Position
RSELABRR HLAST
Remoyve |
Mave g I
Mave Dewn
| |
Current library; |“U5RPRF ;’
Initial command:
Restore Defaults | Apply I
KRR

d. Click OK.

This will add the library RSELABxx to your library list every time you use
this connection.

Note: You can also change your library list using the pop-up menu items
Add Library List Entry or Change Current Library on the Library
list folder in the iSeries Objects subsystem. These changes are only
valid until you disconnect.

3. Expand the Library list folder.
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£ 2| #|B®) v

E_ﬁ‘; Mew Connection
- - iseries...

[+ @ Wwindows...
- ,_& Lir, ..

w1 Y Power Linux...
B-unix UREC,

[ By A%,

#-E Local...

Local

[+

(-7, work with libraries. .,

-2 work with objects...

-3 work with members. ..
W Library list
g User libraries

[+ g¥ iSeries Commands

- iSeries Jobs

[ Ty IFS Files

G Qshells

I

1] |

L. [ Connection created successfully. £

2

Now the connection will be activated and you will be prompted for a user ID

and password.

@ Enter Password |

System type: iSeries
Host name:  TORASO7M

x|

User ID: | WLABxx

Password; | e
V' Save user ID

¥ Save password

[ ok | comce |

Click OK.

As you know, you can use the properties of any of the subsystems to set
connection information such as adding a library to a library list.

Enter your user ID and password.
Select the Save user ID check box.
Select the Save password check box.

Back in the workbench in the Remote Systems view you will see the libraries in

your job’s library list.
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.15 Remote Systems X

1
o % =] SR
& | & | [ 3 -

1.4 New Connection -
LB rg iSeries.,
: "V Connection created successFull
LAY windows...
L ﬁ Linu. ..
i ﬁ Power Linux...
{ o [FHeunix URDG .
LBy AIX...
- #-E Local...
0 [.:_i’ Local
=B s400a
= gy iSeries Objects
& ':#\ Work with libraries. .
ﬁ '5'.3' Work with objects. ..
+I _g Work with members..
J i«‘ Library list
. -l Q5Ys.Hib.prod-sys
. @ik Q5YS2.ib.prod
! 2] H}l QHLPSYS. *lib.prod-sys
Bl QUSRSYS.*ib.prod-sys
. -k QGPLHib.prod-ust
- Bl WFLABXX, ’1|b test-usr

& User libraries

[+ ﬁi{ iSeries Commands
i W iCevine dnb- _ILI
4 | | 3

Notice that the s400a folder now has a small green arrow in the icon to indicate
it is an active connection.

For each library, you can right-click and select from a number of actions. For
example, there is an action to create a new source file within the selected
library. Common actions like delete, move, copy, etc. are valid for all kinds of
objects.

You have connected to an iSeries system and now you are ready to begin |”Exercis€|
[2.3: Viewing and accessing objects in the Remote System Explorer perspective.”|

Exercise 2.3: Viewing and accessing objects in the Remote System
Explorer perspective

Before you begin, you must complete [“Exercise 2.2: Connecting to an iSeries|
[system” on page 10

Now you are ready to view and access objects in your library RSELABXX.

To view and access an object:
1. Expand library RSELABXX.

You will see all objects in this library appear in the Remote Systems view. For
each object you can right-click and select from a number of actions. The list of
actions depends on the object selected and whether you selected one or
multiple objects. For example, for a source file the pop-up menu has an action
to create a new member within the selected file.

2. Dirill-down through the files in the Remote Systems view until you find
QDDSSRC source file and then expand it.

3. Scroll down through the files in the Remote Systems view until you find
QRPGLESRC source file and expand it as well.

14 Development Studio Client: RPG application



.15 Remate.
+£ ]| | 8% ~

- (] PAYROLLG.*pam.rpale « |

- [Ey COMPARE *file. pf -src

® i EMPMST. *file.pf-dta

-5 EVFEVENT.*file. pf-dta

[#-6% MSTDSP. *file dspf

& E'tf] MSTDSP2. *file dspf

-1 PRIMST *file.pf-dta

® E; QCEBLLESRC. *file.pF-sn

L_ @] QCLSRC ”‘flb pF~src
() ke

Systems X

By MSTDSP. dspf
0y PRIMST.of
RT[D REFMST pf

) raissec e
L phRon rplje

: Iy PAYROLLG.rpgle

#-[Ey QRPGLESRCP. *file,pf-¢

-] REFMST.*file.pf-dta

=) RPGFILE. *file.pF-src

|:3- RSNMST. *file.pf-dta
- MVCOMPILE *cmd

+I }O User libraries
f B i€ i ~aren s 4
4| ] 3

Now you can see and access the members in these two source files. For each
member you can right-click and select from a number of actions. The exact list
of actions depends on whether the member is a data file or source file and
whether you select one or multiple members. For a RPG source member, the
pop-up menu actions include:

* open with

* browse with

* verify

* compile

Before you go ahead and work with these members, let’s see the members in
the iSeries Table view as well because that is similar to the view you are used
to from PDM. You use this view to display a list of items, for example,

members or objects, in a table format similar to PDM. You can also perform
actions against these items such as editing and compiling.

Right-click the QDDSSRC file and then click Show in Table on the pop-up
menu.
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@ EMPMST.pF
»
@y MSTDSP.dspf 219
Iy PRIMST.pf 2| Refresh
[y REFMST.pF
[’y RSNMST.pf Expantd +
Collapse -

Elproperties 33 N | B &0 ~ | Rename...

Property | value = Copy
Aftribute PF-SRC ' Paste
Mame QDDSSRC i
Murmber of chi,.. S «}+ Move...
Source RSELABRX ¥ Delete..,
Status oK
Text

|
Trpe FIE chie File Descriptions

£ Find String. .,
Change(g)...
Save...

The iSeries Table view takes the selected object in the Remote Systems view as
input, and displays the contents in the table. For source physical files, this
step displays the members inside, their names, types, attributes, text
descriptions, and status.

&=l QCMDSRC. "Hle. pt-ste = = =
= [E) QDDSSRC *file.pf- Mgmesﬁ 1 |
: ®y EMPMST.pf \ File RSELABKRZ/QDDSSRC (5 Members) -

[y MSTDSP.dspf

r i

[ PRIMST nf —lﬂ N © 5 @{%
.2 Name Wy | Type | Attribute | Text 4

(= et 52 N E % v =0 BEvemsT pF SRC
- [ MSTDSP  DSPF SRC =

“Propersy | value I @ PRIMST  PF SRC

Attribute PF-SRC O REFMST  PF SRC =

Marne QODSSRC 4 I I LIJ

Murnber of chi.., S =

Source RSELABXK

it::tus Ok Command INormaI LI ]

Type *FILE

Messages l ;I Details, s

The top of the iSeries Table view contains a lock icon & that controls the
correlation between the Remote Systems view and the iSeries Table view. If
the lock is disabled then whenever you click an object or library in the
Remote Systems view, the associated contents of that item automatically
populate the iSeries Table view. If the lock is enabled then when you click on
various items in the Remote Systems view, this view does not change the
content of the iSeries Table view. To enable or disable the lock, you can click it
once to change its state. You can click on the columns heading to sort the
view by column.

5. In the iSeries Table view toolbar make sure the lock/unlock button i is in
the unlock position. Leave the mouse pointer over the tool button for a second
or two to display the flyover help. That way you can check if the view is
locked or unlocked.

This means now the table will automatically be updated when a different
object is selected in the Remote Systems view. This is a shortcut to open the

pop-up menu for an object in the Remote Systems view and to select Show in
Table.
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You can also modify which specific columns you want to see in the iSeries
Table view.

6. To modify the iSeries Table properties:
a. Click Window > Preferences from the workbench menu.
The Preferences Window opens.

_ioi x|
[ Workbench I ETahIe View [
E Ant
- Build Order IV Re-open to previous state
Help ¥ Use the command ling for action parameters
[+ Install{Update
Internet
[+ igeries Projects Specify columns and column order
= JEEE

Type: |Member fud
[+ Java | _l
[} LPEX Editor Available columns Move Up I Selected columns
[EDRemote Systems
: i MName
o Communications " o Type
i IONE LIOATT
- Debug _I' Attribute
-File Cache Text
~Files <Remove Status
iSeries
TR e )
Command Executio |Al:|t| the selected column in
< Carmmand Subsyste™
- Job Subsystems
LPEX Editor Parsers
- Objects
Prograp Yerifiers
- Tahle Yie
i Templates
. -
" | *| nanina I . Restore Defaults | Apply I
mport... | Export... | [ ok | concel |

In the left pane of the Preferences window, expand Remote Systems.
Expand iSeries under Remote Systems.
Click Table View under iSeries.

In the right pane of the Preferences window, select Last modified in the
Available columns list.

Click the Add button.
g. Click OK.
Now, let’s update the iSeries Table view.

® oo o

—h

=

Click the down arrow on the iSeries Table view title bar.

Chapter 2. Module 2. Configuring a connection to an iSeries system and connecting to an iSeries 17



o [RON, e[ % =)

File RSELABX¥/QDDSSRC (5 Members) -

FEES E D@ work with » -
Subset... L=

Shou Al

0 RE . -
4| Prink...
— Export to File...
Hide Commands
Command |Mormal
Preferences...
Messages ] ;I Dietails, »

i. Click Show columns > Customized in the pop-up menu.

Now you'll see the extra column that you've added.

Mﬁerle& Commands Log I Remate System Details | =8
File RSELABXX/QDDSSRC (5 Members) r e
Name | Tvpe | atiribute | Text
By EMPMST PF s|RC OK  January 3, 2005 3:3...
Iy M3TDSP DSPF SRC 0K January 3, 2005 3:3...
B PRIMST PF SRC 0K January 3, 2005 3:3...
[y REFMST FF SRC OK  January 3, 2005 3:3...
P RSMMST PF SRC OK  January 3, 2005 3:3...

You can also sort the objects in the iSeries Table view by column.
j. To sort the objects in ascending order by Last modified, click on the

heading.

Mﬁerle& Commands Log I Remate System Details | =8

File RSELABXRIQDDSSRC (S Members) : -
Name | Tvpe ] Attribute ] Text
Py EMPMST PF SRC ok | January 3, 2005 3.3
[ MsTDSP DSPF SRC Ok || January 3, 2005 3.,
[ pRIMST PF SRC oK || January 3, 2005 3:3..,
[y REFMST FF SRC oK f January 3, 2005 3:3...
Py RSNMST PF SRC Ok January 3, 2005 3.,

k. If you click the heading the second time, it will sort it in descending order.
7. In the Remote Systems view, select QRPGLESRC.
The table shows the members in QRPGLESRC.
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By QODSSRC Mfile.pf-src || —
& % SRR tSeries... | Remote .| "1 = O
| Y PAYROLL.rpgle SELABKX/QRPGLESRC (2 Members) -

- PAYROLLG.rpale =

i = b .

m.Eh pﬁmnm.*ﬁh.f FHPe @
»

_hame | Type [ attribute | Te:
B propertiss 53 E % . w =0) Brawroll RPGLE SRC
I PaYROLLG RPGLE SRC
Property I Value |
Attribute PF-SRC
Marne QRPGLESRC 4 »
Mumber of chi... 2 I ’ ’_I
Source RSELABXK
Status OK
Text Command |Norma| ;] |
Type *FILE

Messages | _ﬂ Details..

Now you are ready to use the Remote Systems LPEX Editor to edit the
member MSTDSP found in QDDSSRC.

8. From the Remote Systems view double-click member MSTDSP in the
QDDSSRC source file.

You can do this in the Remote Systems view or in the iSeries Table view.

The Remote Systems LPEX Editor opens. It is built right into the workbench,
with rich editing functions and is iSeries aware! It is a superset of SEU! The
syntax checker is ported from SEU, and the reference manuals are built-in and
F1 cursor sensitive.

9. Double-click the MSTDSP tab to maximize the Editor window.

10. Double-click the MSTDSP tab again to return the view to its original size.

& Remote System Explorer - MSTDSP.DSPF - IBM Rational Software De
File Edit Source Compile Mavigste Search Project Run ‘Window Help

|rs - S |B-0-Q- | %7 E—j"lEiRamota Syste..,

5 O w a e A G
#BRemote Systems 52\ Team| = O | LDt I mh| =
£ 2] 2| BE - Line 1 Column 1 Repl|| & (8
o eoas Lo v red e e e
B MSTDSP.‘ﬂe.dsl:] | - = i
65 M5TDSP2, *Fle.d 000001 L*%5TS DD 1999033
- @ PRIMST. *file. pf- 000002 A* B839/04/10 16:2
= T 000003 LE R AR ERERARTRNA AR
= Ely QBLLESRC.*File
i Ely QCLSRC Fle.gf- 000004 L* THIS DISPLAY F
5B ansr{'c "‘f:le.'| 000005 A* TIME REPORTINGC
=) E) (DDSSRC. *file. 900005 ol
0y EMPMSL.o 000007 E:]—z
000008 Rl A AR AT ARAATANR
b MSTDSPd
- 000009 AFELEC -
1 REFMST pf | ] E
LMy RSNMST.pf !

You have viewed and accessed objects in your library and now you are ready to
begin [“Exercise 2.4: Opening a second source member” on page 20.|
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Exercise 2.4: Opening a second source member

Before you begin, you must complete [“Exercise 2.3: Viewing and accessing objects|
[in the Remote System Explorer perspective” on page 14

Next let’s open a second member in the editor.

To open a second source member:

1. In the Remote Systems view, double-click member PAYROLL in the
QRPGLESRC source file.

This member will be loaded into the editor as well.

Your Editor window will look something like:

iRemate Systems 2@“\___Team| = B Zmstose.osre  NEATTEIREE . |0 | B
S | HE - Line 1 Column 1 Replll &5
& B, MSTOSP i dsia]|| e @000 L =
- 56 MSTDSP2, *file.d 980108 G "_il
i [B) PRIMST, *ie.pf- 000200 F* PROGRAN NANE
o é\u QCBLLESRC. *File 000300 F# DESCRIPTION -
a1 Bl QLSRC. *file.pf- e e Ex
= DUUSUO yﬁx:rrﬁx:twﬁx*rr:x
i1 Ely QeMpsre *ile,) N N -
£ B QDDSSRC *fie.; 000600 F* INDICATORS USE
7y EMPMST.pf 000700 F: 50 - l\jl:l recorc
L.}y MSTDSP.dsp 000800 { 60 - General E
5 PRIMST.pf 000200 F* 90 - Protect ¢
L.y REFMST.pf T — 2
oy RSMMST pf .

Notice the two tabs in the Editor window.

2. Click on each tab to switch from one edit session to another edit session.

You have opened another member for edit and now you are ready to begin
[“Exercise 2.5: Displaying an outline of a source member.”|

Exercise 2.5: Displaying an outline of a source member

Before iou begin, you must complete [“Exercise 2.4: Opening a second source]

member.”

The Outline view acts as an excellent resource when you want to edit RPG,
COBOL and DDS source in the Remote Systems LPEX editor. The Outline view
displays a structural outline of items defined in the file that you currently have
open in the Remote Systems LPEX editor window. With the editor active, you can
expand the file structure in the Outline view, and click various elements in the
view to jump to that location in the source itself.

To see an Outline view of your RPG source:

1. Click the PAYROLL tab in the editor and click Refresh on the Outline view
toolbar.

Note: If you have closed the Outline view, you can reset the perspective by
selecting Window > Reset perspective from the workbench menu or
Show view > Other then expand Basic and click Outline in the Show
view dialog.

The Outline view contains your source program in a tree view without the lines

containing logic.
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6. Stay in the PAYROLL tab to get the PAYROLL Editor window in focus for the

next module.

Now you are ready to review your knowledge of this module by taking the quiz.

You can also apply what you have learned in this module by completing the

practice tasks detailed in More practice.

Quiz

1. When you first open Remote System Explorer, you are not connected to any
system except your local workstation. To connect to a remote iSeries system,

you need to:

a. Start Remote System Explorer communication server
b. Start a 5250 session

c. Define a connection. Specify the name or IP address of a remote system.

Chapter 2. Module 2. Configuring a connection to an iSeries system and connecting to an iSeries
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d. Define a profile
2. Subsystems include:
iSeries Objects
iSeries Jobs
IFS Files
iSeries Commands
All of the above
3. The subsystem iSeries objects includes:
Work with libraries
Work with objects
Work with members

®© o 0 T o

Library list
All of the above
4. The iSeries Table view is used to:

®© o 0 T o

a. Display a list of items, for example, members or objects in a table format
similar to PDM

b. Perform actions against a list of items, such as editing and compiling
c. Both

5. The lock icon controls the correlation between the Remote Systems view and
the iSeries Table view. (T, F)

6. You can maximize the Editor window by double-clicking on its window
heading. You can get back to its original size, by double-clicking on the
heading again (T, F).

7. The Outline view:

a. Displays a structural outline of items defined in the file that you currently
have open in the editor

b. Lists structural elements
c. Shows editor specific contents and toolbar
d. All of the above

More practice

Given that you have access to your own iSeries systems, configure a new
connection and connect to this iSeries system. Now rename the connection, move
the connection up or change the properties of the connection. Then use the iSeries
objects subsystem to list the libraries in your library list. Use the iSeries Table View
to see the objects in your library. Subset objects in the iSeries Table View. Open the
Remote Systems LPEX Editor from the iSeries Table view. Use the product online
help to assist you in these tasks.

Module recap

You have completed [Chapter 2, “Module 2. Configuring a connection to an iSeries|
[system and connecting to an iSeries,” on page 7. You have learned how to:

* Create a connection to an iSeries system

* Connect to an iSeries system

* Add a library to your library list

* View libraries in your job’s library list from the Remote Systems view

 Find a source physical file in your library
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* View members in a source physical file using the iSeries Table view

* Customize the columns in the iSeries Table view

* Open a member for edit from the iSeries Table view or the Remote Systems view
* Maximize the editor window

* Open another member for edit

* Switch from one edit session to another edit session

 Display a structural outline of items defined in a source member

Now that you have a connection to an iSeries server and have opened a source
member for edit, you can learn more about the Remote Systems LPEX Editor.
Continue to the next module |[Chapter 3, “Module 3. Editing source,” on page 25|
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Chapter 3. Module 3. Editing source

This module teaches you how to edit ILE RPG source member PAYROLL, which
should already be open, and learn about some of the Remote Systems LPEX
Editor’s language features.

In this module, you will:

Change the default settings of the LPEX Editor Parsers

Change the color settings and font used by the Editor

Change the default behavior of the Enter key

Use SEU commands to edit source

Undo and redo source changes

View language sensitive help for the MOVE operation code

View a list of all help contents

Limit the search of help to specific documents

Search the help

Request a prompt for a specification line

Display context sensitive help for any field in the iSeries Source Prompter
View the beginning and ending of constructs in your source

Use the Find and Replace window to search for an item in your source
Filter or subset your source

Filter lines based on line type

Search through members in a source physical file

Compare different versions of a program and identify the differences
Syntax check source by line

View help on syntax errors

Exercises

The exercises within this module must be completed in order:

[“Exercise 3.1: Introducing the editor” on page 26]

[“Exercise 3.2: Changing default editor settings” on page 26|

[“Exercise 3.3: Entering SEU commands” on page 32|

[“Exercise 3.4: Requesting undo and redo operations” on page 33|

[“Exercise 3.5: Invoking language-sensitive help” on page 34|

[“Exercise 3.6: Prompting language specifications” on page 39|

[“Exercise 3.7: Indenting source” on page 41|

[“Exercise 3.8: Finding and replacing text” on page 43|

[“Exercise 3.9: Filtering lines by string” on page 45|

[“Exercise 3.10: Filtering lines by type” on page 46|

[“Exercise 3.11: Searching multiple files” on page 47]

“Exercise 3.12: Comparing file differences from the Remote Systems view” on|

[page 49|

[“Exercise 3.13: Comparing files in the CODE Editor (optional)” on page 53|

[“Exercise 3.14: Checking syntax” on page 55|

© Copyright IBM Corp. 2001, 2005 25



Time required
This module will take approximately 45 minutes to complete.

Tip: You might want to maximize the Editor window during this module.

Exercise 3.1: Introducing the editor

Your program editing tasks are simplified with the Remote Systems LPEX Editor.
The editor can access source files on your workstation or your iSeries system
directly. When a compilation results in errors, you can jump from the compiler
messages to an editor containing the source. The editor opens with the cursor
positioned at the offending source statements so that you can correct them.

Here is a list of some of the basic editor features that you would expect in a
workstation editor:

e Cut, copy, and paste

* Block marking of lines, characters, or rectangles with copy, move, and delete
operations

* Powerful find and replace function

¢ Unlimited undo and redo

In addition there are a few more functions that you may not have seen in a
workstation editor:

 Token highlighting where different language constructs are highlighted using
different colors to help identify them in a program

* SEU-like format-line rulers to show the purpose of each column for
column-sensitive languages like RPG and DDS. These rulers can automatically
update themselves to reflect the current specification.

* SEU-like specification prompting for RPG and DDS

* Sequence numbers, which allow SEU-style commands in the prefix area
¢ Intelligent tabbing between columns for column-sensitive languages

* Automatic uppercasing for languages that expect uppercase

* Settings for column-sensitive languages that simplify text insertions and
deletions

* On-line language reference

Now you know the features of the editor, you are ready to begin
[Changing default editor settings.”|

Exercise 3.2: Changing default editor settings

Before you begin, you must complete [“Exercise 3.1: Introducing the editor.”]

The LPEX Editor has predefined settings, but also has an associated preferences
page containing settings that you can modify. The name of the category is LPEX
Editor and it appears in the left pane of the Preferences window.
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& Preferences

= |
[+ Ant
Build Order
[+ Help
[# InstalljUpdate
- Internet
[#)- iSeties Projects
J2EE
[#]- Java
S LPEX Editgrd
- Appearance
i Block.
- Compare
o Controls
- Find Text
Parsers
-~ Prink
- Save
- Tabs
- User Actions b
User Commands
- User Key Actions
- User Mouse Actions
User Profile
C:\Documents and Sekt

C:\Documents and Sekt vl
»

You will change the default settings of LPEX Editor Parsers, Appearance and User
Key Actions.

-

-

LPEX provides special support for insertion and deletion in column-sensitive
languages. When column-sensitive editing is selected, each column is considered as
a separate entry space. For example, in an RPG source member, if you are inserting
or deleting characters into a string that is in the Factor 2 entry, the Result field
entry does not move. The default editor preference is that column-sensitive editing
is off. You can switch this support on by going to the workbench preferences
window.

Setting column sensitive editing

To set preferences:
1. Click Window > Preferences from the workbench menu.
The Preferences window opens.
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[+ Java | ‘ LPEX Editor Parsers [
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[~ Show date area

ommunications olumn sensitive editing

EE:: :i:ha I Add signature to changed lines I
i L Fie Stanature
e ache Resequence start at (1-9999); | 100

Command Executio
-~ Command Subsyste

¢ €z LPEX Editor Parse

Resequence increment by (1-9999): | 100

" Resequence lines at save

0
[ Program Yerifiers
- Table Yiew
Templates
-~ Logging
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ez} RunjDebug
[ Server
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‘Web and =ML
[+ Web Diagram

\WebFacing Il
‘ml e Too | .L]:- Restore Defaults |
Import... | Expott. .. I QK | Cancel I

2. In the left pane of the Preferences window, expand Remote Systems.

w

Expand iSeries under Remote Systems.
4. Select LPEX Editor Parsers under iSeries.
The right pane allows you to set preferences for this feature.

5. In the right pane of the Preferences window, select the Column sensitive
editing check box.

When selected, each column is considered as a separate entry space.
6. Click Apply.
The Preferences window shows.

Other interesting preference settings are located under LPEX Editor.
Appearance allows you to modify color settings and font used by the Editor.

Changing the editor appearance

In the left pane of the Preferences window, expand LPEX Editor.
Select Appearance under LPEX Editor.

Select formatLine under the Styles list.

Change the Foreground color to dark green.

Change Font to 12.

Change Background color to light green.

ook wn =

Notice how your changes are reflected in the sample edit view.
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7. Select currentLine under the Styles list.

This option highlights the line that the cursor is on. The option applies to all
source files opened in the editor area.

8. Change the Background color to light yellow.

9. If you don’t like the changes you made, you can click Restore Defaults to
return to the original settings.

Modifying the default behavior of the Enter key

To modify the default behavior of the Enter key to split the current line in the
source instead of creating a new line:

1. Expand LPEX Editor if not already expanded then select User Key Actions.
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_ioix

Workbench

[ Ant

- Build Order
Help

[+ InstalliUpdate
Internet

[ iSeries Projects
- J2EE

Java

{B) Lpex edor

- Appearance
- Black

- Compare

- Controls .
~Find Text

E Parsers

- Print

- Save

- Tabs

LUser Actions

- UserMouse Actions
- User Profile
[+~ C:\Documents and Sett

| E-C:\Documents and Sett v |
4 | I »

mport... | Export.. |

-

i User Key Actions I

Key | action |
enter splitLine @

Key enter Erter

Action I splitLine

Reset I Restore Defaultsl apply I

K | Cancel I

2. Type enter in the Key field.

Note: The Key and Action fields are case sensitive. Make sure that the values
typed in the Key and Action fields are exactly as shown above.

3. Type splitLine in the Action field.

4. Click Set.

The Remote System Explorer has a predefined behavior for the Enter key. For
the Enter key to use the new split line action you need to change the default
Remote System Explorer behavior for the ILE RPG language.
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_ioix
Workbench i |11§ RPG |
& Ant
- Build Order IV Automatic syntax checking
Help [V Automatic syntax checking of SQL statements (performe

+- Install{Update
Inkernet

™ Automatic uppercasing

" -File Cache

Pos{tion

[ i5erles Projects Enter key behavior

- J2EE Repeat previous specification bype

Java : ) : -

&} LPEX Editor I | Repeat previous operation code (if on fixed form C-Spedficati
|° Remate Systems I™ | set G-Specification cursar position

! - Communications Position

[+ Debug
[ Set free form C-Spedification -:ursckfositic.n

.~ Templates =
g

fimed ameun l n

Restore Defaults | Apphy

- Cache I set D-Specification curscr positian
-~ Command Executio Eositian
< Command Subsyste
- Job Subsystems ¥ autamatic indent
@L?E}::Editor Parsers ¥ automatic closure of control block
e GoR0L — ™ User defined tabs(G)
- DDs
IH: Contral o
REug0 I _____ HEeywordst+t+titstdttttitstdbtttits
- Objects
[ Program Verifiers I" an
- Table View

Import... ] EXport... ]

[ o |

Cancel I

Editor Parsers.
6. Select ILE RPG.

N

8. Click OK on the Preferences window.
Return to the Editor window.

Clear the Repeat previous specification type check box.

Seeing the results of column sensitive editing

Notice that the line the cursor is on is now highlighted in the color you selected

for it in the preference setting for highlight current line.

V4 550/ PAYROLLRRGLE X

Lne 27 Column 10 Insert

002100 i

002200 F* used are — METDSPE - maintenanced
002300 F* - EMPMST - emplovee m:
002400 F* - PRJIMST - project ma:
002500 F* - RBNMST - reason cod:s
002700 FMSTDSE CF E WORKS!
-
4| | >

This program uses all externall:4
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To see what column sensitive editing does:
1. Move the cursor to line 27, column 10.

2. Make sure the editor is in Insert mode. If the status area shows Replace press
the Insert key.

3. Press the spacebar 3 times.

Notice that only the filename is shifted but none of the other columns to the
right are effected.

3
&/ MSTDSP.DSPF |

Line 27 Column 13 Insert
ooz2100 F* This program uses all externall:«
002200 F* used are - METDSP - malntenance
ooz300 F* - EMFMST - employee m:
00z400 E* - PRJMST - project ma:
oozs500 F* - RSNMST - reason cods
002600 RS S L
002700 [EMST DSP CF IE WORKE!
=
4 | »

4. Press the Backspace 3 times.

Once again the filename is shifted but no other columns are effected.
Seeing the results of splitLine

To see what splitLine does:
1. Place the cursor somewhere on a line and press Enter.

The text to the right of the cursor is moved to the next line.

You have changed the default editor settings and now you are ready to begin
[“Exercise 3.3: Entering SEU commands.”]

Exercise 3.3: Entering SEU commands

Before you begin, you must complete [“Exercise 3.2: Changing default editor|
[settings” on page 26/

You can configure the LPEX Editor to adopt the keyboard and command
personalities of many popular editors. Most editor profiles differ only in the keys
and commands used to perform various editor tasks. Some base editor profiles,
listed below, also add prefix information and a command area at the start of each
line:

* ispf

* seu

* xedit

The editor recognizes prefix commands used by these editor profiles. Depending
on which profile you are using, you can enter SEU, XEDIT, or ISPF commands

when the prefix area is active.

If you are an SEU expert you will appreciate the ability to use SEU commands.
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To enter SEU commands:

1. Move the cursor into the gray sequence number area to the left of the edit area.

Fustosposee 12 B

Line 31 Column 1 Insert 1 change

F'k*'k'k'k'k*'k'k'k'k*'k'k'k***************t***:‘l

FMSTDEP CF E WORKS'—!
oozsoo FEMPEMET UF A E K DISEK
oozsoo FPRJMST UF A E K DISEK
oo3000 FRENMST UF A E K DISK
dd| D*

003200 D* Compile time array containing e:

T | o

2. On any sequence number type dd.

3. Go down a few lines and type dd again and press Enter.
Notice that the lines have been deleted.

4. Now type 15 in the sequence number area.

5. Make sure the cursor is within the sequence number area.

6. Press Enter.

Five new lines are inserted.

You have learned how to use SEU commands in the editor and now you are ready
to begin [“Exercise 3.4: Requesting undo and redo operations.”|

Exercise 3.4: Requesting undo and redo operations

Before iou begin, you must complete [“Exercise 3.3: Entering SEU commands” on|

The editor records each set of changes you make to a file in the Editor window.
The number of changes made since the last file save is displayed on the status line.
If you want to undo a set of changes made to a file you use the Undo operation.
You can also cancel the effects of an Undo operation by using the Redo operation.

Now you are going to undo some of the changes you just made to the file. Then
you will cancel the Undo operation by using the Redo operation. Finally you will
reload the source so that it is back to its original content.

To undo and redo edit changes:

1. Click Edit > Undo from the workbench menu.
Notice that the 5 new lines disappear.

2. Press Ctrl+Z to undo the last change.
Notice that the deleted lines reappear.

3. Click Edit > Redo from the workbench menu.
Notice that the lines are deleted again.

At this point you will reload the source from the iSeries to make sure that it is
back in its original form.

4. Click File > Close on the workbench menu.
Tip: You can also click the X on the PAYROLL tab.
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VA st o 4PAYROLLRPGLL (X =)
" -

Line 26 Column 10 Insert 1 change
002100 F* This program uses all externall:l
nn22nn =& Nead ara — METTIED — maintanar e o)t

A Save Resource dialog opens asking if you want to save the latest changes.

x

@ 'PAYROLL.RPGLE' has been madified. Save changes? %

=1 @ |_ o |

5. Click No.

6. Go back to the workbench to the Remote Systems view and open the PAYROLL
member in the QRPGLESRC file.

You have learned how to undo and redo changes that you made to a file and now
you are ready to begin [“Exercise 3.5: Invoking language-sensitive help.”|

Exercise 3.5: Invoking language-sensitive help

Before you begin, you must complete [“Exercise 3.4: Requesting undo and redo
[operations” on page 33|

Inside the editor, there is cursor-sensitive language-reference help available.

This help is invaluable if you cannot remember the order of fields in an RPG
specification or the allowed values for a variable field. This help is available from
the LPEX Editor window.

To receive language sensitive help, press F1 in an Editor window. If the cursor is
on an operation code, you receive help for that operation code; otherwise, you
receive help for the current specification.

Accessing language sensitive help

To access language sensitive help:
1. Position the cursor over the word MOVE in line 112 of the ILE RPG source.
2. Press F1.

Language-sensitive help for the MOVE operation code appears in a Help
window.

Text marked in blue in the Help window contains the link to detailed
information about the topic in blue.
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& Help - IBM Rational Software Development Platform = II:I|E

Search: | |m Search scope: All topics

Contents a0 o o g & O
@ mtroductionto websg| ILE RPG Language Reference =
e Installing and migratin
@ Navigating and custon
@ Connecting to Linux, U MOVE (MO?&}
@ YWorking in a team eny|
@7’ Developing iSeries ser Free- (not allowed - use the EVAL or EVALR
< Developing Web applic Form operations, or buikt-in functions such as
@ 3 I Synt WCHAR, %DATE, %DEC , %DECH, %

* Developing Java applic GRAPH, %INT, %INTH, %TIME, %

~ Developing data acces TIMESTAMP | 3%UCS2, %UNS, or %
@ Devel d
@ Developing EGL applicg UNSH )
€ Building XML applicatia
"2 Detecting and analyzir Factor Resutt
@ Testing and publishing Code Factor 1 2 Field Indicators
@ Troubleshooting and s :‘;}O“E 3?:3 ;‘?_'E'l';":e I—CE:[’ + - | 2B

; ributes
L = Debugging application{ —_ ned

@ Reference
L3 Glossary

The MOYE operation transfers characters fram factor 2
to the result field. Moving starts with the rightmost
character of factor 2.

When moving Date, Time or Timestamp data, factor

' CR ]

1 must be blank unless either the source or the target is =~
B |5 | I | | ;I—I

3. Click the link Date Data Type.
The Help page for Date Data Type is displayed.

& Help - IBM Rational Software Development Platform = II:I|E
Search: | |m Search scope: All topics
Contents a0 o o g & O

2 Introduction to WebSp

@ Navigating and custon
@ Connecting to Linux, U
@ YWorking in a team eny|
@-’ Developing iSeries ser
@ Developing Web applid
@ Developing Java applic
@ Developing data acces
@ Developing EGL applicg
@ Building XML applicatia
"2 Detecting and analyzir|
@ Testing and publishing
L Troubleshooting and s

@ Reference
L3 Glossary

e Installing and migratin

@ Debugging application{

Date Data Type

Date fields have a predetermined size and format. They
can be defined on the definition specification. Leading
and trailing zeros are required for all date data.

Date constants or variables used in comparisons or
assignments do not have to be in the same format or use
the same separators. Also, dates used for /O operations
such as input fields, output fields or key fields are also
converted (if required) to the necessary format for the
operation.

The default intemal format for date variables is *1S0. This
default intermal format can be overridden globally by the
control specification keyword DATFMT and individually
by the definition specification keyword DATFMT.

The hierarchy used when determining the intemal date
format and separator for a date field is
1. From the DATFMT keyword specified on the
definition specification
2. From the DATFMT keyword specified on the

-

4| | » control specification =
= 5 e
B [ % | @ | | Lr"

4. Play around in the Help window to see what else is available.

5. Minimize the Help window.
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6. Select Help > Help Contents on the workbench menu to see a list of all help
that is available in the product.

@i Help - IBM Rational Software Development Platform B -'Il:llzl
Search: |[E  searchscope: ltopics
Contents |:><p B

@ Installing and migrati
& Navigating and cust
> Connecting to Linux, U
@ Working in a team eny|

@ Introduction to Web:a

@ Developing iSeries ser

@ Developing Web applic Welcome to the
 Developing Java appl ‘?Ei“snienfg?métion

@ Developing data acces center tells you

@ Developing EGL applicz about our tools

@ Building XML applicatia g:' gmhtngvat;iggz

@ Detecting and analyzir your i
@ Testing and publishing development

goals,

e Troubleshooting and s

@ Stay current Information for this
product is constantly being extended
and improved. To download updated
information, go to Help > Software
Updates = IBM Rational Product
Updater,

@  Smart searches Learn how to use
the Help search engine effectively

4 | __P| and refine your search scope. -

g [ % | B | | o

7. In the left pane of the Help window, click Reference.
8. Expand Language Reference.
9. Expand iSeries programming information.

10. Expand High-level languages.

11. Expand ILE RPG.

12. Select Language Reference.

13. Scroll down to Moving Date-Time Data.
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& Help - IBM Rational Software Development Platform

=10l x|

Search: | | search scope: Al topics

Contents #. [ || Reference O o e & O
" Troubleshooting and support 2l ILE RPG Language =
@ Debugging applications Reference

E Reference

= [ ap1s

i L3 Commands

[ [ Debuggers Contents

+ [ Files
Language reference
iSeries programming information

High-level languages
|5 PDF versions of the books
# I ILE Cjc++
& [ coBoLf400
= [ 1LE CoBoL
1+ [ DB2 UDE for iSeries SQL R
B Java

[+ (1] RPGi400
@II ILERE

[ [ Control language information

5 Taglibraries =
1 P - i LR T
4 [ >

g [ v | @

+ About This Reference
o Yho Should Use This
Eeference
o Prerequisite and Related
Information
o How to Send Your
Comments
YWhat's New
Changes to this Guide
Since Y5R1
What's New This Releaze?
YWhat's MNew in VaR27
What's New in V&R1?
What's New in V4R47
What's New in V4R2?
What's MNew in %3R7?
YWhat's New in \GRBNBRQ?_‘-._'
>

4| |

(o8 o]

C QOO0 OO0O0

Having the latest version of the manuals at your fingertips will make it easier
to find programming information. There is also the option to search the help
by specifying a search string. By default, the complete help will be searched.

Limiting the search scope

To limit the search to specific documents:

1. Click Search scope.

The Select Search Scope dialog opens.

2. Select Search only the following topics radio button.
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@ Help - IBM Rational Software Developnr_aent Platform

Search: |

O Detecting and analyzing run-time problems
= Testing and publishing applications to a server
O Troubleshooting and support
+ ing applications
£ Iv Reference

s
™ Commands

™ Debuagers
I Files
Sethings
[ User interface reference
[™ Crystal Reports
™ Miscellaneous
[T Accessibilty
O Glossary

~
< | o

38  Development Studio Client: RPG application

4. In the List name field, type MyList for example.

Contents .. A || Referenre it ek E% '"'H & B
S oreeey——— A
" Troubleshootin e
© Debugging appl e 22ar¢h alltopics
B Reference arch only the Following topics:
= [ ap1s
1+ L Commands
# L pebuggers
# [ Files
= [0 Language refer Lo
= [ iseries proc L Tria
&1 3 High-le: —
B pol
d Related
BELE |
@M@ co ‘ Mew. ., H Edit. Remaye
= NE I I st
= A e
£ 22 -
£ Guide
= [ rp | —
oF Cancel |
S Iﬁ: is Release? L\k
- TrTE s e vaR2?
[ Programming Guide o What's New in V6R17
[ [ Data Definition documentatior o What's New in VAR4?
lE [0 Control language information o What's New in VARD?
_ B Taglbyeries v o What's New in V3R7?
q | » o What's New in V3REAV3R2? «
g | % | @ 1 | »
3. Click New.
The New Search List dialog opens.
@i New Search List i ﬂ
SE CLEME:




5. Expand Reference.
6. Select the Language Reference check box.
7. Click OK on the New Search List dialog.

The Select Search Scope dialog reopens again with MyList selected in the topic
list.

& Select Search El:ope i _}_d_]

" search all topics
& Search only the Following topics:

Mew. .. | Edit... | Removel

Im Cancel I

8. Click OK on the Select Search Scope dialog.
9. In the Search field, type iSeries and programming for example.

& Help - IBM Rational Software Development Platform -0 x|
P sesrch ccope: altopis

10. Searching requires a help index and it takes approximately 10 minutes to
create the index in your workspace. If you want to complete the search query,
click GO.

The search results display.

Search Results ?‘&)

100% iSeries programming informaki =
24%. ILE CJ/C++ Programmer's Guide
23% DBZ Universal Database for iSer ¢
199 ILE COBOL Programmer's GuideJ

19% WebSphere(R) Development Sty
19% ILE CfC++ Compiler Reference
18% ILE CJC4+4 Compiler Reference
18% ILE CJC++ Programmer's Guide
15% ILE CJC++ Programmer's Guide
15% DBZ Universal Database for iSer
13% ILE COBOL Proarammer's Guide

You have accessed language sensitive help and now are ready to begin
[3.6: Prompting language specifications.”|

Exercise 3.6: Prompting language specifications

Before you begin, you must complete [“Exercise 3.5: Invoking language-sensitive|
[help” on page 34|

Instead of entering or changing code directly in the Editor window, you can use
prompts. When you request a prompt for a specification line, a window appears
where you can enter or change that line using entry fields.
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Accessing language prompts

To access prompts:

1. Return to the workbench. In the Editor window move your cursor to the
D-spec on line 33.

2. Press F4 (You can also click Source from the workbench menu and then click
Prompt.)

You see the iSeries Source Prompter at the bottom of the workbench. The
iSeries Source Prompter shows the specification line broken down into its
individual fields.

A MSTDSP.DSPE | //PAYROLL.RPGLE 53 0)(8z0 x\ =0
Line 33 Column 6 Replace [o5]
003100 D* Bl T D Fes
003200 D* Complle tTime array — (¥ i— Fields
003300 D ERR =) E{ahﬂmmn
003400 D EMESS g EQQMmew@
X EI«F-E Subrouti
| | Lr'
| «1 | o

|»

Externally Data structure Definition
Mame described tvpe type  From TojLength

ERR | ¥ B [ s
..... DName+++++++++++ETDsFrom+++To/L+++IDc. Keyw
D ERR 5 50 DIM (

4 | ;lﬂ

On the iSeries Source Prompter toolbar you can use the three push buttons to:
Disable source prompt view, Disable syntax checking, and Change to insert
mode.

Displaying context sensitive help

To display context sensitive help for any field in the iSeries Source Prompter:
1. Tab to the Keywords field.
2. Press F1 to see help for this field.

The Help window with help for the D spec keywords opens. If it doesn’t
appear automatically, you might have to bring it to the foreground by clicking
on its icon on the Windows taskbar.
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& Help - IBM Rational Software Development Platform

Search: |

|m Search scope: Mylist

=10/ %]

Contents Wy B

L

Colwele o

& Introduction to WebsSp
e Installing and migratin
@ Navigating and custon
@ Connecting to Linux, U
@ YWorking in a team eny|
@' Developing iSeries ser
@ Developing Web applid
@ Developing Java applid
@ Developing data acces
@ Developing EGL applicg
@? Building XML applicatia
@ Detecting and analyzir|
@ Testing and publishing
@ Troubleshooting and s
@ Debugging application:
@ Reference

@ Glossary

ILE RPG Language Reference

Positions 44 .80 (Keywords)

Positions 44 to 80 are provided for definition specification
keywords. Keywords are used to describe and define
data and its attributes. Use this area to specify any
keywords necessary to fully define the field.
o Definition-Specification Keywords

o ALIGM

o AlT{array_name]}

o ALTSEQ(*MONE)

o ASCEND

o BASED(basing pointer name)
CCSID{number | *DFT)
CLASSJAVA class-name)

COMST{(constant)}
CTDATA

DATFMT{format{separator}
DESCEND

IM{numeric_constant
DTAARAIMYAR: Jdata_area_name)}
APORT{(external_name
YTFLD(field_narme

ATEMT(code

(]

o

COQO0O0O0QO0O0OO00OCO0

-

You will see words in the help that appear in a different color than the regular
text. These are help links, and they show that there is additional help available
on that word or phrase.

3. Click on any link to see specific help for that item.

4. Minimize the Help window.
5. In the workbench, double-click the PAYROLL tab to return the Editor window

to its original size.

You have used prompts to enter code and now are ready to begin m

[[ndenting source.”]

Exercise 3.7: Indenting source

Before you begin, you must complete [“Exercise 3.6: Prompting language|

[specifications” on page 39,

When editing ILE RPG source, it can be difficult to determine the beginning and
ending of constructs. The iSeries Indent view allows you to see your source with

constructs in an indented mode.

To indent source:

1. Click Source > Show Indentation from the workbench menu.

The iSeries Indent view opens at the bottom of the workbench.
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rfmsrosp‘nsps |I PAYROLL.RFGLE E:?\ ][50 Sa’\\LEf

Line 32 Column 3 Replace (5]

003100 D* Alll &y Files
003200 D* Compile time array | & ®-f= Fields
003300 D ERR s - O Indicator
003400 D EMESS = G4 Main Procedu

58 Global Definit

1 h
| hd =+ C& Subroutic
> |

4|

| < | >
craslt:t..'_lisa_sﬂes_Tal:n_... |i5_eries Co.., |Rsrrd:35yst lﬁeriss SOU. . m
PAYROLL.RPGLE =
Line 32 Column 3 Insert

F**ﬁc**1'*t*t*t*t*t*t*t*t*t*t*t*t***********ﬂd

FMSTDSP CF E WORKSTHN al
FEMPMST UF A E K DISK

FPRJMST UF A E K DISK

FRSNMST UF A E K DISK

D*

D* Compile time array containing error des |
D ERR S 50 DIM (:
D EMESS S 50

E*

CHEHAAALXA XL AARA R AR AR XA AR A AR XA R AR AL XA A AR

C* MAINLINE CALCULATIONS
Ch AR AR AARAAAAARARARAARAARARARARAR AR AIARAERIS
;I

You can display the iSeries Indent view as a full view.
2. Double-click the iSeries Indent tab.
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|

Tasksllggrles Table... llSeries Conn... |R.emote5ysta... [ISeﬂasSourc... K4 (Series Indent X N
|PAYROLL.RPGLE -
Line 150 Column 11 Insert Bre

cx Al

C | | | IF not *INKC

C RECDE | 1 | | CHAIN RENMST

c I | | | EXSR ACDESR

C | | | ELSE

Z | | | | LEAVESR

c | | | END

C* end of error loop _J

C | | ENDDO

c*

C* Display reason code maintenance format

c*

C | | EXFMT RENMHNT

c?r

c | | IF *TNKD

ks | | | LEAVESR

(@ | | END

C | | IF *INKG

C | | | ITER

c | | END

C‘):

C* Determine update mode and perform record &

C*

c | T not *inkec —
| | 2

3. Scroll down to line 150. The Row shown on the status bar is the cursor
position.

In the iSeries Indent view you see some nested conditions with indented lines.
As you will notice this helps to recognize the beginning and ending of these
conditions.

Note: The Indented view is Browse mode only and cannot be edited.
4. Click the X in the top right corner of the view to close the iSeries Indent view.
5. This returns you to the Editor window with the PAYROLL program.

You have used the Indent view to see the beginning and ending of constructs and
you are ready to begin [“Exercise 3.8: Finding and replacing text.”|

Exercise 3.8: Finding and replacing text

Before you begin, you must complete |“Exercise 3.7: Indenting source” on page 41

The LPEX Editor also has a powerful find and replace text feature. You use the
Find and Replace window to search for an item. You can search for a word, a
partial word, or a sequence of such. You can also enter a pattern you want to
match, provided that the pattern follows the rules of regular expression. You can
replace the found search item. If the entered text or pattern is found, the cursor
moves to either the next or previous occurrence of the search item, according to
your chosen search direction, and replaces the found text according to your
selections.
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To find and replace text:

1.

5.
6.

Press Ctrl+Home to go to the top of the file.

Tip: When you press Ctrl+Home to go to the top of a file or Ctrl+End to go to
the bottom of a file, a quick mark is set at your cursor position. This allows
you to return to that line by pressing Alt+Q. Ctrl+Q will set a quick mark.

Click Edit > Find/Replace from the workbench menu or press Ctrl+F.
The Find/Replace window opens at the bottom of the Editor window.

Line 52 Colunmn 26 Replace

005200 e MAIN -
005300 o wyapn *inkc
005400 C EVAL *INGOD =
005500 c EVAL EMESS =]
005600 c EVAL EMPAPL =
005700 e EVAL PRJAPL =
005800 & EWVAL RSNAPL =
005200 c*

006000 C* Write the SELECT format to display
006100 (66

006200 c*

006300 e Dou not *ING
D0&400 & EXFMT SELECT
006500 e *INEC IFEQ T
006600 |5 LEAVERSR
006700 e ELSE
006800 = EXSR EDITEL
0069200 23 END
007000 c*
007100 C* IF the general error indicator *IN
007200 C* program continues to loop =
o | o
Eﬁ-.dlBEGBRiI @ Previous | ﬁl

R

Replace - _eplacel Replace aIIl
u ;ass?énsltm ™ whole word |~ Regular expression v wrap [~ Select found text |
I Restrict search to selection [ Restrict search to columns  Skark column Il_ End column I?

At the bottom of this window, you will notice that you have some options to
select from, for example, search only in certain columns, etc. You want to find
the first occurrence of BEGSR.

In the Find field, enter BEGSR to find the start of a subroutine.
Make sure the Replace field is blank.
You would use this field for text replacement.

The Editor moves the active line to line 52, which contains the first BEGSR
phrase in the file.

Click Next to go to the next location of BEGSR in the file.
Click in the Editor window to close the Find/Replace window.

You have searched for an item in your source using the Find/Replace window and
now you are ready to begin |“Exercise 3.9: Filtering lines by string” on page 45
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Exercise 3.9: Filtering lines by string

Before iou begin, you must complete [“Exercise 3.8: Finding and replacing text” on|

The editor allows you to filter or subset your source so that you see only lines
containing a given string. Filtering lines makes it quick and easy to find lines
without having to scroll through your source.

To filter source by string:
1. Double-click the variable EMPAPL in the Editor window.
2. Select Edit > Selected > Filter Selection from the workbench menu.

/ PAYROLL.RPGLE X =
Line 56 Column 36 Replace
005600 L: EVAL Buepars =
007900 Cc* If EMPAPL (employee maintenance) £
008800 = when EMPAPL =
035800 e EMPAFPL IFEQ R
036000 o EMPAPL OREQ LT
037300 c EMPAFPL IFEQ 2
038300 o EMPAPL IFNE o
ff 038400 c EMPAPL ANDNE 0

3. Move the cursor down a few lines to line 79.
4. Expand line 79. This expands the section up to the next instance of EMPAPL.

Line 79 Column 1 Replace
005600 C EVAL EMPAPL =
307900. C* If EMPAPL {(employee maintenance) e
08000 C* branches to label EMPTAG.
008100 c* If PRJAPL (project maintenance) ec
008200 C* branches teo label PRJITAG.
008300 Cc* If the prior twoe tests were not S
008400 C* reason code maintenance. The proc
008500 C* next executable operation.
008600 o=
008700 [, SELECT
008800 [ when EMPAPL =
035800 Q EMPAPL IFEQ Tt
036000 [ EMPAPL OREQ r%t
037300 3 EMPAFPL IFEQ r
038300 c EMPAFPL IFNE LA

) 038400 c EMPAPL ANDNE X

Now you want to show the entire source again.
5. Click Edit > Show all from the workbench menu or press Ctrl+W.

Your cursor is still positioned on the same line that you moved the cursor to,
even though all lines are now showing.
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You have filtered your source so that you see only lines containing a given string
and now you are ready to begin [“Exercise 3.10: Filtering lines by type.”|

Exercise 3.10: Filtering lines by type

Before iou begin, you must complete [“Exercise 3.9: Filtering lines by string” on|
page 45.

To help you navigate quickly through your ILE RPG source the editor allows you
to filter lines based on the line type. Imagine you want to see where all the
subroutines are defined in your source.

Line 24 Column 46 Replace
UDUlUU F****************************************-‘;
poozoo E* PROGRAM NAME - Pavyroll |
000300 F* DESCRIPTION - Time reporting master f
0oo4ao0 F* externally described wo
goosoo0 FP*: New | S e S S S S
000600 E‘i Prompt F4 ‘ -
ooo7zon F Syntax Check Line il on CHAIN operatil
oooson F* kfondition
ooogoo F* o Chrl % ' on delete reques
001000 F* Copy. Chrl+Insert hested
001100 F* ozt ki lcation selection
001200 F* Select » pvee selection
001300 F* Selected Fbct selection
001400 F* Deselect AltHU n code selection
0o1soo % i
001600 F*: — kdddkdkk
001700 P ' Chrl 45
0o1son F* Source % ion d
001900 F* View L2 11 mai
gozo000 F* 1 i o | Shateme Rk kR
= pets...
002100 p b R e desc
00Z200 F* Saye disp
002300 F* Show Date Area employee master
002400 E* - PRIJMST - project master fi»
K| | b

To filter lines by type:
1. Right-click in the Editor window with the PAYROLL program.
2. Click Filter view > Subroutines on the pop-up menu.

All source lines with BEGSR or ENDSR are displayed allowing you to move
quickly and easily to the desired subroutine in your file.
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“ PAYROLLRPGLE X g

Line 102 Column 1 Replace
_N....cuoNolFactorltt+t+++Opcods (E) +Factor2d
H

t 005200 2 MATN BEGSR
H 010200 ¢ endsr
t 011000 c RESNTAG BEGESR
H 017600 5 ENDsr
t 018300 c EMPTAG BEGSR
t 025700 8 ENDESR
H 026400 o PRITAG begsr
H 033500 c endsr
[ 034700 c EDITSL BEGSR
H 040400 e ACDESR BEEGER
H 042700 2 ENDSR
t 043100 (o) ADDCDE BEGSR
it 044000 & ENDER
t 044400 c CHGCDE BEGSR
H 045400 c ENDSR
t 046100 BEGSR DELCDE;

H 047200 ENDSR;

H 047600 BEGSR INVCDE;

H 047900 ENDSR;

3. Move your cursor to the line with the subroutine declaration CHGCDE (line
444).

4. Expand the declaration to show all lines in this subroutine.
Now you could work with the source inside this subroutine.
5. Right-click in the Editor window and click Show all on the pop-up menu.

You have filter lines in your source by line type and now you are ready to begin
[“Exercise 3.11: Searching multiple files.”|

Exercise 3.11: Searching multiple files

Before iou begin, you must complete [“Exercise 3.10: Filtering lines by type” on]
page 46.

If you would like to search through the members in a source physical file or
through the files in a local directory, you can use the Search tool. The Multi-File
Search utility allows you to search for a particular string of text in many members
on the host. This function can also be used on local files.

To search multiple files:
1. Click Search > iSeries from the workbench menu.
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| o
| = e

gl

|

/ FAYROLL.RFG

Line 446 Colun

NS RN » R S = Search..,

» 57 File...
Y iSeries...

2 Remote...

Chri+H

= [ Efremote Syste. ..

2

n42nn (54

The Search window opens.

TR NOT *THG <l

2. In the Search string field, type ENHRS.

Search

] x|
Java Sem;_IL

P iseries Search | )" Fie Search | <57 dw Search | %’ Help Search | 2 4
Search string| ENHRS | j ™ Case sensitive

Connection; ]s4ma

= Naw...l

j;] Browse. .. |

j;l Browse. .. I

CTarget e——
Libraryf | RSELABKX
File: | QDDSSRC
Meml *auL

¥ source members

_j_] Browse... |

I Datamembers

- Columns
gl columns

" Between || and(G) | 50

" Between(H) I 1 and end of line

Customize, ., |

(oo )] coneal |

The Connection field should contain your iSeries server name, otherwise enter

it there.

3. Under Target in the Library field, type RSELABXX.
4. Under Target in the File field, type QDDSSRC to search all members in this

source physical file.

5. Under Target in the Member field, select *ALL.

6. Click Search.

The Multi-File Search window lists all the lines in all the files that reference

ENHRS.

(TaskinSefias

|i5eries |Remute$... IiSsries... IiSeriss T m

"EMHRS" - 3 Occurrences in 3 Members

O %%~

8- Iy RSELABYXX/QDDSSRC(EMPMST) (1 match)
(Line 18) A ENHRS R
SELABXX/QDDSSRC(MSTDSP) (1 match)
{Line 99} & EMHRS R
|: Iy RSELABXX/QDDSSRC(REFMST) (1 match)
ine 27) A EMHRS L

Eth

B 11 37REFFLD{RCEMPJENHRS *LIBL/EMFMST)

TEXTCEMPLOYEE NORMAL WEEK HOUR
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7. Double-click the last line in the list.
A ENHRS 3 1 TEXT('EMPLOYEE NORMAL WEEK HOURS')

The member REFMST is automatically loaded into the editor and the cursor is
placed on the correct line.

[ / sToSP DSPE | // PAYROLL RPGLE m &
Line 27 Column 1 Replace
. B...A ... .......NamettttH+RLeN++TDPB. .. .. .k
000026 A al
IDDDDE?I A ENHES )l I
ooo028 =
poonze A EPHRC 5 1
pooo30 A
pooo31 A EPHRY 7 1
pooosz2 A
pooo33 A EPHRP 7 &
poons34 A
000035 A EPNRC 5 1
pooo36 A
pooon37? A EPNRY 7
pooon3s A
pooo3e A EPNRP T &
poop4n A B
pooop41 A EHWRK 5 1
poop4z A
000043 A* PROJECT MASTER RELATED FIELDS
po0n44 A PRCDE 8
poop4s A
poooD4s A PRDESC 50
poopanw A
pooo4s A PRRSP 30
pooon4s A
0oooso A I PRSTR R
4 | _"I_‘
|

8. Click the X in the REFMST tab to close the REFMST file.

You have searched through members in a source physical file and now you are
ready to begin [“Exercise 3.12: Comparing file differences from the Remote Systems|
iiew.”

Exercise 3.12: Comparing file differences from the Remote Systems
view

Before iou begin, you must complete [“Exercise 3.11: Searching multiple files” on|

If your product undergoes many changes, you will find the Compare utility useful.
It allows you to compare different versions of a program and find the differences.
There are two ways to do a compare: use the Compare utility in the workbench or
use the Compare utility in the CODE tool. The compare in the CODE tool is more
intuitive but requires you to start the CODE Editor outside of the workbench.
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Using the compare utility in the workbench you can view the differences between
two files by comparing them. You can compare different files, and you can
compare versions in the Workbench with versions in the repository or with the
local edit history.

After a comparison is carried out, the Compare Editor opens in the editor area. In
the compare Editor, you can browse through all the differences and copy
highlighted differences between the compared resources. You can save changes to
resources that are made in the comparison editor.

Using the compare utility in CODE you can also view the differences between two
files by comparing them. You enter a name of a file to compare against the file in
the CODE Editor view. You can type the name of a file, or you can select one from
the list of files already open in the editor. If you type the name of the file that is
not already open in the editor, it is loaded into the editor. If no file is specified, the
current file is compared against a new, untitled file. The current file appears on the
left side of the Compare view, and the specified file on the right. You use the
Compare menu to view the next and previous mismatch and to select options such
as ignore case, font, protect view and show mismatches only.

Note: Make sure all lines show in the source before starting the Compare tool.

To compare files in the workbench:
1. Click Window > Preferences from the workbench menu.
The Preferences window opens.
2. In the left pane of the Preferences window, expand LPEX Editor.

il
-ﬂm‘ _:l | Compare |
- Appearance
-~ Block Ignore case
gnore |eading blanks
; Clonhrols gnore trailing blanks
- Find Text
# Parsers gnore al blanks
i Print v Ignore sequence numbers
friniive [ Ignore comments %
- Tabs
-~ User Actions
- User Commands [~ Column restricted comparison
- User Key Actions start column I‘I_
- User Mouse Actions
i User Profile End column IGO

- C:\Documents and Sett
#- C\Documents and Sett
5 Ct\Documents and Sett

# Remoke Systems

[+ RunfDebug

[+ Server

[+ Yalidation

[+ Web and ¥ML

#- Web Diagram

‘WebFacing I
‘ﬂl Welb Tods _’]; Reset | Restore Defaults | Apply I

mport... | Export... | [ (o) | conce |

3. Click Compare under LPEX Editor.

In the right pane of the Preferences window make sure that the Ignore blanks
check boxes are selected.
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10.
11.
12.

Click OK in the Preferences window.
Back in the Editor window of the PAYROLL member double-click the

PAYROLL tab.

Click Edit > Compare > Compare to file on the workbench menu.

@ Remote System Explorer - REFMST.PF - IBM Rational Software Devel
Filz @ Source Compile Mawvigate Search Project Run  Window Help

£ #lndo Chrl+Z J 57 12 [W
l W nedo Chri4y A 2 By
(P ok it Cirl 5
W Cory Chri4Insert Replace
l B reste Chri+y
r Bl
[ % Delete Delete ENHRS BT
C  Select Al Chrl+a
L FndjReplace... Ctri+F FRHRE 8 4
€ FindNext Shift+F4
L Find Previous EPHRY 74 1
¢ Find Other
E Shov Al el BERES 7 1
[  AddBookmark... EPNRC B o
[ AddTask..
L Select EFNRY 74 1
€ Selected
E Deselect At EENRP 7 1 =
E |BLK
C Compare
[ Keystroke Recorder e ES+-ShiFE+
C Show Tooltip Description F2 Previous Mismatch  CrrlShift+P
[ Content Assist Ctrl+5PACE Refresh Crrl4+Shift+R.
oooo4a A Clear
gooon47 A
oooo4s A PRRSP 30
oooo4g A
0oooso A PRSTR R
v

< I Ll_l

The Compare window opens.
Expand your connection.
Expand *LIBL.

Expand RSELABXX.

Expand QRPGLESRC.

Select member PAYROLLG.
Click OK.
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& Compare File L x|

Select a member

[PaYROLLG

& My QHLPSVS. *lib.prod-sys Al
- i, QUSRSYS.*lib.prad-sys
-l QGPL.*ib.prod-usr

i, WFLABHY. Mlib.kest-us

W, RSELABXX. *lib.prod-usr

& [Ely COMPARE . *file.pf-src
- EMPMST, *file.pf-dta

® T EVFEVENT *file.pf-dta
5T PRIMST *file.pf-dta
-2y QCBLLESRC. *file.pf-sre
= Ehy QCLSRC. *file.pf-src
5= QCMDSRC. *file. pf-src
+ E] QDDSSRC. *file.pf-src
CQRPGLESRC, *file, pf -src

% Ely QRPGLESRCP. *Fle p-src
[ REFMST *file. pf-dta =]

1 B Ancen € #filn oF -

(o |

The editor now will show the differences of these two members PAYROLL
and PAYROLLG .

You can move from mismatch to mismatch by using the Compare menu under
the Edit menu.

Mismatches in PAYROLL and PAYROLLG are highlighted in different colors
so that you know where the mismatched lines are in each file.
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451 oo/ PAYROLLRPGLE X *REFMST.PF | =
Line 52 Column 1 Replace
004200 C* another. The action code you sele|
004300 C* determinez if the program will add
004400 C* wupdate an existing record in the f
004500 C'k:t'k*'k*'k*‘k***t‘k‘k‘k‘k‘kt‘kt‘kt‘kt‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k
004600 C* Housekeeping, clear display fields
oo4700 c*
004800 c EXER MAIN
004200 c* If MAIN is done program ends
005000 & eval *INLR =
ops100 * MAIN SUBROUTINE
005200 c MATIN BEGER
00053 c dou ’W]
05300 & dou *inkc
uusaua [ EWAL *INpU =
005500 c EVATL EMESS =
005600 24 EWVAL EMPAFL =
005700 = EWVAL PRJAPL =
005800 i EWVAL RENAFL =
005900 c*
on0&000 C* Write the SELECT format to display
006100 cx
006200 e
006300 g DOU not *ING
006400 C EXFMT SEELECT
00s500 C *TINKC IFEQ b
< | LI—I
[One or more mismatches found. |
I

13. Click Ctrl + Shift + N to find the next mismatch.
Next, end the compare session.
14. Click Edit > Compare > Clear from the workbench menu.

15. Double-click the PAYROLL tab to return the Editor window to its original
size.

You have compared different versions of the program and found the differences
and now you are ready to begin [“Exercise 3.13: Comparing files in the CODE|
[Editor (optional).”]

Exercise 3.13: Comparing files in the CODE Editor (optional)

Before you begin, you must complete [“Exercise 3.12: Comparing file differences|
[from the Remote Systems view” on page 49

The CODE tool provides a side-by-side view of the members being compared. If
you prefer this type of view follow the steps described next. You might want to
skip this section if the Compare Tool you just used provides sufficient information
for you. Now you will open a couple of files and edit them and use the CODE
compare utility.

To compare files in the CODE Editor:
1. In the Remote Systems view, right-click member PAYROLL in QRPGLESRC.
2. Click Open With > CODE Editor on the pop-up menu.
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This opens the CODE Editor window with the member. It will open in browse
mode since it is locked by the LPEX Editor session.

3. In the CODE Editor, open the PAYROLLG member.
4. Click File > Open from the CODE Editor menu.
The Select file - Open for Edit dialog opens.

I.aSe!ecl: file - Open for Edit B ‘51

File name [<RDS4004>RSELABXX/ORPGLESACIPAYROLLG)  ¥| Soucetype [rPGLE -

I~ (Contains sequence numbers Subset by source type |< All Files > "i

i<FI[IS4CI]A> RSELABXX/ORFPGLESE |Con‘.eris of *ROS4004>RSELABXX/URPGLESRLCT

& QHLPSYS - RS : =]
dasvs . peiiand par MEFTOEEE T Wil T A
#- QSYS2
= QUSRSYS
= RSELABXX
. COMPARE
- QCBLLESRC
i~ QCLSAC
. OCMDSAC

. QRPGLESAC

LS &
- WFLABN _l;l
- WSSLABRAK = LI =
¥ <ROS4004/ADM> - cmee | [ Era
: . Reftesh | Sot | cumser | Fine | [

Open | oo | Cancel| Hebp |

[¢R0S400A>ASELABX{QRPGLESRC[PAYROLLG)

5. In the left pane of the Select file - Open for Edit dialog expand the R0S400A
connection (the Remote System Explorer connection).

6. Expand library RSELABXX.
7. Select file QRPGLESRC.

8. In the right pane of the Select file-Open for Edit dialog, select member
PAYROLLG from the member list.

9. Click OK.
10. Click Actions > Compare from the CODE Editor menu.
The Compare dialog opens:

I

<R0S400A>RSELABX{ORPGLESRC[PAYROLLG]

Select or enter a file name

<R0S400A>RSELABXX{JORPGLESRC[PAYROLL)

<ROS400A>RSELABXX]QRPGLESRC[PAYROLL

. Cancel Help |

All entries are preloaded.
11. Click Compare.

The editor now has the PAYROLLG member loaded on the left and member
PAYROLL loaded on the right. In between the two members are two long
vertical blue lines with horizontal yellow and red bars highlighting the
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differences in these members.

ECUDE - ZROS400A>RSELABXX/QRPGLESRC(PAYROLLG): 2 - |I‘:I|.£|
Fil= Edit Wiew Actions Compare Options Windows Help
I R S I |l R R 2 [ E
RAS4OBA>RSELABXX/QRP RC (PA <ROSLOBA>RSELABXX/NRPELESRC(PA
Row 1 Column 1 Repl;l Il Row 1 Column 1 Repla
........ Toooorooo 2 ... 40 | s e
BBSBIHI Fasassnrn st et tiss a fpp1880 Foaasssete i s usr a
sapen2 F* PROGRAM NAME :: pae2e0 F* PROGRAM NAME |
fapev3 F* DESCRIPTION - —{ |B8B300 F* DESCRIPTION -
sopoBYy F* o400 F=
gapeans e 30 36 30 3636 36 36 30 30 30 3630 3036 agesao [Foesee s seae 36 30 330 30 3 3030 3636
BT F* INDICATORS US 008600 F* INDICATORS US
sapen7 F* 58 - No recor pa8700 F* 58 - No recor
popoBs F* 68 - General 0oesne F* 68 - General
oonen9 F* 98 - Protect Bae90e F* 98 - Protect
sape18 F* KC - End of j 001000 F* KC - End of j
oase11 F* KD - Return t ba1100 F* KD - Return t
aaee12 F* KE - Return t —4 881280 F* KE - Return t
sape13 F* KF - Return t 0801300 F# KF - Return t
safe1y F* KG - Return t B8a1400 F* KG - Return t
oase1s F* LR - Last rec Ba1500 F* LR - Last rec
aaev16 [ 3030 30 36 3696 3 3 30 90 36 330 363 ap1680 [ e 30 30 36 30 36 36 36 336 30 M 303
oaee17 F* SUBROUTINES U Ba1700 F#* SUBROUTINES U
pape18 F* EDITSL - Edit 061800 F* EDITSL - Edit
sape19 F#* ACDESR - Edit 61900 F* ACDESR - Edit
ufeifopedi] [0 30 36 36 3636 3 36 30 96 30 330 3636 afz2pe0 [ e 3 3030 30 30 36 36 336 30 M 33
apaa21 F+ This program —{ 8821080 F+* This program
pape22 F* used are - MS 802200 F* used are - MS
seee23 F - EM —j /882300 F= - EHM
seee2y F* - PR 002400 F= - PR
- -
«| [ 3 = Rk [ v
IBH Live Parsing Editor IBH Live Parsing Editor
| -l -1

12. Use the vertical scroll bars to move within the files.
As you scroll, you will see where the differences are in the members.

RPG experts will notice that PAYROLL has some errors in it. You will fix these
in a few moments.

13. Click Ctrl + Shift + N to find the next mismatch.

14. Click Compare > Exit compare from the CODE Editor menu (which was
inserted while performing this action).

The CODE Editor window re-opens.
Close the CODE Editor.

15. Click File > Exit from the CODE Editor menu. The workbench re-opens.
Continue working in the workbench.

You have compared files using the CODE Editor and now you are ready to begin
[“Exercise 3.14: Checking syntax.”|

Exercise 3.14: Checking syntax

Before you begin, you must complete [“Exercise 3.13: Comparing files in the CODE]
[Editor (optional)” on page 53|

One of the powerful features that the LPEX Editor shares with SEU is its ability to
syntax check your source. Syntax checking can be done either when the cursor
leaves each line of source or all at once on either the currently selected source or
on the entire source member.

Now you will create a syntax error and watch for the prompt to correct it.
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To syntax check the file:

1. In the PAYROLL Editor window move the cursor to line 211 which contains

EXSR ACDESR.

You might already be on that line but if not, type the line number in the

sequence number column, or scroll down.
2. Append an X to the EXSR op-code to make it EXSRX.
3. Move the cursor off of the line.

An error message appears to draw attention to the error.

1]

( “PAIROLLRFGLE X

Column 31

p = l

*INKD

NOT *INK
EMPMST
ACDESR

EMPMNT
*INRKD

Line 212 Replace 1 change
020100 C* leave subroutine
020200 c* i
020300 c IF
020400 [ leavesr
020500 &5 END
020600 c*
020700 C* Access employee master to validate
020800 o*
020200 c IF
021000 (& EMPNO CHA
021100 c
RNF5014E Operation code iz not valid; speci
021200 c eLsE i
021300 2 LEAVESR
021400 & END
021500 C* end of error loop
021600 c ENDdo
021700 o*
021800 C* Dizplay employee maintenance forma
021900 c*
022000 (6! EXFMT
022100 o] IF
022200 C*end of subroutine
022300 g2 LEAVESR
022400 55 END

o

4. Move the cursor onto the pink error message.

5. Press F1.
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& Help - IBM Rational Software Development Platform = jl:l|£]
Szarch; | |m Search scope: Mylist
Contents % O o o e & O

& Introduction to WebsSp
@ Installing and migratin
@ Navigating and custon
@ Connecting to Linux, U
@ YWorking in a team eny|
@‘ Developing iSeries ser
@ Developing Web applid
@ Developing Java applid
@ Developing data acces
@ Developing EGL applicg
@ Building XML applicatia
@ Detecting and analyzir|
@ Testing and publishing
@ Troubleshooting and s
@ Debugging application|
& Reference
@ Glossary

RNF5014

Operation code is not valid; specification is ignored.

further checking is done on the specification. The
operation must start with a valid Operation Code and can
be foliowed by an optional Operation Extender. If
specified the Operation Extender must be one or more of
A D E H MNP R,T,orZ and enclosed within
parentheses.

Recovery . . . . Specify a valid operation, or omit the
specification. Compile again.

(C) Copyright IEM Corporation 1332, 2005, All Rights Reserved.

This opens a window with second level help for the error.

Minimize the Help window.

Change EXSRX to EXSR to correct the error. (Similarly, you can use Edit > Undo

to correct this).

Move the cursor off the line you just fixed.

The error message is automatically removed from the editor.

Tip: You can toggle automatic syntax checking. Click Window > Preferences
from the workbench menu and then expand Remote Systems, iSeries, LPEX
Editor Parsers and select the language you want to change the settings for in

the left pane of the Preferences window, select the Automatic syntax checking
check box and then click OK.
Tip: You can syntax check the whole source member currently in the editor by
clicking Source > Syntax Check All.
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_igx]

@emde Systems I™ | 5et C-Specification cursor position
“ Communications e
: Fosition h
[+ Debug
" File Cache I™ Set free Form G-Specification cursar position
i X FIE? Fosition
i @Senas
o - Cache I" 5et D-Gpecification cursar position
Command Executio Position
Command Subsyste
- Job Subsystems ¥ | automatic inderit Blanks (12
B LPEXCEd'mr Farsers ¥ nutamatic closure of control block St
[reoBcL [~ User defined tabs(G)
- DD3
; JH: contrel ]
:'_ - I ..... EReywords+t+tt+ttttttttttitittttbttttittitittt
-~ Objects
Program Yerifiers I-‘

Logging =
« : | AR =5 LI—I Restore Defaults | Apply I
Irnport... | Expott... | [o]4 I Carcel I

- Save 2l |neres [
i Tabs

‘... User Actions utomatic syntax checking

- User Commands ¥ Automatic syntax checking of SQL statements (parformed on the server

- User Key Actions
User Mouse Actions
“User Profile Enter key behavior
[#- C:\Documents and Sett
E -C:\Documents and Sett
[#- Ci\Documents and Sett

[ Automatic uppercasing

[ Repeat previous specification type

I~ Repeat previous operation code (if on fixed Farm C-Specification)

- Table Yiew
- Templates And every: Iﬂ

Now you are ready to review your knowledge of this module by taking the quiz.
You can also apply what you have learned in this module by completing the
practice tasks detailed in More practice.

Quiz
1.
a.
b.
C.
d.

When column sensitive editing is selected:

Each column is considered a separate entry space

If you are inserting or deleting characters into a string that is in the Factor
2 entry, the result field entry does not move

The default editor preference is that column sensitive editing is off
All of the above

2. The LPEX Editor has predefined settings, but also has an associated preference
page containing settings that you can define. (T, F)

3.

LPEX Editor preferences are set in the:

a.
b.
c.
d.

Preferences window
Editor window

New wizard

Remote Systems view

You can configure the LPEX Editor to adopt the keyboard and command
personalities of many popular editors. (T, F)
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10.

11.

12.
13.

If you want to undo a set of changes made to a file you must use the
operation. Name the operation.

a. Insert
b. Replace
c. Redo

d. Undo

You can also cancel the effects of an undo operation by using the
operation. Name the operation.

a. Insert
b. Replace
c. Redo

d. Undo

This help is invaluable if you cannot remember the order of fields in an RPG
specification or the allowed values for a variable field. Name the help. Choose
the best answer.

a. Context sensitive help
b. Language sensitive help
c. Display help

d. Field help

To receive language sensitive help, press the ___ key in an Editor window.
Name the key:

a. F2

b. F3

c. F1

d. F4

If the cursor is an operation code, you receive help for that operation
code; otherwise, you receive help for the current specification.

a. before

b. after

c. on

d. off

Instead of entering or changing code directly in the Editor window, you can
use

a. Prompts

b. Filters

c. SEU commands

d. Format line

e. All of the above

The view allows you to see your source with constructs in an indented
mode. By default, the view will show the indented view in the
bottom pane.

a. Outdent

b. iSeries Indent

c. Edit

The iSeries Indent view is browse mode only and cannot be edited. (T, F)

You use the window to search for an item in the current source.
Choose the best answer.
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14.

15.

16.

17.

18.

19.

20.

a. Search

b. Find

c. Edit

d. Find/Replace

You can search for:

a. Aword

b. A partial word

c. A sequence of words

d. A pattern if it follows the rules of regular expression
e. All of the above

The LPEX Editor allows you to
only lines containing a given string.

or subset your source so that you see

a. search
b. find
C. sort
d. filter

To help you navigate quickly through your ILE RPG source the editor allows
you to filter lines based on the . Choose the best answer.

a. string
b. line type
c. both

If you would like to search through the members in a source physical file or
through the files in a local directory, you can use the tool. Choose the
best answer.

a. Compare

b. Search

c. Find

d. Edit

The tool allows you to compare different versions of a program and
find the differences. Choose the best answer.

a. Convert

b. Migrate

c. Compare

d. Search

There are two ways to compare files. They are Compare tool in the workbench
and the Compare tool in the CODE Editor. (T, F)

Syntax checking can be done either when the cursor leaves each line of source
or all at once on either the currently selected source or on the entire source
member. (T, F)

More practice

Given your experience using the Remote Systems LPEX Editor, try these new tasks:
Check out how token highlighting works in your ILE RPG source. Display a
format line and use it to enter your source. Filter source by comments. Set
auto-uppercase on. Use the product online help to assist you in these tasks.

Module recap
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You have completed [Chapter 3, “Module 3. Editing source,” on page 25| You have
learned how to:

* Change the default settings of the LPEX Editor Parsers
* Change the color settings and font used by the Editor
¢ Change the default behavior of the Enter key

* Use SEU commands to edit source

¢ Undo and redo source changes

* View language sensitive help for the MOVE operation code

* View a list of all help contents

* Limit the search of help to specific documents

* Search the help

* Request a prompt for a specification line

* Display context sensitive help for any field in the iSeries Source Prompter
* View the beginning and ending of constructs in your source

* Use the Find and Replace window to search for an item in your source
* Filter or subset your source

* Filter lines based on line type

* Search through members in a source physical file

* Compare different versions of a program and identify the differences

* Syntax check source by line

* View help on syntax errors

Now that you have mastered editing source, you can move on to verifying your
source to ensure you have a clean compile on the iSeries system. This approach
saves you iSeries cycles! And you perform both verify and compile from the
Remote Systems view! Continue to [Chapter 4, “Module 4. Verifying and compiling|
[source,” on page 63
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Chapter 4. Module 4. Verifying and compiling source

This module teaches you how to verify and compile RPG in the Remote Systems
LPEX Editor. When errors are found by either the verify or the compile step, the
iSeries Error List appears. The iSeries Error List is a powerful tool that manages

errors found by verify and compile utilities. You will become familiar with these
tools, the various capabilities of the iSeries Error List and the RPG program that
you have created.

In this module, you will:

* Check for semantic errors on your workstation

e Start the Program Verifier tool

* Use the iSeries Error list to locate each error in the source
* Use content-assist to fix an error

* Save your source

* Re-verify source

* Change compile preferences

* Invoke the compile command

* Change the current library using the Command field in the iSeries Table view
¢ Start an interactive connection

 Invoke the payroll program

Exercises

The exercises within this module must be completed in order:

* |“Exercise 4.1: Verifying the source”]

* |“Exercise 4.2: Compiling source remotely” on page 67

* [“Exercise 4.3: Submitting iSeries commands in the iSeries table view” on page 71|

+ [“Exercise 4.4: Running commands and programs” on page 73|

Time required

This module will take approximately 20 minutes to complete.

Exercise 4.1: Verifying the source

Now you get to play with one of the most powerful and unique features of the
Remote System Explorer — the Program Verifier. Before you compile your code on
an iSeries, you can make certain that there are no errors by invoking the Program
Verifier. The verifier checks for semantic (compile) errors on your workstation so
that you can guarantee a clean compile on the iSeries. Think of the host cycles
you'll save. It is especially handy when you are writing code but you are
disconnected from an iSeries. You can do this because Remote System Explorer
ported the parsing and checking code from the iSeries system compilers to the
workstation. The iSeries Error List view lists the errors that are found and their
severity, inserts the error messages directly into the source and helps you to
navigate between the errors.

To invoke the verifier:
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1. Click Source > Verify from the workbench menu. (Similarly, you can also use
the pop-up menu for the source member in the Remote Systems View or the
Verify tool button — you need the source in the editor for the button to

appear.)
After a moment the verifier will display an iSeries Error List below the Editor
window.
iSeries Tab.. |iSeries Com... | iSeries Sour... | Remote Search | Tasks
<TORASO7M=RSELABKX/QRPGLESRC(PAYROLL)
| o | Message | Severity | Line | Location | connection |
T ruFS17S ENDSR operation s .. 30 1 RSELAB... 4008
< 030 The name or indicato.., 30 365 RSELAB... s400a
1 RNF7030 The name or indicato... 30 95 RSELAB... s400a
Ol RNF7018 The operand RSNTA... 30 95 RSELAB.., s400a
1 RNFS184 Factor 2 must be '0' ... 30 364 RSELAB... s400a
O  RNF7515 Maove operands ERR ... 30 365 RSELAB.., s400a
i  RNF7089 RPG provides Separa,.. 0 27 RSELAB.., 54003
i RNF7031 The name or indicato... 0 110 RSELAB... s400a
i PRNF7031 The name or indicato... 0 1 RSELAB.., s400a
i RNF7031 The name or indicato,.. 0 1 RSELAB.., s400a
i RNF7031 The name or indicato... 0 1 RSELAB.., s400a
1 RNF7031 The name or indicato... 0 1 RSELAB.., s400a
1  RNF7031 The name or indicato... O 1 RSELAB... s400a

The error list shows you:
* The error message itself
* The severity

* The line number

* The source location

* The connection name
Fixing errors
Next you will fix the errors in your source.

To fix an error in your source go to the error list:
1. Double-click the error RNF7030.
You are automatically brought back into the Editor window to the line where

the error occurred. The error on line 365 is a typo. The variable EMES should
be EMESS. One good way of finding the correct name is the content assist.

)
Line 366 Column 51 Replace 3 changes
OB6300******xxxx% ;I
036400 MOVE T *INGD
036500 MOVE ERR (2) edEs
EMESS FEMESS
char(S0) ToEMPHO
doEMPaPL
JOEmMCaT
{IoeoerT
ELocn
JoENAME
037300 oL TFEQ  |JJENHRS
AR7400 o7 ANTIRN o T
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Note: The Outline view must be populated to use content assist.
Select the misspelled variable and press CRTL+spacebar.

If the variable starts correctly the selection presented contains the correct
name.

Double-click the variable EMESS in the list to correct the variable name.

Another way to find the variable name is to use the Outline view and see
what variables are declared.

E Cﬁ. Global Definitions -
L] Lﬁ Files
= 5— Fields
00 ACODE : Character (1)
. 0 ACREC : Character (1)
. -0 EDEPT : Character (5)
¢ -0 ELOCN : Character (30)
@00 EMCAT : Character (1)
i [?EI--@ EMESS : Character (50)
. B0 EMPAPL : Character (1)
-0 EMPNO : Packed Decimal ¢
. 1 ENAME : Character (30)
. @ ENHRS : Packed Decimal {

- EPHRC : Packed Decimal ( _

Foormmn Pl d

o gl i

The next error is a RNF7030 as well.
Double-click RNF7030. Fix it in the editor.
RSNTAX should really be RSNTAG.

Make the appropriate change.

Go to the next error RNF5184.

The next error is actually RNF7018 but it is related to the one you just fixed
and can be ignored. It shows the same line number, which is an indication
that both errors are related.

Double-click RNF5184.
Fix this by replacing the 2 with a 1.
Error RNF7515 is related to the first error you fixed. It has the same line

number. You can ignore it. The only serious remaining error is RFN5178. This
error is caused by a missing ENDSR.

Note: The verifier could not determine where the ENDSR is missing so the
line number reported is 1, for this reason you can’t just double-click on
the error message. You need to investigate where the missing statement
belongs. You can use the Indent view to determine where the ENDSR is
missing.

Move to line 398 in the editor.
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Gromisee WETTIIEN, e ]
Line 398 Column 8 Replace 5 changes
039700 END Al
039800 ENDSR
039900
040000 C‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***********
040100 C* ACDESR subroutine verifies the tim
040200 C* all maintenance selections.
040300 C*******‘k*'ir****************f**********
040400 ACDESE BEGSR
040500 Cc*
040600 C* Housekeeping, clear display fields
040700 o
040800 2 EVAL EMESSE =
040900 C EVAL *INGO =
041000 & EVAL *INS0 =
041100 c*
041200 C* The following statements perform
041300 C* two functions. First they determi
041400 C* requested and branche to the appro
041500 C* they determine if the maintenance
041600 Cc*
041700 c SELECT _]
041800 o WHEN ACODE =
041900 c EXSR ADDCDE
042000 c WHEN ACODE =
042100 c EXSR CHGCDE
4| | 4
|

10. Remove the asterisk (*) from the C-spec.
You can use the Tab key to quickly move to the appropriate column.
All the non-informational errors are now fixed.
You can filter out messages according to these severities by using the filter

menu.

i = e,
Remote ... | Tasks | @iseries... 2 . Remate ..'[»3 |
<TORASO7M =R SELABXXQRPGLESRC(PAYROLL) -

® & 50 W Information
E v & Warning

RNFS178 o o Error
RNF7030

]
v O
v O rurroz T Hoevere
v [ rnFroig ¥ H Terminating
v [ RNFS184 Factor 2mustbe'D’ ... 30
v [0 RNF7515 Move operands ERR ... 30 —
i RNF7O31 The name or indicato... 0
i RNF7031 The name or indicato... 0
i RNF7O31 The name or indicato 0

=
4| | >

11. Click the arrow in the iSeries Error List title bar.

12. Click Show Severity on the pop-up menu.
13. Clear the severities you don’t want to see in the list (Warning for example).

Saving the source member
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Now before you loose any of your changes, it’s a good idea to save them. Make
sure the member is selected. You then verify the source again to make sure that all
the errors are fixed.

You can save the member using one of these ways:

1. Click File > Save from the workbench menu.

2. Click the Save icon _@ in the workbench toolbar.
3. Press Ctrl+S.
Changes are uploaded to the iSeries.

4. Verify your source again.

iSeries Tabl... | iSeries Com. .. | iSeries Sour... [Remute Search | Tasks [Efi
<TORASOTM >RSELABXX/QRPGLESRC(PAYROLL)
| | | Message | severity | Line | Location | Connection |
'l RNF7089 RPG provides Separa... 0 27 RSELAB... s400a
i RNF7031 The name or indicato... | © 1 RSELAB.., s400a
i RNF7031 The name or indicate...  © 1 RSELAE... 54002
i RNF7031 The name or indicato... | 0 1 RSELAB... s400a
i RNF7O31 The name or indicato.,. 0O 1 RSELAB... sd400a
i RNF7031 The name or indicata... 0 1 RSELAB... s400a

Everything should be ok. You should see only severity 0 messages. You are
ready to compile the program.

You have verified your source and fixed any errors and now you are ready to
begin [“Exercise 4.2: Compiling source remotely.”|

Exercise 4.2: Compiling source remotely

Before you begin, you must complete [“Exercise 4.1: Verifying the source” on page

The remote compile capability is part of the Remote System Explorer. It gives you
a workstation interface to submit requests to compile, bind, or build objects on the
iSeries host. It allows for easy access to all the compile options available for all the
supported CRTxxx commands.

If you used the local program verifier, then your host compiles should be
successful -- no wasted iSeries cycles. However, if there are errors, the host
compiler will send the error information back to the workstation and they will be
loaded into the iSeries Error List view, which behaves just as it did when you did
a program verify.

The default for compiling programs is to submit the compile to the batch job
queue. Here in this exercise you can run the compile interactive.

Changing compile preferences

To change the preferences to run the compile interactive:
1. Click Window > Preferences from the workbench menu.
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_ioix

Wworkbench i | Command Execution [
[+ Ant k
.- Build Order Command Execut% Preferences
Help
Eg-Irstallipdate Preferences for compiles and user action variables
Inkernet
[# iSeries Projects Object library: I*SRCLIB
i J2EE [¥ Replace object
Java .
[} LPEX Editar ompile in batch
= Remate Systems
i F z Egm””mhons Preferences for batch compiles, commands, and user action variabl
+)-Debug
" File Cache Job description library: I"";IB!_
iy i Job description [*usrers
= I2EMNES
| - Cache SBMIOB additional parameters: |
: g”‘“"‘a“j E"‘*""’“ [ Add batch comples to the iSeries Job Status view
Ornnan uhsy‘stf
- Bobhapstoms [ add batch commands to the iSeries Job Status view
=} LPEX Editor Parsers
Loa :
Seat Preferences only for compile commands
- DDS Compile member types in this order:
~ILERPG o
L RPGJ400 i ﬂ P
.- Objects DSPF &I
; Pragram Yerifiers PRTF
Table Yiew IllffG'i_E Move Bovn |
- Templates ey -l
- Loaging e
4 | | LI—I Restore

Irmport... | Expott... I 0K I Cancel I

In the left pane of the Preferences window, expand Remote Systems.
Expand iSeries under Remote Systems.
Click Command Execution under iSeries.

ok~ wbd

In the right pane of the Preferences window, clear the Compile in batch check
box.

6. Click OK to return to the Remote System Explorer perspective.

Invoking the compile command

You will now use the prompt for the CRTBNDRPG command to specify your
compile parameters. All entry fields pertaining to names are already filled in with

the correct information.

To compile source:
1. Right-click the PAYROLL member in QRPGLESRC.
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@ Remote System Explorer - PAYROLL.RPGLE - IBM Rational Software |
Fil= Edit Source Compile MNavigate Search Project Run  Window Help

75 | EBremate Syste...

D_Outllne 8N i_ =)

[ (1 EMESS : Character (50)
-0 EMPAPL : Character (1)

-1 EMPNO : Packed Decimal ¢

1§00 ENAME :
- ENHRS
-1 EPHRC

Character (30)

g
-2 EPHRP :
(1 EPHRY |

{0 EPNRC
{21 EPNRP :

[0 EPNRY

(1 EUSRI : Character (8)
[#-23 PRCDE : Character (8)

: Packed Decimal |
: Packed Decimal {
Packed Decimal {°
Packed Decimal (-
: Packed Decimal ¢
Packed Decimal {
: Packed Decimal {°
- ERR : Character (50) DIM

=

L S e 5 T W 1 T O P I R B
B
o y
[%}lSeries... 23 s = m
ELABXY/QRPGLESRC{PAYROLL) -
| Message

p

RPG provides Separate-Indicator ...

The name or indicator *INO3 is nat, ..
The name or indicator *INO4 is nat...
The name or indicator *INOS is not. ..
The name or indicator *INOG is nat. ..
The name or indicator *INO7 is not...
The name or indicator *IN11 is nat. ..

Rt CRTBNDRFG...
o1y CRTRPGMOD. .,

Iiyo Work With Compile Commands. ..

21

| i |3 -G~ Q- | &
l =1 -I |ﬂﬂ..|Av[’;"¢.
T, | oo % O
el ¢ | Bs v Line
T PROMST *fle.pf-dta -
-5 QCBLLESRC, *file.pf-src 039 4
@By QCLSRC #file.pf-sre 039
#-E) QCMDSRC.*fils.pf-src 039
B E] QDDSSRC. *file. pf-sre 040
-y EMPMST.pf
®y MSTDSP.dspf gig
-y PRIMST.pf =l
|E| REFMST. DF 040
-y RSNMST.pf 040 _
EI E] QRPGLESRC *file.pf-src > rl
I
| ..y PAYROLLG, GoTo r
#-Eh QRPGELESRCP.* =
&3 REFMST. *file.pf e Imh 5
E-E] RPGFILE. *fle.p _ Crowse Wit
. =) RSNMSTfie.pl 1 o
- MYCOMPILE. *cr
= g User libraries =] Copy
g iSeries Commands s Move...
- iSeries Jobs
P24 IFS Files M o=
|4 B Find String...
= Properties &3 = Verify
[E e VeriFy (Prompt)...
P. I Y, '-I Cﬂh’ph L
Is.. Compile (Prompt)
AP User Actions K
ro
<R... Add To iSeries Project...
0., Make Avallable OFfline
Compare 'With 3

2. Click Compile (Prompt) > CRTBNDRPG on the pop-up menu.
The Create Bound RPG Program (CRTBNDRPG) dialog opens.
3. In the Debugging views list, select the *ALL parameter.
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eate Bound RPG Program (CRTBND

If you want to see the other parameters available, click Advanced.
4. Click OK when you are finished.

The progress bar on the workbench (bottom right corner) will indicate that the
compile runs. Then the error list will be shown, with no errors, just information
messages.

If you are not sure that the compile was successful, you can check the iSeries
Commands Log.
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Remate ...

s400a |

CRTBMDRPG PGM(RSELABNX/PAYROLL)
SRCFILE{RSELABX:/ORPGLESRC)
SRCMBR{PAYROLL) OPTION(*EVENTF)
DBGYIEW(*ALL) REPLACE*YES)

Program PAYROLL placed in library RSELABEX. 00
highest severity, Created on 01/04/05 at
14:03:39,

Cause .. ...: Program P&YROLL was
successfully created in library RSELABEX, The
highest message severity that resulted was 00,
The program creation date and time are 01/04)05
and 14:03:39, LI

| Command fl‘uormal ﬂ '

5. Click the iSeries Commands Log tab at the bottom of the workbench.

This log shows a list of all commands run on the remote system and the
messages returned for each command.

You have set compile preferences, invoked the compile command, checked for a
successful compile and now you are ready to begin [“Exercise 4.3: Submitting]|
iSeries commands in the iSeries table view.”]

Exercise 4.3: Submitting iSeries commands in the iSeries table view

Before iou begin, you must complete [“Exercise 4.2: Compiling source remotely” on|
page 67.

You can use the iSeries Table view inside the Remote System Explorer to submit
commands to the iSeries. You can run commands from the Commands field
beneath the iSeries Table view, and view messages in the Messages field. After you
populate the table, you can enter a command and click either Prompt to specify
parameters and then Run or just click Run. When you run a command, the
Messages field is populated with the messages from the command. When you
select a message, the Details button is enabled. When you click this button, the
message and its help is displayed.

Also note that besides the iSeries Table view, you can also use the Remote Systems
view to run commands and programs. Which one you choose depends on your
personal preference. In the iSeries Table view, you can see the properties of all
items at the same time; they are displayed as rows across the table. In the Remote
Systems view, you have greater ease of navigation; you can work from your
Library list in the iSeries Objects subsystem, and you can see the contents of many
items before selecting the one you want to run.

In the Commands field, you select where you want to run the command. The
choices are Normal, which means that the command will run in the RSE

communication server job, Batch or Interactive.

To change the library list:
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Tasks | Remate ..., ‘ISeries |Ramata |lsmes |15aries e I iseries .
File RSELABX¥/QDDSSRC (5 Members) EG E D @
Name | Type | Attibuts | Text | sta... | Last modified
P EMPMST PF SRC 0K Janwaty 3, 2005 313,
B MSTDSP DSPF SRC OK Janary 3, 2005 3:3...
1 pRIMST PF SRC oK January 3, 2005 3:3,..
[ REFMST PF SRC oK Janary 3, 2005 3:3...
[ RSHMST PF SRC K January 3, 2005 3:3...
4 T
w
Command |Mormal b kchacurlib rsel: :J Prompt... | @
Messages |ngram PAYROLL placed in library RSELABXX, 00 highest se j Details... ] Show Log... |

1.
workbench.

Click the iSeries Table View tab from the views at the bottom of the

2. In the Command field type, CHGCURLIB RSELABXX for example.

Note: Use a library that is on your iSeries system.

3. Click Run.

If you haven’t used the iSeries Table view to show iSeries objects in this view
you will see an error message because the table view is not linked to an active

connection.

If you see this message, click OK.
a. In the Remote Systems view, right-click QRPGLESRC.

EREIFORPGLESR .

&1 [Ey QDDSSRC *file.pf-src

[T

B

0y PAYROLL.rpal el ¢
- 3 PAYROLLG.rpgle GoTo ’
&1 E) QRPGLESRCP, *file.pf-s
[ REFMST *file.pf-dta | <) RoiTesh
- B RPGFILE. *file.pF-src Expand +
| - RSNMST *file.pf-dta Collapse -
| - MYCOMPILE, *crd
] i User libraries [ Rename...
&3] H{ iSeries Commands Copy
EI--& iSeries Jobs “ Daste
*, IF5 Files L= 2=
— —— — ol Move...
ClProperties 22 _'I: = - % Delete...
plv.]
1P, #8 Show in Table

b. Click Show in Table on the pop-up menu.

The table view is now populated with the member in the selected source

file.

Run the CHGCURLIB command again.

The command will run on the iSeries and after completion you will see the
completion message on the bottom of the iSeries Table view.
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Tasks|Ramote... |155rias... |Remute... |ISerias |ISerles‘.. B iseries ...

Flle RSELABXY/QRPGLESRC (2 Members) ESG oo @mw
Name | Type | attribute | Text | sta... | Last modified |
@ pavROLL RPGLE SRC OK  January 4, 2005 1:4...
B PAYROLLG RPGLE SRC OK  January 3, 2005 3:3...
4| | 2

Command [Normal ] || = Erompt... | o |
[_uassages |Current library changed to RSELABXX, ;I gataﬂs...] Show Log,.. ]

4. Back in the workbench in the Remote Systems view, right-click Library list and

click Refresh.

Team |

.15 Remote Systems X

_Sfl

] e
§ | =

#-_4 New Connection
#-E] Local
=B sd00a
Iﬂafn iSeties Objects
[+ ?ﬂ ‘Whork with ibraries. ..
| ?i" Work with objects...
-3 Work with members. .,
=B ibrary ist
238 H}@, Q5Y5."ib. prod-sys
-l Qsvs2 *ib.prod-sys
-l QHLPSYS. *iib.prod-sys

1 = @ rsELAEN *lib.prod-cur

i 52 L L W 1 Y [
[+ [# CLR1.*pgm.cle
[+ [8] MYCOMPILE.*pgm.clle
[2] PAYROLL. *pam.rpgle
[*] PAYROLLCZ. *pgm.chlle
[ [F] PAYROLLD. *pam.chlle
[+ [#] PAYROLLG. *pam.rpgle
- [Ely COMPARE *file.pf-src
#1-[F EMPMST *file.pf-dta
& EVFEVENT *file.pf-dta

=l

5. You will see a small green asterisk beside the RSELABxx library to indicate it as

your current library.

6. You can also connect to other than iSeries systems with the Remote System
Explorer and launch commands for these systems as well, for example, your

local system, or Linux' .

You have submitted a command to change the current library in the command line
of the iSeries Table view now you are ready to begin [‘Exercise 4.4: Running

fcommands and programs.”|

Exercise 4.4: Running commands and programs

Before you begin, you must complete [“Exercise 4.3: Submitting iSeries commands|

[in the iSeries table view” on page 71/
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As you know already, you can run programs and commands from the Remote
Systems view or the iSeries Table view in three ways:

1. In the Remote System Explorer communications server job.
This is the one you are using currently.

2. In a batch job.

3. In an interactive job (to test 5250 applications).

4. In a server job

Using the first option lets you run the program in the same job as the
communications server. With batch and interactive jobs, you cannot monitor the
status as easily, however, you do not tie up your communications server and you
are notified when the program command ends. Batch jobs work as you would
expect and do not require any initial setup. Interactive programs require a 5250
emulator, and you need to first run a STRRSESVR connectionName command to
associate the emulator with a particular connection in the Remote System Explorer
communications server. A multi-threaded debug session creates a new server job
and this way keeps the RSE communications server job free for other tasks.

Starting an interactive connection

To start an interactive connection:
1. Start a 5250-emulation session.

2. Sign-on to the iSeries with your User ID and password.

Note: Instead of the Enter key, you may have to use the Ctrl key in your
5250-emulation session.

=1 Session A - [24 x 80] =10f x|

File Edit Yiew Communication Actions indow  Help
o] 2 B b s & 3 @l

AN B Main Menu

=)
|af? 1902 - Session successfully started

3. In the command line, type the command
STRRSESVR connectionName
4. Press Enter.

The connectionName parameter is the name of your connection defined in the
Remote Systems view. This associates the interactive job with the Remote
System Explorer communications server.
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Running the payroll program
Now you are ready to run the program that you just compiled.
Return to the workbench.

To run the program:

@ Remte system Evporer AT -ojx
File Edt Source Complle Ma  Expand +
|5 - |45~ @ - efepse 7 | EHremote Syste..,
| | o = » | A [JRename..
= e = N
FETIEN, o Fom X S e
£zl & Faste . @0 EMESS ; Character (50) |
<&+ Move. .., -0 EMPAFL : Character (1)
4= New Connection o Dk - EMPNO : Packed Decimal {
g ? Lz;:' (- 01 ENAME : Character (30)
& si00a [ ENHRS : Packed Decimal
:I ﬁf:, iSeties Objects Update... :

L% work with lbrerie| Change.. -7 EPHRC : Packed Decimal {

-7 Work with object:  Save...

- 4; Work withmembe  Restore. .,

E| i Library list User Actions 4
= il QsYs.Hib.pre
@M, QSYs2 Mb.p  Service Entry Point ¥
- il QHLPSYS. *ib T ’
# ﬁ« QUSRSYS.*it  Run{Prompt)(B)

»
=) " RSELABKAI Debug As(F) b m
E-ECLCLYP pebug (prompt)y b Mukithreaded

{1 EPHRP : Packed Decimal {°

{
1 EPHRY : Packed Decimal {—
{
0

-1 EPNRC : Packed Decimal {
I EPMRP : Packed Decimal
[ EPNRY : Packed Decimal ("

PN S—— -
Berl&s application in RSE Job o n

W
#-[F] CLR1.*pc
[ [F] MYCOMP: Propartlw(B) _iﬁerifmﬁarm X \~—
w5 et L ABKIQRPGLESRC (2 Members)
®-E PAYROLLCZ, *oam. chle - i
& [£] PAYROLLD. *pgm.chlle FP e o @
#-[F] PAYROLLG, *pam.tpale Mame | Type | attribute | Text
i -Ely COMPARE. *file.pf-src T PAYROLL RPGLE SRC
@-[E EMPMST *file of-dta [ PAYROLLG RPGLE SRC
w-[5 EVFEVENT *file.pf-dta x|
" Properties £2 E ® v =0
Py
'R..
re... ‘:I | =
ro
§ R =
e Command ]Munnal J I
e Messages |The command ADDLIBLE R: 7| Detalls... |
I |
1. In the Remote Systems view, locate the PAYROLL program that you created.
2. Right-click the PAYROLL program.
3. Click Run As > Interactive on the pop-up menu.
4. Switch to your 5250-emulation session.

You will see the payroll program menu.
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File Edit Wiew Communication Actions ‘Window Help
D 2% @ =6 % & 9] @l

i ic B9:40:11

:J’ |Connected to remate serv'e'r:‘host toras pdl0l on psprintl:pd101 P

. Type x beside Employee Master Maintenance.

5
6. Press Enter.
7. Type 234 for the Employee Number.
8. Type A for the Action Code to add employee 234.
9. Press Enter.
10. Type any information you like about the employee.
11. Press Enter.
12. Play in the application as much as you like.
13. Press F3 to end the applications.

14. To get control of the interactive job, right-click iSeries Objects and click
Release Interactive Job on the pop-up menu.

You can also choose to disconnect a session. You would right-click the
connection and click Disconnect on the pop-up menu.

Now you are ready to review your knowledge of this module by taking the quiz.
You can also apply what you have learned in this module by completing the
practice tasks detailed in More practice.

Quiz
1. The tool checks for semantic (compile) errors on your workstation so
that you can guarantee a clean compile on the iSeries.
a. Compile
b. LPEX Editor
¢. Program Generator
d. Program Verifier

2. The view identifies each error with the severity level of the error,
the ID of the error, the message, the severity, the line in the source member that
caused the error, the location of the source member that produced the error,
and the connection name.

a. Remote Systems
b. Outline

c. Navigator

d. iSeries Error List

76  Development Studio Client: RPG application



3. You can sort the entries in the iSeries Error List view by:
a. ID

b. Message

C. Severity

d. Line

e. Location

f. Connection

g. All of the above

4. If you used the local program verifier, then your host compiles should be
successful; no wasted iSeries cycles. (T, F)

5. A compile command can be run on an iSeries server from the Remote System

Explorer, and you can retrieve error feedback from the compile. (T, F)
6. From the iSeries Table view you can:
a. List and sort libraries, objects, and members

b. Copy, rename, delete, edit, compile and run (for programs), open with and

browse (for members) in the view from the pop-up menu
c. Transfer files from one system to another
d. All of the above

7. You can run programs and commands from the Remote Systems view or the

iSeries Table view in:

A Remote System Explorer communications server job
A batch job

An interactive job

Multi-threaded

All of the above

8. Interactive programs require a 5250 emulator, and you need to first run a
STRRSESVR connectionName command to associate the emulator with a
particular connection in the Remote System Explorer. (T, F)

®© o 0 T o

More practice

Given your experience using the Program Verifier and Compile command, and that
you have your own source on your own iSeries system, try these new tasks: Check

out Compile (Prompt) Work with Compile commands. Assuming you receive
errors in your source (add some errors into your source if you don’t have any)

when you verify your source, choose insert all error messages into the editor from

the Error list. Use the product online help to assist you in these tasks.

Module recap

You have completed [Chapter 4, “Module 4. Verifying and compiling source,” on|

page 63.| You have learned how to:

¢ Check for semantic errors on your workstation

e Start the Program Verifier tool

* Use the iSeries Error list to locate each error in the source
* Use content-assist to fix an error

* Save your source

* Re-verify source

¢ Change compile preferences

Chapter 4. Module 4. Verifying and compiling source

77



* Invoke the compile command
* Change the current library using the Command field in the iSeries Table view
* Start an interactive connection

* Invoke the payroll program

Now that you know how to verify and compile source from the Remote Systems
view and run the payroll program interactively, you can move onto debugging

our payroll program. Continue to [Chapter 5, “Module 5. Debugging a program,”]
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Chapter 5. Module 5. Debugging a program

This modules teaches you how to debug a CL and ILE RPG program.

You will learn how to start the debugger, set breakpoints, monitor variables, run
and step into a program, view the call stack in the Debug view, remove a
breakpoint, add a storage monitor, and set watch breakpoints and all from the
Debug perspective.

In this module, you will:

* Invoke the debugger from the Launch Configurations window
e Add a breakpoint

* Add a conditional breakpoint

* Edit a breakpoint

* Monitor a variable through the Monitors view
 Step into your payroll program

* Show a listing view

e List the call stack entries in the Debug view

* View all breakpoints

* Remove a breakpoint

* Monitor storage

* Set a watch breakpoint

* Close the debugger

Exercises

The exercises within this module must be completed in order:

* [“Exercise 5.1: Introducing the Integrated iSeries Debugger” on page 80|

* |“Exercise 5.2: Starting the integrated debugger” on page 80|

* [“Exercise 5.3: Setting breakpoints” on page 85|

* [“Exercise 5.4: Monitoring variables” on page 88|

* |“Exercise 5.5: Stepping into a program” on page 93|

* [“Exercise 5.6: Listing call stack entries” on page 96|

* [“Exercise 5.7: Setting breakpoints in PAYROLLG” on page 97]

* |“Exercise 5.8: Removing a breakpoint in PAYROLLG” on page 98|
* [“Exercise 5.9: Monitoring variables in PAYROLLG” on page 100]
* [“Exercise 5.10: Adding a memory monitor” on page 101]

* |“Exercise 5.11: Setting watch breakpoints” on page 102]

* [“Exercise 5.12: Closing the debug session” on page 103|

Time required

This module will take approximately 30 minutes to complete.
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Exercise 5.1: Introducing the Integrated iSeries Debugger

The Integrated iSeries Debugger is a source-level debugger that enables you to
debug and test an application that is running on an iSeries system. It provides a
functionally rich interactive graphical interface that allows you to:

* View source code or compiler listings, while the program is running on the
iSeries system.

* Set, change, delete, enable and disable line breakpoints in the application
program. You can easily manage all your breakpoints using the Breakpoints
view.

* Set watch breakpoints to make the program stop whenever a specified variable
changes.

e View the call stack of your program in the Debug view. As you debug, the call
stack gets updated dynamically. You can view the source of any debug program
by clicking on its call stack entry.

* Step through your code one line at a time.

* Step into or step over program calls and ILE procedure calls.

* Display a variable and its value in the Monitors view. The value can easily be
changed to see the effect on the program’s execution.

* Locate procedure calls in a large program quickly and easily using the
Modules/Programs view.

* Debug multithreaded applications, maintaining separate stacks for each thread
with the ability to enable and disable any individual thread.

* Load source from the workstation instead of the iSeries — useful if you don’t
want the source code on a production machine.

* Debug client/server and distributed applications.

The Debugger supports RPG/400® and ILE RPG, COBOL and ILE COBOL, C, C++
and CL.

In the following exercises you will be given the opportunity to learn about some of
the basic features of the Debugger. For the purpose of these exercises you will
debug a CL and an ILE RPG program. Don’t worry if you don’t know RPG.

You know the basic features of the debugger and now you are ready to begin
[“Exercise 5.2: Starting the integrated debugger.”|

Exercise 5.2: Starting the integrated debugger

Before you begin, you must complete [“Exercise 5.1: Introducing the Integrated|
[iSeries Debugger.”|

You will be working with the ILE RPG program PAYROLLG.

Note: PAYROLLG is the same RPG program as PAYROLL but without compile
errors. You are using it instead of PAYROLL in this exercise, to
accommodate anyone who decided to skip right to this exercise without
Comi leting the editor exercises in [Chapter 3, “Module 3. Editing source,” on|
page 25.

You can start the Debugger in several ways: directly from the pop-up menu of a
program or service program in the Remote Systems view, or from a Launch
Configurations window. Starting directly from the Remote Systems view doesn’t
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allow you to specify parameters to be passed to the program. The Launch
Configurations window allows you to modify how the program is invoked and to
specify parameters.

To make the exercise interesting you will use CL program CLR1 to call PAYROLLG

and you will pass one parameter to CLR1.

This means you will use the Launch Configurations window.

To start the debugger:

1.

ok 0D

already.

& Remote System Explorer - PAYROLL.RPGLE - I

File Edit Source Compile Mavigate Search Proje

j_“j' 1%00 - I

& Local 4
=B s400a
:I & iseries Objects
- work with libraries. .
B ':1':' ‘“Work with objects...
'ﬁj‘ Work with members..
Er ‘-' Library list
- M Q5YS.Mib.prod-sys
-l Q5Y52.4ib prod-sys
] [f‘_.. QHLPSYS. *ib.prod-sys
il QUSRSYS. Hib.prod-sys
= g* RSELABKX. *ib.prod-cur

(=] PAYROLL.*pgm.rpgle
<[ PAYROLLCZ. *pgm.cblle
[#] PAYROLLD.*pgm.chlle
] PAYROLLG. *pam.rpale
E] COMPARE *file, pf-src
|: EL EMPMST. *file.pf-dta

© @ EvREVENTflepf-dta v
«| | »

-
®
[+
#
®

In the Remote Systems view expand the Library list filter, if it isn’t expanded

Expand library RSELABXX, if it isn’t expanded already.
Select program CLR1 in library RSELABXX.

Click the arrow beside the DEBUG icon ﬁlj on the workbench toolbar.

Select Debug from the list.

The Debug Launch Configurations window opens.

Select iSeries: Debug Interactive Application under the Configurations list.
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(T I

Create, manage, and run configurations

Caonfigurations:

| 3% Apache Tomcat
5 Attach to a Running Pre _ -
- f& Compiled Application & Perspectives

5,1 Hast Java Application These settings associate a perspective with iSeries: Debug Interactive Application
‘A HTML Script Application launch configurations, & different perspective may be associated with each supported
.5 iseries: Debug Batch ap 1aunch mode, and can optionally be activated when a configuration is launched or
when a breakpoink is encountered via the Debug preferences. To indicate that a
perspective switch should not occur, select "Mone".

% i5 g Interacti
- g% iSeries: Debug Job
(3% iSeries: Debug Multi-Thr
7% Java and Mixed Lanqua  Debug: {Debug =]
-] Java applet
3] Java Application
8 Java application in iSeri Restore Defaults |
:15 Java Bean
Ju JUnit
- rL‘: Remote Java Application
“#% Script Host Application
- 155 websphere v5.0 Applic.
6% webSphere v&,1 Applic.
15 Websphere v6.0 Applic.

K — =
New I Delete I Aoty I Revert I
Debug Close |
7. Click New.

Note: You could also use Debug(prompt) > Interactive from the pop-up
menu.

The right pane of the Debug Launch Configurations window opens.

Name‘l CLR1 ’
What To Debug | B/ source|  Advanced | C¢|»]

Connection; |s400a x| nmew... |

Programs or service program to be debugged

Library | Program | Type | add. .. |
RSELABXE CLR1 *PEM
Ediths |
Hemove |

[V stepinto
¥ Terminate debug session on program completion
pdate production files

Apply I Revert |

8. In the Name field, type the program name CLR1.
9. Select the Update production files check box.
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10. Click the How To Start tab.

11.

12.

13.

The How To Start page opens.

Mame: | CLR1

what To Debug How To Start: I % source I Advanced I 1 Comman |

Command to start application:
CALL PGM{RSELABKXMCLR1) ;]

=

¢ Fromer.. Y |
e

Apply | Revert |

By default, the page contains a call for the program selected in the Remote
Systems view.

Click Prompt.
The Call Program (CALL) window opens.

@& call Program (CALL) 1 x|
Program: = |CLR1 Mame
Library: > | RSELABXX | Name -
Parameters: gt ) ;I ‘Add% ]
[™ tdvanced [~ &l Parameters I Keywords
CALL PGM{RSELAB/CLR 1) PARM{EX) |
‘ OI{' I Restore defaults I Cancel I

In the Parameters field, type 'XX' where XX’ is your workstation number.
Click Add.

The parameter value will appear in the lower list.

If you forget to click Add, the parameter will be missing from the CALL
Program command and you will receive an error when the program tries to
call the payroll program.

Click OK.

The complete start command for the program appears.
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Create, manage, and run configurations

Configurations: Name: |G.R1
-~ |z% Apache Tomcat

% Attachto a Running Prc . —

[, Compiled Application What To Debug How To Start | £ Source | Advanced ] 1 Common I
- Ei Host Java Application

‘&% HTML Seript Application Command to start applcation:

5 iSeries: Debug Batch Af - :
= * iSeries: Debug Interacti +~ALL PGM{RSELABXK/CLR1) PARM(:X) LI

| B New_configuration
- ‘& iSeries: Debug Job I
- [ iSeries: Debug Multi-Thr
- [1% Java and Mixed Langua
— i Java Applet
3 Java Application
[ 2ava pplication in iSeri
|48 JavaBean
Ju JUnik ;l
-2, Remote Java Application
‘A Script Host Application Prompt... I
- [y websphere v5.0 Applic.
{5 websphere v5.1 applic.
I]'ﬁ ‘WebSphere vé.0 Applic.

S N

New | Delete | aply | revert |

14. Click Debug.
The Debug perspective opens.
If not, you may see this error message.

@& EVFC50011 x|

@ Mo interactive job associated with this connection. Associate an interactive

job with this connection ko continue.
[ cawel | <<Detais |

# request to run an interactive command or program was recelved for the RSE ;]
connection s400a, but no interactive job is currently associated with this connection,
To associate an interactive job with this connection:
1. Open a 5250 emulator,
2. Runthe CL command STRRSESVR MAME(s400a)
3, This will associate the interactive job with this connection, causing this
dailog to close and your interactive command or program to run, ;l

I

The Remote System Explorer communications server has been shut down in
the meantime. Go to your 5250 emulator and restart the Remote System
Explorer communications server following the instructions in the message.
You don’t have to cancel the message. It will be removed as soon as the
connection between the Remote System Explorer communications server and
the interactive session has been established. Now the Debug perspective is
loaded in the workbench.

Now that the program is active on the iSeries and stopped at the first
executable statement, the debugger displays the source.
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@i Debug - CLR1.CLLE - IBM Rational Software Development Platform E = IEI[E]
Fil= Edit Source Compile MNavigate Search Project Run ‘Window Help
Iti~ @302 |® 1| 5 vebug
| = = = CBRemate Syste...
| |@ o> |A KRBy
%5 Debug 52 Sewersl = (0= Variables 53 _Breakpo... | ¥4 =5
- Yk 0 -
'S | 32 eF| |
(28] %3
- B Thread:t (stopped) :_I
i = CLR1:CLR1: CLR1
= _CLPEP:CLR1: CIR1 'J
= QCMDEXC : QCMDEXC : QCM)
= executeCommand : QRSEMAL ;_I
«Z main : QRSEMAIN : RSEMAIN _ -
- = ,Tr.,ﬂ_l i ;I_I
[ Zanicue N O)(Bo.. £\Z0)
Line 1 Col 1 Replace An outline is not
in umn epla bt
pooloo ~ PARM(&nal
oopz200 VAR (&nu
000300 &name *—
000400 &lib *¢
000500 VAR (&co %
b4
«| | »
-~ ~
Consola|Tasks|[SerlesCmmmdsLogrﬂ Memary &3 w ¥ | - w =
|| ] | |

You have started an interactive debug session and now you are ready to begin
[“Exercise 5.3: Setting breakpoints.”|

Exercise 5.3: Setting breakpoints

Before you begin, you must complete [“Exercise 5.2: Starting the integrated|
[debugger” on page 80

You can only set breakpoints at executable lines. All executables lines are displayed
in blue. One way to set a breakpoint is to right-click on the line in the Source view.

To set a breakpoint:
1. Position the cursor on line 11.
2. Right-click anywhere on line 11.
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WY WOl MIca

|4l S|

(Zazice NG

l"

0

Ereakpoint...

Line 11
g e
ooogoo Monitar Expression m
0on900 Monitor Memory » [AME) VALUE
Swikch View y }1b) wvalue (
CALT P slib/ PAYROLL
001200
=
s ]
|

3. Click Add breakpoint on the pop-up menu.

A dot with a checkmark in the prefix area indicates that a breakpoint has been
set for that line. The prefix area is the small grey margin to the left of the
source lines.

Now you add a conditional breakpoint to stop in the loop when it loops the
99th time.

Adding a conditional breakpoint

To add a conditional breakpoint:

1. Position the cursor on line 8.

2. Right-click on line 8.

3. Click Add breakpoint on the pop-up menu.

[ caviae < NG o)
Line 7 Column 1 Replace
QooZo00 Toon. e TS TS|
ooosoo if (scount *1t 100) then (g9
Ton200 [Ss(erN RTFN o 0 PN GROR R -w TR
go1000 chgvar var(elib) walue(
2001100 CALL PGM (&lib/ PAYROLL
-
< | L4
I

4. Click the Breakpoints tab in the upper right pane of the Debug perspective.
The Breakpoints view opens.

~

Variables Registers| 3 = O
XRPAE S|~
[ # CLR1.CLLE [line: 11]

=2

Select all
M Erabile
|_| Disable

5. In the Breakpoints view right-click the breakpoint for line 8.
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6. Click Edit Breakpoint on the pop-up menu.
The Edit a Line Breakpoint window opens.

@& Edit a Line Breakpoint x|

Required information
Sets a breakpoint to stop execution at a specific source line ﬁ'

Executable (Optional)
Object (Optional)
Source;

| cLr1.CLLE

Line:

—

< Back |-l| Finish I Cancel

7. Click Next.

@& Edit a Line Breakpoint x|

Optional parameters
IMake the breakpoint conditional upon the following parameters ﬁ'

—Frequency

From:

To: | Infinity

Every: | 1

Expression: |

< Back I THext = '@‘ Cancel I

You only want to stop in the loop when it executes for the 99th time or more.
You can do that by setting the From field of the Frequency group to 99.

8. Under Frequency in the From field, type 99.
9. Click Finish.

You have added a breakpoint including a conditional breakpoint to your source
and now you are ready to begin [“Exercise 5.4: Monitoring variables” on page 88
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Exercise 5.4: Monitoring variables

Before you begin, you must complete [“Exercise 5.3: Setting breakpoints” on page]

You can monitor variables in the Monitors view. Now you will monitor the
variable &count.

To monitor a variable:
1. In the Source view, double-click the variable &count.
Line 7

000700 LOOEP: ¢
2000800 if (&count *1t 100) then (go

ooosaon CHGVAR VAR (&NAME) VALUE
oo1o000 chgvar var (elib) wvalue (
L~ 001100 CALL PGM (&lib/ PAYROLL
< | »

2. Right-click &count.
3. Click Monitor Expression on the pop-up menu.

The Monitors view opens.

& (onitors X

The variable appears in the Monitors view. Its current value is zero.

Tip: If you quickly want to see the value of a variable without adding it to the
Monitor, leaving the mouse pointer on a variable for a second or so will
display its value in a pop-up window.

Now that some breakpoints are set, you can start to run the application.
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ot N =

‘Jﬁ' O]
&%

3_551: CLR1 [iSeries: Debug Interactive ﬂpplit.atiu:l
B 3® state: <stopped: Connection: iSeries
=y Thread:1 (stopped) L\}

Al

= _CL_PEP:CLR1:(LR1
: = QCMDEXC : QCMDEXC : QCML
~~= executeCommand : QRSEMAIl_|

main : QRSEMAIN : RSEMAIN

_C_pep : QRSEMAIN : RSEMA
AMATERAD ST AN o S IY(‘f
4

4] |

Click the Resume “# icon from the Debug toolbar.

The program starts running and stops at the breakpoint at line 8. (Be patient,
the Debugger has to stop 98 times but because of the condition continues to
run until the 99th time.) Notice in the Monitors view, that &count now has the
value 99.

Click the Resume icon again.

The program stops at the breakpoint at line 8 again and &count now has the
value 100.

Click the Resume icon once more so that the program runs to the breakpoint at
line 11.

If you do not see the error message below, go to [“Exercise 5.5: Stepping into a
[program” on page 93

Error Handling

If you forget to add the parameter to the CALL program command when you
debug the program, you will see this error message.

& Debugger Message x|
/ ’i Program received unmonitored exception MCH3601: Pointer not set For
location referenced,
a. Click OK.

b. Click the Terminate ﬂ icon on the Debug toolbar.

The debug session terminates on the workstation but the exception waits for
input from the 5250 emulation session.

If you closed the Debug view by mistake, you will need to re-open the
Debug view and then terminate the debug session on the workstation.
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@i Debug - CLR1.CLLE - IBM Rational Software Development Platform = Il:l[lj

File Edt Source Compile Navigate Search Project Run  Window Help

[$5-0-8-Q- [®5  o[Fod
= EBRremoate Systs...

X
Registers T’Eﬂ'Moniwm 2\ ==

TR EZQE|BL|IES
@ 3COUNT = 00100,

A RL.CUE &2 PAYROLLG.RPGLE B|(E=ouine 52\ =0
Line 10 Column 1 Replace |#Anoutineisnot avalable.

000900  CHGVAR  VAR4]
001000 chgvar wvar_,

A2001100 CALL PGMw
4| »

asks |iseties Commands Log | Memory | %|BBL| B -=0)

Process; 587975/STECKHAM/QPADEYDOOD Program: CLRL

4 | o
||

Click Window > Show View > Debug.
@ Debug - CLR1.CLLE - IBM Rational Software Development Platform =10] x|

File Edit Source Comple Mavigate Search Project Run | ‘Window Help

]f‘j'- |3 -0 -9--4 - | ™ 5 New Window
[ltelia Open Perspective »
R T T
PSR Customize Perspective...  [= )
’ & consale Save Perspective As...
| Reset Perspective H &)
Server Close Perspective
13, Display Close All Perspectives
& Expressions Navigation :
5% outline Alt+Shift+Q, O
5 Preferences
% Tasks
%:l Threads and Monitors
9= Yarisbles
all Other...

Remember to terminate the Debug view if you haven’t done so already.
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c. Go to your 5250 emulator and press Enter until the program messages
complete and the Remote System Explorer communications server screen
appears again.

n A - [24 » 80] 'Q =10] x|

File Edit ‘Yiew Communication Actions Window Help

D] 2% B w| % & 8] @

)
- 51902 - Session successfully started 7

d. In the workbench, click the Remove all terminated launches icon on the
Debug toolbar to clean up the Debug view.

m Servers 7 -=\ | S = S
=-B <terminated> CLR1 [iSeries: Debug Interactiv mgatiun]

& {State: <engine terminated > Connection: ijRemave All Terminated Launches|
<terminated > Process: S87975/STECKHAM/QPADEYODOD Program: null

E

e. Click the arrow beside the Debug icon on the workbench toolbar to start a
new debug session.

f. Select Debug from the list.

CLR1.CLLE - IBM Rational Softwal
File Edt Source Compille Navigate Search

i % -0 -2 -Q -
"0 G e - By
| |

+ *

Debug As »

Debug - Si

Organize Favorites), .

The Debug Launch Configurations window opens.
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g. Click the How To Start tab.
The How To Start page opens.

CALL PGM(RSELABXX/CLR1)

"
i
i
i
o
i
i
i

i
s

By default, the page contains a call for the program selected in the Remote
Systems view.

h. Click Prompt.
The Call Program (CALL) window opens.
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& Call Program (CALL) x|
Program: = |CLR1 Mame
Library: > | RSELABXX ;] Name
Parameters: ! ) :I ( Adcq |
[™ tdvanced [~ &l Parameters [~ Keywords
CALL PGM{RSELABXY/CLR1) PARM{:X) 4]
‘ OK' I Restore defaults I Cancel I

i. In the Parameters field, type 'XX' where "XX" is your workstation number.
Click Add.

The parameter value will appear in the lower list.
j. Click OK.
k. Click Debug.

If you did not terminate the debug session, you will see this error message.

_ x|

Q Host: CPF3801 Job s already being serviced, traced, or debuaged.

Complete the steps shown earlier in the section called Error Handling to
terminate the debug session then start the debug session again by clicking
the arrow beside the Debug icon on the workbench toolbar and selecting
CLR1 from the list. Breakpoints and monitors are restored.

You have monitored the variable &count and now you are ready to begin
[5.5: Stepping into a program.”|

Exercise 5.5: Stepping into a program

Before you begin, you must complete [“Exercise 5.4: Monitoring variables” on page]

The Debugger allows you to step over a program call or step into it. When you
step over a program call, the called program runs and the Debugger stops at the
next executable statement in the calling program. You are going to step into the
PAYROLLG program.

To step into a program:
1. Click the Step into icon on the Debug toolbar.
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oy x N o=

> - | EL:‘ ==
|E| g;: iStep Into

= QUIMGFLW : QUIMGFLW : QU 4 |
i QUIMNDRY : QUIMNDRY : QLI

o QUICMENU ¢ QUICMEMNL ¢ QL
L-E QCMD : QCMD : QCMD
. ot Process: 251287(STECKHAMQPADEY!
= ‘k CLR1 [iSeries: Debug Interactive Applicati
=7 State: <stopped: Connection: iSeries
= o Thread:1 {stopped)
=8 CLR1; CLRI: CLRI

H " . -
3. L) FED « SILBA o SR
4| | 3

The source of PAYROLLG is displayed. Depending on the option you used to
compile the program (*SRCDBG or *LSTDBG for RPG, or *SOURCE, *LIST, or
*ALL for ILE RPG), this window displays either the Source or Listing View.

If you specified an incorrect parameter for the CALL program command, you
will see this error message.

& Debugger Message | x|
N
r’i Program received unmonitored exception CPFO001: Error found on CALL
command,

==

Complete the same steps as covered in the section called Error Handling in
[“Exercise 5.4: Monitoring variables” on page 88

2. Right-click anywhere in the Source view.
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Line 4 Column 9 Replace Browse
T - £ A el L e s LN E e Der UL e =i

nooooz F* PROGRAM NAME - Payroll A

pooooz F* DESCRIPTION - Time reportling master fileJ

000004 R exteornally described works

ooonos Syntax Check Selection AhAkhARAAAA LA KA &

000006 Convert Selection To Free-Form

opoooz Cut il CHAIN operation

poooposg copy CtritInsert tion

ooooos Paste Grly delete request

pgooolo Select T d . _

pooo11 St s fon se Iectlon

pooolz FEe Al selectlon

ooooLiz election

ooool4 Filter view Plde selection

oooois Shiow all Gl

gooole Source » AAREEERAREALLEL A

opooLlz _

ooools [ #Add to Snippets... n selection disp.

poooig = e for all mainte)

DDDUZQ EE TR E R R

000021 #dd Watch Breakpaint. .. tternally describ:

poonzz Manitor Expression ntenance displgy

0oooz3 Monitor Starage. ., » ployee master f£il:

goopz4 = Soct _moctax £i]e

000025 Y v Show "SOURCE er 1

000026 F‘.t‘k‘k‘k‘k‘k‘k‘k‘k‘k‘kt‘k‘k‘kt‘k‘k‘k‘k‘k‘k‘k‘k‘k* d Ak &

000027 FMSTDSP  CF E SewEoTATEN

oooozs FEMPMST UF A E E DIGE

pooozs FPRJMST UF A E E DIGSE

4 | LI_I

I

3. Click Switch view > Show *LISTING on the pop-up menu.
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. PAYROLLG, LISTING X =
Line 1 Column 1 Insert Browse
F——+ 1 + 2 ‘ 3 i 4 +-——=5 +
»| it *MODULE ENTRY AND MAIN PROCEDURE ENTEA
2 1 E‘***?\'***T\'1(1\'1(***********************1
3 2 F* PROG;AM NAME - Payroll =
! 3 F* DESCRIPTION - Time reporting mas
5 4 F* externally descrik
6 5 E‘**********************************’
7 & F* INDICATORS USED
g8 7 F* 50 - No record found on CHAIN oy
9 8 F* 60 - General error condition
10 9 F* 90 - Protect display on delete
11 10 F* KC - End of Jjob requested
12 11 F* KD - Return to application selec
13 12 F* KE - Return to employee selectic
14 13 F* KF - Return to project selectior
15 14 F* KG - Return to reason code selec
16 15 F* LR - Last record
’? 16 E‘**********************************i
18 17 E* SUBROUTINES USED
1% 18 F* EDITSL - Edit application select
20 13 F* ACDESR - Edit action code for al
21 D) FrAAAAAAAAAAAAAAAA AL A AL A A A A A A Ak hh ks
22 21 F* This program uses all externally
2 22 F* used are - MSTDSP - malntenance
24 23 F* - EMPMST - emplovee me
25 24 F* - PRJMST - project mas
26 25 F* - RSNMST - reason code
‘? 26 E‘**********************************i
28 27 FMSTDSE CF E WOREKST
29 28 FEMPMST UF A E K DISK
b 8
<| | 3

4. Page down in the source and take a look at the expanded file descriptions.

You don’t have any /Copy member in your PAYROLLG program but these
would also be shown in a Listing view. Switch back to the Source view.

5. Right-click anywhere in the Source view.
6. Click Switch view > Show *SOURCE on the pop-up menu.

You have stepped into PAYROLLG program, switched the view from source to
listing and back to source and now you are ready to begin [“Exercise 5.6: Listing]
[call stack entries.”]

Exercise 5.6: Listing call stack entries

Before iou begin, you must complete [“Exercise 5.5: Stepping into a program” on|

The Debug view in the upper left pane, lists all call stack entries. It contains a tree
view for each thread. The thread can be expanded to show every program,
module, and procedure that is on the stack at the current execution point. If you
double-click on a stack entry you will display the corresponding source if it is
available. Otherwise the message No Debug data available appears in the Source
view.

In the Debug view, expand the stack entry of Thread1 if it is not expanded already.
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J

= | = y
M, servers| | SERIREEER
= ‘t CLR1 [iSeries: Debug Interactive Application]
= ,I]@ State: <stopped> Connection: iSeries(TM) (ROS4004:5043)
| _ [%‘“m@ Thread: 1 (stopped)

CLR1 : CLR1 : CLR1
_CL_PEP : CLRI ! CLR1
QCMDEXC : QCMDEXC : QCMDEXC
executeCommand : QRSEMAIN : RSEMAIN
main : QRSEMAIN : RSEMAIN
_C_pep ! QRSEMAIN : RSEMAIN
QUICMD § QUICMD ; QUICMD
QUIMGFL'W : QUIMGFL' : QUIMGFL'W
QUIMMDRY : QUIMNDRY : QUIMNDRY
QUICMENU : QUICMENL : QUICMENU

i = QUMD : QCMD : QCMD

i p_] Process: 251237 /STECKHAM/QPADEYOOOF Program: CLR1

The stack entry allows you to work with and switch between different programs
and/or ILE modules.

You have viewed the call stack entries of your program and now you are ready to
begin [“Exercise 5.7: Setting breakpoints in PAYROLLG.”|

Exercise 5.7: Setting breakpoints in PAYROLLG
Before iou begin, you must complete [“Exercise 5.6: Listing call stack entries” on|

Now you add some breakpoints in PAYROLLG.

To add breakpoints:

1. Select PAYROLLG in Threadl.

2. In the source view (also called the iSeries default editor) scroll to line 57.
3. Double-click the prefix area of line 57.

A breakpoint icon is added to the prefix area of this line to indicate that a
breakpoint is set.

4. Repeat the above step for line 58.

Line 58 Column 1 Replace
i I% CLOND1Factorlt++++++Opcode (E) +E

£ 000057 g EVAL A
20000581 5! EVAL =

0ooosse c*

000060 C* Write the SELECT format t.

ooooel Cc*

poooez2 £k

0000B4 @ Dou .

| L|J

I

5. Right-click in the prefix area of line 87 and click Add Breakpoint on the
pop-up menu.
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./ PAYROLLG,RPGLE X, =
Column 1 Replace
N....CLONOlFactorl+++++++0Opcode (E) +F
ooooss C* If PRJAPL (project maintel4]
oooose C* branches teo label PRJTAG.
0oooas?7? C* If the prior two tests we
0oooss C* reason code maintenance.
0oooss C* next executable operation
000080 by
slbooog1 c SELECT  _
4 L|_I
|

To view all breakpoints, select the Breakpoints tab from the top left pane.

D Registers | 4 =1
RFEPR AT N[N~
.2 CLR1.CLLE [line: 11]
K RCLR L CLLE [line: 8]
2 PAYROLLG.RPGLE [line: 57]
2 PAYROLLG.RPGLE [line: 58]
2 PAYROLLG.RPGLE [line: 87]

This view shows all breakpoints currently set in your Debug session. This is a
convenient place to work with breakpoints. You can remove, disable/enable,
add, or edit a breakpoint. These tasks are available from the pop-up menu
when you right-click in the view area. Double-click any entry to show the
source where the breakpoint is set.

You have added several breakpoints to PAYROLLG and now you are ready to
begin |“Exercise 5.8: Removing a breakpoint in PAYROLLG."]

Exercise 5.8: Removing a breakpoint in PAYROLLG

Before you begin, you must complete [“Exercise 5.7: Setting breakpoints in|
[PAYROLLG” on page 97,

It is also easy to remove breakpoints from the Source view.

To remove a breakpoint:
1. Right-click the prefix area of line 58.

2. Click Remove Breakpoint on the pop-up menu.
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TSR T F'- ‘.'._ e r T
*/;, CLR1.CLLE emave Breakpoint T =

Disable Breakpdist
Line Add Watch Breakpaint... lace
Run To Location HSDERGSIEIE
000054 EVAL =
DDDOSS Monitor Expression EVAL =
0pDo00S6 Monitor Storage. .. P | EVAL
2000057 Syikch View y | EVAL
£poooss = EVAL
0ooos9 C*
000060 C* Write the SELECT format t-ll
4| | |
|

The icon is removed from the prefix area indicating that no breakpoint is set on

that line.
Now you are ready to run the PAYROLLG program.

Click the Resume ¥ icon from the Debug toolbar.

The program starts running and runs to the breakpoint at line 57.
Click the Resume icon again.

The program waits for input from the 5250-emulation session.

-ioix

File Edit ‘iew Communication Actions ‘Window Help

D 2% B =6 % & 9] @l

|2f" 1902 - Session successfully started v

6. Type an X beside the Project Master Maintenance option.
7. Press Enter in the emulation session.

The program runs to the breakpoint at line 87.
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You have removed a breakpoint from PAYROLLG and now you are ready to begin
[“Exercise 5.9: Monitoring variables in PAYROLLG” on page 100.]
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Exercise 5.9: Monitoring variables in PAYROLLG

Before you begin, you must complete [“Exercise 5.8: Removing a breakpoint in|
[PAYROLLG” on page 98

Now lets monitor variables and change them in PAYROLLG.

To monitor variables:

1. In the source view, double-click the variable EMPAPL on line 88.
2. Right-click the variable.

3. Click Monitor Expression on the pop-up menu.

:fCLRLCLLE m (=1 Add to Snippets. . 5

Line 88 SavE

000086 Add Watch Breakpoint... =
0000B7 re no n
000088 The Run To Location L
0oooge . pressio

000090 ges

L 000091
Switch Yie »

000092 BTy =
- —

|
4. Click the Monitors tab in the upper right pane.

The variable appears in the Monitors view. Its value is blank because you did
not select the Employee Master Maintenance option.

5. In the same way add the variables PRJAPL on line 91 and RSCDE on line 113
to the monitor.

Variable PRJAPL equals X because you did select the Project Master
Maintenance option.

6. In the Monitors view, double-click the variable RSCDE.
The value changes into an entry field.
7. In the entry field, type in the new value X for the variable.

Breakpo. ., =y ==

FRRELE| L EBE
~@  COUNT = 00100,
@ EMPAFL =
L@ PRIAPL=1X

8. Press Enter.

The variable is successfully changed.

You have monitored several variables in PAYROLLG and now you are ready to
begin [“Exercise 5.10: Adding a memory monitor” on page 101
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Exercise 5.10: Adding a memory monitor

Before you begin, you must complete [“Exercise 5.9: Monitoring variables in|
[PAYROLLG” on page 100

Adding a memory monitor for a variable allows you to view the memory starting

with the address where the variable is located. The memory is displayed in
hexadecimal and text format.

To add a memory monitor:
1. In the Source view, double-click the variable ERR in line 33.
2. Right-click and select Monitor Storage > Memory on the pop-up menu.

A CLRLLCUE m ROLLGR Moritor Expression EOUU‘"S BN\ 0]
Line 33 Co. Manitor age. .,
N
Switch View » 2 ASCIJEBCDIC
000033 3] =] 3 Signed Integer
ooo034 D EMESS S et 4 Unsigned Integer
0opo3s E* 5 Map...
000036 CAFARAARARRARA AR ARFARA AR A RA LK & dsa.xml
onon37 C* MAINLINE CALCULATIONS 7 psa.xml
000038 c****************************
0ooo3s C* This mainline routine con .,
A new page is added to the Memory view. The tab shows the name of the
variable.
Console | Tasks | [Seties Commands Log m + R & EE > =0
ERR : Dxc6ba71b7(7017250 <Hex> |
Address [o-3 [4 -7 [6 - B [c-r | B
CEEAT1ETF7017ES0 = =- cec-inp | C3C540E2
CEBA71B7F7 CED3C5C! o Base A E C540D5DE
CEBAT1BTF70 E340C5Di  GotoAddress... S P E77F4040
40400401 ol < , 1 DeD5C540
~1D7D7D" 28 )
C3IE3C5CY  Peformat p _|
C1D5C3C! -E Copy To C|Db€l&‘d 1 ]
C9C3C1E{S 5 | C3E3C5C4
40C6D6D¢ = Pk C1D5C3CS
40404041 Dereference Painter E3CAD&DS
40C3D6CT o g s pmp can) perpn ey gy e E4C1D340 ﬂ

3. Use the scroll bar on the right of the Memory view to scroll down.
You can see the current content of the memory.

&

Right-click in the view area.

o

address.
6. Click the X on the Memory title bar to remove the Memory monitor.

Click Reset to Base Address on the pop-up menu to return to the starting

[.Consule ‘ Tasks l iSeries Commands Log m

#[x]o- 5 & ~ =0

You have added a memory monitor for the variable ERR and now you are ready to

begin [“Exercise 5.11: Setting watch breakpoints” on page 102.|
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Exercise 5.11: Setting watch breakpoints

Before iou begin, you must complete [“Exercise 5.10: Adding a memory monitor”]

A watch breakpoint provides a notification to the user when a variable changes. It
will suspend the execution of the program until an action is taken.

To set a watch breakpoint:

1. Go to the Line number field at the bottom of the source area. In this field enter
116 to go to that line.

Line 33 Column 11 Replace
..... DNamefft+++++++++ETDsFrom+++To/L

000027 FMSTDSP CF E |
oooozs FEMDMST UF A E K
000029 FERJIMST UF A E K
000030 FRSNMST UF A E K
pooo31 D*

gooos3z D* (Complile time array contai;
pDooon33 BlFRR 5 .
< | I ’
D

2. Double-click variable *IN60 to highlight it.
3. Right-click and click Add Watch Breakpoint on the pop-up menu.

The Add a Watch Breakpoint window opens. The Expression field is pre-filled
with the highlighted variable *IN60.

By default the Number of bytes to watch field is set to zero, which means the
variable will be watched in its defined length.

& add a watch Breakpoint x|
Required information
Sets a breakpoint to stop execution when data changes at a specific address ﬁ'
Address or expression: | FINED
Number of bytes to watch: |IJ ;]
< Back Next > I Finish Cancel

4. Click Finish.
The watch breakpoint is now set.
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Click the Resume button on the Debug toolbar.

The application waits for input from the 5250-emulation session.

-ioi x

File Edit Wiew Communication Actions ‘Window Help
D 2% @ =6 % & 9] @l

|Connected to remate servér.fhost toras pdl0l on psprintl:pd101 - A

‘.d'.l

In the 5250 emulation session, type 123 for Project Code and D (for delete) in

the Action Code field.

Press Enter. A message is displayed indicating that the variable *IN60 has

changed.
& Debugger Message B x|

/"=y VYariable *IN60 has changed in program PAYROLLG, module PAYROLLG, which
\4) is running in job QPADEYODOT/STECKHAM [S87478,

Click OK. The program stops at line 465. This line is located immediately after

the statement which caused the variable *IN60 to change.

You have added a watch breakpoint for the variable *IN60 and run the program to

see the notification that the variable has changed and you are ready to begin

[“Exercise 5.12: Closing the debug session.”|

Exercise 5.12: Closing the debug session

Before iou begin, you must complete [“Exercise 5.11: Setting watch breakpoints” on|

To close the debugger:

1.

Click the Resume icon on the Debug toolbar.

The application waits for input from the 5250-emulation session.

Switch to the 5250 emulation session.
Press F3 to end the job.
A message Program terminated appears:

Chapter 5. Module 5. Debugging a program
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& Debugger Message x|

@ Pragram terminated.

Click OK.
=lolx|

n Window Help

] =] - =5 | F%pehi »
2.
E Clasge all
{ n [=) —_ = |
;\farlables[ '@ Breakpoints | e El.-
v Show Text Ji -

5. Right-click the Debug icon on the top right of the workbench.
6. Click Close on the pop-up menu to close the Debug perspective.

Now you are ready to review your knowledge of this module by taking the quiz.
You can also apply what you have learned in this module by completing the
practice tasks detailed in More practice.

Quiz
1. You can start the debugger:
a. From the Remote Systems view
b. Launch Configurations window
c. Both
2. You can only set breakpoints at executable lines. (T, F)
3. To set a breakpoint you:
a. Right-click on the line and click Add Breakpoint on the pop-up menu.
b. Double-click in the prefix area.
c. Right-click in the Breakpoints view and click Add Breakpoint on the
pop-up menu.
d. Right-click in the prefix area and click Add Breakpoint on the pop-up
menu.
e. All of the above
4. You can change variables and indicators in the:
Remote Systems view
Debug view
Monitors view
Source view
. All of the above
5. The debugger allows you to:

© a0 o

a. Step over a program call
b. Step into a called program
c. Both

6. The Debug view lists all call stack entries. It contains a tree view for each
thread. (T, F)
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7. You can perform which actions on breakpoints:

a. Delete

b. Add

c. Disable/Enable
d. Edit

e. All of the above

8. Adding a storage monitor for a variable allows you to view the storage
starting with the address where the variable is located. (T, F).

9. The Storage monitor supports these display formats:

a. Hexadecimal and text
b. Character
c. Text only
d. Decimal
e. Aand B
10. A breakpoint provides a notification to a user when a variable
changes. It will suspend the execution of the program until an action is taken.
a. Watch
b. Line

c. Conditional
More practice
Given your experience in working with the debugger features, in your own source,
try setting, changing, deleting, enabling, disabling line breakpoints, setting watch
breakpoints, displaying and changing variables and viewing the call stack as you

debug your program. Use the product online help to assist you in these tasks.

Module recap

You have completed [Chapter 5, “Module 5. Debugging a program,” on page 79,
You have learned how to:

* Invoke the debugger from the Launch Configurations window
¢ Add a breakpoint

* Add a conditional breakpoint

 Edit a breakpoint

* Monitor a variable through the Monitors view

* Step into your payroll program

e Show a listing view

* List the call stack entries in the Debug view

* View all breakpoints

* Remove a breakpoint

* Monitor storage

* Set a watch breakpoint

* Close the debugger

You have mastered debugging your program and now you learn how to define

filters and perform actions. Continue with [Chapter 6, “Module 6: Exploring Remote
[System Explorer,” on page 107.|
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Chapter 6. Module 6: Exploring Remote System Explorer

This module teaches you how to use the Remote System Explorer perspective to
work with the iSeries objects that you used in the previous modules. You will learn
how easy it is to define filters, perform actions and define your own actions. In
short, you'll see how Remote System Explorer can organize and integrate your
work and make that work easier.

In this module, you will:

* Know the features of Remote System Explorer

* Create a filter to show specific iSeries libraries

¢ Change the filter to add more iSeries libraries

* Create a filter to show all the source files in a library
* Access members to edit from your filter

* Create a user action that copies a source file with data to a new source file in the
same library

* Specify user action parameters
* Specify a restriction on a user action
* Try the user action

¢ Run an OS/400 command from the iSeries Table view

Exercises

* [“Exercise 6.1: More about the Remote System Explorer”]

* |[“Exercise 6.2: Creating a library filter” on page 108|

* |“Exercise 6.3: Creating an object filter” on page 112|

* |“Exercise 6.4: Creating a user action” on page 116|

* |“Exercise 6.5: Running commands from the Remote System Explorer” on page
121

Time required

This module will take approximately 15 minutes to complete.

Exercise 6.1: More about the Remote System Explorer

Most of the functions of CODE Project Organizer have been replaced by
WebSphere Studio functions with the exception of accessing ADM parts. The
Remote System Explorer is replacing PDM (Program Development Manager) on
the workstation. It currently doesn’t have all the function of PDM but will over
time eventually be a full replacement for PDM.

Remote System Explorer allows you to:

1. Simplify your work by giving you quick access to lists of iSeries libraries,
objects, members, IFS files, UNIX® files, and local files.

2. Use the context-sensitive pop-up menus on these lists to perform actions such
as start the Remote Systems LPEX Editor, CODE Designer, or Integrated
Debugger or other common iSeries actions.
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3. Use the Work with User Actions option to create and manage your own
user-defined actions and have them appear in the pop-up menus.

4. Use the command support to increase your productivity by allowing you to
enter and repeat iSeries or local commands without switching to an emulator
session.

You have read the list of Remote System Explorer capabilities and you are ready to
begin [“Exercise 6.2: Creating a library filter.”|

Exercise 6.2: Creating a library filter

Before you begin, you must complete [“Exercise 6.1: More about the Remote System|
[Explorer” on page 107

In the Remote System Explorer perspective, you now need to get to the iSeries
objects you want to work with.

In the previous modules you have worked with the Library list. Now you will
create your own library filter. Library filters list a set of libraries from your iSeries
system in the Remote Systems view. But first let’s understand what filters are all
about.

Filters allow you to easily organize elements within your system. You use the filter
function to list iSeries native file system objects (such as libraries, objects, or
members).

& Remote System Explorer - PAYROLLG.RPG

File Edit Source Mavigaste Search Project R

|t |% -0 -Q- |5 |
| |m g |AY REE
= :ﬁ“ it
[ New Connection -
B Local
= Big s400aa
=B s400a
& "I Ce iy it

; : >
€T work with ibraries..

POE 'Zklj' ork with members...
-+ "
Library list

; Bl

To create a library filter:

1. In the Remote Systems view expand the connection that connects to your
iSeries system if its not already expanded.

2. Expand iSeries Objects if its not already expanded.

3. Expand Work with Libraries. (You can also right-click iSeries Objects and click
New > Library Filter on the pop-up menu).

Expanding Work with libraries corresponds to the WRKLIBPDM command,
plus creates the filter in the Remote Systems view.

The Create a new iSeries library filter page opens:
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x|
Library Filter
L -,
Create a new [Series library fileer B

Library: |RSE“| 1 ;l J Browse. .. |

< Back I Mext > I Finish | Cancel I

You are going to create a filter to specify the libraries you want to work with,
so they will show in iSeries Objects. You want to create a filter that shows all
libraries on the iSeries with the name RSExxxxx and VARxxxxxxx, xxx being
any character.

Note: You may need to select different libraries that appear on your system if
libraries with the above names do not exist.

You specify the first filter string that selects the libraries starting with RSE.
4. Type RSE* into the Library field, using the * wild card character.
5. Click Next.

The Name the new filter page opens.

x
Library Filter
Mame the new Filter -}1 M
&>
= | l

Filters are saved for easy re-use. Specify a unique name For this filker, This name will
appear in the Remote Systems view, and will be expandable,

Filter name: &l RSE and YARPG libraries ’

I Orily create filter in this connection

Select a profile ko own the new Filker, This determines if it is unique to you, or
sharable by the team. It will be placed in the default filker pool for that profile.

Owner profile: |msteckh?tp ;]

< Back I Mext = ‘@, Cancel |

Note: You can choose between creating the filter for all connections or for this
specific one only.

6. In the Filter name field, type A11 RSE and VARPG Tibraries.
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You give your filters a name because the Remote System Explorer saves them
for future use, unlike PDM, which does not save filters.

7. Click Finish.

Back in the Remote Systems view under iSeries Objects you will see the new
filter expanded, listing all RSE* libraries.

Now you need to add the VARPG libraries.
Changing the library filter

To change the library filter:
1. Right-click the filter All RSE and VARPG libraries and click Change.

1 Remote Systems. X Teaml =m
&£ 2| SR 4
i3] ? Work with objects. .. -
-3 Work with members. .,
i Library list
28 ﬁ':=b User libraries
=k 3
-4l RSEL:  New »
=4 RSELY  Golnto
& Ml RSEL oo »
-l RSELs
-, RseL £ Open in New Window
=i, RSELs
=iy, RSEL+ £ | Refresh
EEh RSEL Epad .
L+:_ il RSELs olapse )
[+, RSEL:
E0 K] . Change...
=i}, RSELs
- RSEL: [ Rename...
L+:. Wk RSELY N
-, RSEL: =
@ Jify RSELs i+ Move...
@M\ RSEL' 3¢ Delete...
=Ml RSELs
@\ RSEL < Move Up
- RSELY g
B 'h RSELs ‘r Move [Down
M RSELY e o i Table
=i RSEL
g rses B Find String...
: =il RsELs
! @M RseL, Froperties
«| | ]

The Change Library Filter window opens.
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w

@& change Library Filter x|

Filter name: Al RSE and YARPG libraries
Parent filter pool: Msteckh7tp Filker Pool
Filker

New Filter string:

Libra ‘ﬁ v:] Ernwse...l
Test | Revert |

D e |

Select New filter string from the Filter strings list.
In the Library field, type VAR*.

Click Create.

The VAR* filter string is added to the list.

Click OK.

You are now back in the Remote Systems view.

i
&
4

-y RSELAB41.*lib.kest -~
[, RSELAB42.*lb.test
-l RSELAB43.*ib.test
-, RSELAB44.*lib.test
i, RSELAB4S.*lib.test
i, RSELABSO.*ib.prod
i, RSELABED.*lb.test
il RSELABSL.ib.test
-l RSELABSZ. *lib.test
-l RSELABES. *lib.test
il RSELABE4.*lb.test
i, RSELABES. *lb.test
il RSELABES. ¥lib.test
-l RSELABST *lib.test
Wi}, RSESERVER.*ib.prod
G- i) RSEWLILKAN, *ib. test
[y, RSE100,*iib.prod
-l RSE1000.*ib.prod
-y RSE10000.*ib.prod
&y RSES000.%ib.prod
By YARLABHX. *ib.prod
-l vARLABOD.*lib.prod
-y VARLAB10.*ib.test
iy vARLAB11.*ib.test
Bl vARLAB1Z. *ib.test
- YARLAB13.#lib.test
-y YARLAB14.*lib.test
-y VARLAB1S. *ib.test
=iy YARPGSETUR. *ib.prod i
- “ iSeries Commands

ﬁ iSeries Jobs X
4| | »

You will see the list expanded to include your filter. Now you can work with
the libraries directly and can drill down to the object you want to work with.

iy

FOE R R R
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You have created a filter to show a specific iSeries library and changed that filter to
add more iSeries libraries and you are ready to begin |“Exercise 6.3: Creating an|

object filter.”

Exercise 6.3: Creating an object filter

Before you begin, you must complete [“Exercise 6.2: Creating a library filter” on|
ia ge 108.

Now create an object filter. Object filters list a set of objects from your iSeries host
in the Remote Systems view.

To create an object filter:

1. In the Remote Systems view, expand your connection and then expand iSeries
Objects if not already expanded.

i Remote Systems

i B %@ iSeries Objects -
| I L g o " .

I T Work with objects. .

b Lers...

RNy g
[ §p Library list
! i:% User libraries
NCE 35l RSE and VARG libraries
=il RSELAB.*ib.prod
-l RSELABES. *iib.prod
- il RSELABGMA, *lib.prod
&-Iffy RSELABKM.*lib,prod

2. Expand Work with objects. You can also right-click iSeries Objects and click
New > Object filter on the pop-up menu.

Note: Expanding Work with objects corresponds to the WRKOBJPDM
command.

The Create a new iSeries object filter page opens:
Now create a filter to show all your source files in your RSELABXX library.

x|
Object Filter
Create a new [Series object filker *1 N
]

Library: RSELABxx| _v_I J Browse. .. |
Object: b :] ;| Browse. ..
Object type: | *

Object attribute: | *

Mare Types=>= I

< Back I MNext > I Finish Cancel

3. In the Library field, type RSELABxx.
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4. Click Browse beside the Object type field.

The Select Object Type window opens.

@& select Object Type x|
Select an object type:

*CTLD ]

*CRG
*CRQD
*DEVD
*DOC
HDTAARA
*OTAQ
*EDTD
FEXITRG
HECT

*FLR
*ENTTEL
*ENTSRC
*FORMDF
*ETR
*G55
HMGCLG
*IPYD
*J0BD
*J0BQ
*JOBSCD

*IRN ;I
FARKIRCY

[ o« | concel |

Select *FILE under the Select an object type list.

Click OK.
The Create a new iSeries object filter page displays with the object type
updated.
x
Object Filter
Create a new (Series object filter #1 N
Library: |RSELABxx ;I j Browse, .. |

Object: |“ :_I J Browse.., |

Object type: | *FILE x| J | Browse. .. I
Object attribute: | * =14

Mare Types==

< Back I Next > I Finish |

Cancel I

Click Browse beside the Object attribute field.
The Select Object Attribute window opens.

Select PF-SRC under the Select an object attribute list.

Click OK.
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@ select Dbject Attribute x|

Select an object attribute:

BSCF38
CMMF3E
DDMF
DFL
DFUEXC
DFUNOTERC
DETF
DSPF
DSPF38
ICFF

LF

LF35
MHXDF35
PF-DTA
PF38-DTA
PF-5RC

PF38-5RC
PRTF
PRTF38
SAVF
TaPF

| QK I Cancel

10. Click Next.
The Name the new filter page opens.

@rew x|

Object Filter
Mame the new filter 41 M

-

Filters are saved for easy re-use. Specify a unique name For this filker, This name will
appear in the Remote Systems view, and will be expandable,

Filter name; | My source files|

[ Orily create filter in this connection

Select a profile ko own the new Filter, This determines if it is unique to you, or
sharable by the team. It will be placed in the default filker pool for that profile.

Owner profile: |msteckh?tp ;]

<Back | Nexr.>[k|| Fish |  Cancel |

11. In the Filter name field, type My source files.
12. Click Finish.

The new object filter displays in the Remote Systems view under iSeries
Objects:
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[1]
iy
4

4 21|

-l RSELABES. *ib.kest -
- [}, RSELABET. *lib.test
- iy, RSESERVER.*ib.prod
Bl RSEWULKAN, *ib.test
-l RSE100,*ib.prod
-y RSE1000.%ib,prod
- i, RSE10000.*ib.prod
- iy, RSES000.*lib.prod
Bl YARLABEX. *ib.prod
Bl VARLABOO, *iib.prod
-y, VARLAB10.*lib.test
- [l VARLAB11.*¥lib.test
- ifh YARLAE12.*lib.test
Bl YARLABL3. Mib.test
-l VARLAB14.*ib.test
¢ @l YARLABIS Hib.test
- -l VARPGSETUP, *iib.prad
SR A1y source files
[*-=) COMPARE *file.pf-src
- Ely QCBLLESRC. #file. pF-sre
- [Ey QCLSRC. *file.pf-sre
[y QCMDSRC. *file.pf-sre
-El) QDDSSRC. *file.pF-src
-2 QRPGLESRC, *file. pf-src
- Ey QRPGLESRCP, *file, pf-src
=gk iSeries Commands
& m iSeties Jobs
- *y IF5 Files
% Qshells
& Iﬁ s400a 1

-

4| | _:_l_

Note: If you end up with too many filters, you can create filter pools. They
allow you to group filters.

Now you know how to create filters and tailor your development
environment. Filters can also be specified for non iSeries servers and your
local system.

Now you can work with the objects you have in your Remote Systems view
like you worked in PDM with a subset of libraries, objects, or members.

Let’s assume you want to edit the member PAYROLL in the source file
QRPGLESRC using this object filter.

Editing a member from your own object filter

To edit a member:

1. Expand QRPGLESRC.

2. Right-click member PAYROLL.

3. Click Open With > Remote Systems LPEX Editor on the pop-up menu.
This will download the source member and open the editor with this member.
After you have edited the member you could save it and then compile it from

the Remote Systems view by using the pop-up menu options on this member.
You can also create your own actions in addition to the default actions.

You have created a filter to show all the source files in your library and accessed
members to edit from your filter and you are ready to begin [“Exercise 6.4: Creating]
fa user action” on page 116
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Exercise 6.4: Creating a user action

Before iou begin, you must complete [“Exercise 6.3: Creating an object filter” on|

In PDM you can create user actions in addition to using the pre-supplied system
actions. In Remote System Explorer you can do the same. You define user actions
through the Work With User Actions window. User actions can be defined for
iSeries libraries, objects, members and jobs as well as folders and files in any
remote UNIX, Windows, Linux, Local, or IFS system.

To open the Work with User Actions wizard:

1. Expand your iSeries connection and expand iSeries Objects if not already
expanded.

.15 Remote Systems X Tearn| =8| Aar1.cle rf PAYROLLG.RPGLE %\\E
4{» &7 < |BR - Line 1 Column 1
[+ ﬁ'} Q5YS.Mib.prod-sys goopol e i B |
& Wl ©5YS2Mib.prod-sys ooopoz F* PROGRAM
= m?_\ QHLPSYS. *ib.prod-sys 0oooo3 F* DESCRIE
=il QUSRSYS. ¥ib.prod-sys 000004 p
-l QGPL.*lib.prad-ust 000005 Fre®ththrrs

[l WFLABHX, *Iub tesk-usr

gooooe F* TINDICAT:

£z} ﬂ:; RS
- aﬁr User libraries New L4 F* 50 - No
=] ﬁ# Al RSE and VARPG b~ GoTo » F* 6E0 - Ge:
F* 90 - P
-y RSELAB.*ib.prod Expand To 5

l m RSELABES. *ib. pre F* KC - En

b b.pr F* KE - Re-
- W, REELAEMIS! b, Ff‘"""d # mR e = B
=, RSELABOLD My  -ClEPEE > Pk RE - Ra
c3 i, RSELABORIG, *iib o

51 i), RSELAGTEST b, - Rename:.: F* LR - La:

mRSELABX*Iihpm-.,_-,CUD\f Frx**x*xxx**%x
G Wik RSELABXX. ¥ib.pr e pocre F* SUBROUT:
&y RSELABDD.*iib.pr: F* EDITSL
-, RSELABO1. ¥ib,te: ¢ Delete... W AGBRER |

Bl RSELABO1A.MIb.t i k.
Add Library List Entry. .. F
=il RSELAEDZ, ¥ib.te: 4

& W, RSELABO3. ¥ib.te: ¥ Remove From Library List E': This pr
[y RSELABO4.Mlib.te: | Move Up In Library List E used a _:|;|
- RSELABDS. ¥ib.be: T =

il RSELAEOS. ¥ib.ter
-, RSELABO7,Mib,te: f+ Move Within Library List...
[+ |l RSELABOS.*ib.te:

& M\ RSELABOY, *ib.te: E=| Show in Table 2 \_iseries... | iSeries... |
4 " Find String...
Elproperties 52 . Remate Scratch  “nange.. & I
= Save(B)...
Restore... !
Property | Value User Actions
arbribuire PRON- 1SR

2. Expand the Library list filter if not already expanded.

3. Right-click RSELABXX.

4. Click User Actions > Work with User Actions on the pop-up menu.
The Work with User Actions window opens.
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@& Work With User Actions ! i]

Parent profile: |[QEdeaari)

In the right pane of the Work with User Actions window, expand New in the

list, if it is not expanded already.
Select Object action.

You want to create a user action that copies a source file with data to a new

source file called QJUNKSRC in the same library.

@& work With User Actions

Parent profile: |mstadd1?tp

& E; ey Action name:
ﬁ Object action
: lt:} Member action Comment:
R

RTDUPOB]

4

Insert variable. .. | Edit... Browse. ., I

[ Prompt First I Refresh after ¥ Show action
[ single selection only | Invoke once

Resource types for which this action will appear

Defined Types Selected Types
Addz

=RemovelG)

Edit(H)...

| Create I Revert(1) I

Close |

In the Action field, type Copy source file for the user action name.

In the Comment field, type Copy source files with data.
In the Command field, type CRTDUPOBJ for the command to execute.
Click Prompt to open the command prompter for this command.
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e Duplicate Obje RTDUPOE x|

From object: BN | Mame, generic*
From library: I&L _'_] Mame

Object type: a7 = ad |
To library:

New object:

Duplicate data:

I~ Advanced Eﬂl Parameters [ Keywords

CRTDUPOB) OBX(&M) FROMLIB(&L) OBITYPE(AT) NEWOBI(QIUNKSRC) ]
DATA{(*YES)
k|

oK | Restore defaults I Cancel I

This is the command you will be running:
CRTDUPOBJ OBJ(&N) FROMLIB(&L) OBJTYPE(&T) NEWOBJ(QJUNKSRC) DATA(*YES)

Specifying user action parameters

To specify user action parameters:

1.

In the From Obiject field, type &N to indicate to use the name of the selected
object in the Remote Systems view.

In the From Library field, type &L to pick up the library name from the selected
object.

In the Object Type field, type &T to pick up the object type from the selected
object.

In the New Object field, type QJUNKSRC.

Select the All parameters check box to see the additional Duplicate data
parameter.

Now the Duplicate data parameter is also shown on the prompt window.
Select *YES from the Duplicate data list.

Click OK.

You return to the Work with User Actions window.

Select the Refresh after check box, so that the Remote Systems view gets
refreshed after the action has been run.
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@& work With User Actions I x|

Parent profile: |msteckh?tp ‘j
& E; New Action name: ECupy source file
E Object action
: lt:} Member action Comment: qu:l',l' source file with data
Command: iNormaI command j

CRTDUIPOE] OBJ(&M) FROMLIB(&EL) OBITYPE(T) NEW - |

| | _»J;I

Insert variable. .. | Edit... | Browse. ., I
Prompt... |
[ Prompt: first by Refresh aftev Show action

[~ Single selection only | Invoke once

Resource types for which this action will appear
Defined Types Selected Types

FILE_DATA FILE_SRC
FILE_DSPF -
FILE_MBRS

FILE_SRC: *FILE:PF*-SRC

Create | Revert(1) I

Close |

Note: Clicking the Insert variable push button displays a list of valid
replacement variables with the explanation of what they do.

This user action is only valid for Source physical files. You need to specify this
restriction so this user action will only show in pop-up menus when you
right-click on a source physical file.

Specifying a restriction on a user action

To specify this restriction:
1. Under the Defined Types list box, click FILE_SRC.
2. Click Add beside the Defined Types list box.

FILE_SRC is now one of the selected types. Actually since you only selected
this one it is the only one.

3. Click Create then Close.

Now, only when you right-click on a source file, will this user action appear on

the pop-up menu. For any other object type it will not appear. Back in the

workbench and the Remote System view, give it a try.

Note: Remember to close the payroll source member if you opened it earlier.
Trying the user action

To try your user action:
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1. Locate your filter My source files.

N

._'. Remote Systems

PAYROLLG.RPGLE £2 ~_ O
\_

52 2] ' Refrash Column 1
3..&:& RSELABGE, *lib. test Expand 3 R I ST
), RSELABS7.*ib.test Coliapee FARRARAAKAA] i!
i ﬂ-‘& RSESERYER.*lib.prod E* PROGRAM

-y, RSEWULKAN *ib.test | Rename. ..
c] ﬂ.:, RSEL00.*ib.prod
w4, RSE1000.Mb.prod ) COPY
Wil RSE10000.*ib.prod [ Paste
i}y RSES000.*iib.prod o Move,..
-, VARLABX. ¥lb.prod

F* DESCRIP
F*

FEXExEARLL R
F* INDICAT!
F* 50 - No

& [, WARLABOO.*lib.prod * Delete... F* 60 - Ge:
=i, YARLABLO, *ib,test E ) F* 80 - Pr»
i, VARLAB11, *lib.test Zaclilzs F* KC - En
& il VARLABLZ. ¥ib.test : Cachie File Descriptions F* KD - Re-
;t]--ﬂ% WARLABL3. lb.test %" Find String... F* KE - Be
-l WARLABL4. Hib.test Change(B)... S e . B

# i}y YARLABIS. Mlb.test
i, YARPGSETUP.*ib.proc
=] if-&- My source files

F* KG - Re-
La:

- Ely COMPARE. *file. pf-src BEHON

[+ (=) QCBLLESRC.*file.pf-sr 3

7 %] @ _D Add To iSeries Project... L1 work with User Actions. ..

(¥ ﬂ' QCLSRC, *file.pf-src Make Available OFfline )

-y QCMDSRC. ¥file.pf-src 7] F* ACDEER -
& 5 it c Properties(K) i) FhAakhhhhihi:
: [ ooo021 F* This pr.

2. Expand the filter My source files, if it is not already expanded.
Right-click the QRPGLESRC file.
4. Click User Actions > Copy source file on the pop-up menu.

w

The file gets duplicated and the list gets refreshed. Your new source file will
show in the list. You can check the messages of the CL commands you are
running in the RSE Communications server job by looking at the iSeries
Commands log in the right hand side bottom pane of the workbench.

B iSeries Commands Lag X SGER) Search] Vo

s400a I

NEWOBJ(QIUNKSRC) DATA(YES) A
Object QIUNKSRC in RSELABYXY bype *FILE created.

1 objects duplicated.

Cause .. .. .: Al the objects with supported object types specified on
the Create Duplicate Object (CRTODUPOB]) command were duplicated.
See low level messages o determing if any objects were not duplicated.

b

Command ll‘uormal ;l l ﬂ

5. To delete the source file QJUNKSRC that you just created, right-click
QJUNKSRC.

6. Click Delete on the pop-up menu.
The Delete Confirmation dialog opens.

7. Click Delete.

You have created a user action that copies a source file with data to a new source
file, specified user action parameters, specified restrictions on the user action and
tried the user action and you are ready to begin [“Exercise 6.2: Creating a libraryl

[filter” on page 108
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Exercise 6.5: Running commands from the Remote System Explorer

Before iou begin, you must complete [“Exercise 6.4: Creating a user action” on|
page 116.

The Command entry is part of the Remote Systems view.

To run a command:

1.

2.
3.

Check if you have an iSeries Table View tab in the bottom right pane where
your command log appeared in the previous exercise.

If you have it, click on it.

If you don’t have it:

a. In the Remote Systems view, right-click My source files filter.
b. Click Show in table on the pop-up menu.

As you have seen already you can now run commands on the iSeries server
that the table is connected to. You can enter commands in the Commands field
beneath the iSeries Table view, and view messages in the Messages field. You
can enter a command and click either Prompt to specify parameters and then
Run, or just click Run. When you run a command, the Messages field is
populated with the messages from the command. When you select a message,
the Details button is enabled. When you click this button, the message and its
help is displayed.

Type an iSeries command, for example ?ADDLIBLE.

ﬂ\l_s__arjas_ VTS B [Series Commands Log | Remote Search[ aF 69 « > & w =0
Filter Ty SOUPEE Tes (8 Objects)
_Name [ Type | attribute [Text | status [«
E] COMPARE *FILE PF-SRC K L
[EyqcsLLesre *FILE PF-SRC OF
E] QCLSRC *FILE PF-SRC Ok
@ QCMDSRC *FILE PF-SRC CK _ILI
4] | »
w
Command [formal 'll?ADDLIBLE ] =] prompt... | Run |
Messages | _'_I Details,,, | Show Lod,., |

The question mark is there to display a prompt screen.

Instead of specifying a question mark you could use the Prompt push button.
Click Run.

The Command Prompt window for the ADDLIBLE command opens.

In the Library field, type RSELABOO and click OK.
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& add Library List Entry (ADDLIBLE)

Library: -RELnEiclnl Name
Library list position: ;
List position: *FIRST - I
Reference library: Name
I~ advarced I Al Parameters I~ Keywords
ADCLIBLE LIB{RSELABOO) ]

]

() | roetots| _ cont |

That will add this library to the library list of your Remote System Explorer job
on the iSeries server.

Note: You may need to add a different library if the library RSELABOO does
not exist on your iSeries system.

The messages field will confirm the successful completion of this command. To
get to the command history, similar to F9 on the 5250 screen, select the
appropriate value from the Command list (down arrow beside the Messages

field.

I iseries Table view X iSeries Commands Log | Remoke Saarch[ L‘f 6§? @ o m e =0
Filker My source files' (8 Objects)

_Name [ Type [ Attribute [ Text [ status [«
E] COMPARE *FILE PF-SRC K |
[EhqeBLLESRC *FILE PF-SRC 0K

QCLSRC *FILE PF-SRC OK

QCMDSRC HFILE PF-SRC oK =
4 | »
w

Command |Norma| :j | _-_-I Prompt. ., | Rur |
Massagedibrary RSELABOO added to library |§> ;I Details. .. l Show Legd.,, I

You could also use the iSeries Commands subsystem in the Remote Systems
view underneath the iSeries Objects subsystem and run predefined commands
or define your own commands.

You have run an OS/400 command from the iSeries Table view.

Now you are ready to review your knowledge of this module by taking the quiz.
You can also apply what you have learned in this module by completing the
practice tasks detailed in More practice.

Quiz
1. The Remote System Explorer is replacing what ADTS tool:
a. Page Designer
b. CODE Designer
c. Screen Design Aid
d. Program Development Manager

2. filters list a set of libraries from your iSeries system in the Remote
Systems view.
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11.
12.

a. Object
b. Member
c. Library
d. Job

Filters allow you to easily organize elements within your system. You use the
filter function to list iSeries native file system objects (such as libraries, objects,
or members). (T, F)

Expanding Work with Libraries corresponds to the command.
a. WRKOBJPDM

b. WRKLIBPDM

¢. WRKMEMPDM

d. All of the above

You can create filters for all connections or for a specific connection. (T, F)

You give your filters a specific name because the Remote System Explorer
saves them for future use, unlike PDM, which does not save filters. (T, F)

filters list a set of objects from your iSeries host in the Remote
Systems view.

a. Job

b. IFS

c. Object
d. Member
e. Library

If you end up with too many filters, you can create filter pools. (T F)
Filters can be specified for non iSeries servers and your local system. (T, F)
User actions can be defined for:

a. iSeries libraries

iSeries objects

iSeries members

iSeries jobs

®oouo

files and folders in any remote UNIX, Windows, Linux, Local or IFS
system

f. All of the above
You can specify a restriction on a user action. (T, F)
You can run OS/400 commands from the:

. iSeries Table View

. iSeries Commands Log

. 1iSeries Error List
. aand b

a
b
c. Tasks view
d
e
f. All of the above

More practice

Given your own libraries on your iSeries system, create a member filter and a job
filter. Then move libraries up, down and within your library list. Finally create a
filter pool. Use the Development Studio Client for iSeries online help to assist you
in these tasks.
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Recap

You have completed [Chapter 6, “Module 6: Exploring Remote System Explorer,’|
You have learned how to:

Know the features of Remote System Explorer
Create a filter to show specific iSeries libraries
Change the filter to add more iSeries libraries

Create a filter to show all the source files in a library
Access members to edit from your filter

Create a user action that copies a source file with data to a new source file in the
same library

Specify user action parameters
Specify a restriction on a user action
Try the user action

Run an OS/400 command from the iSeries Table view

Now that you know how to create filters and actions to manage your iSeries
objects you can learn how to visually design screens. Continue with

[“Module 7. Designing screens,” on page 125
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Chapter 7. Module 7. Designing screens

This module teaches you about the various aspects of the CODE Designer while
modifying a display file to add a screen. You will step through each part of the
CODE Designer tool interface and update some DDS as well. In the workbench, in
the Remote System Explorer perspective you will use the connection that you used
in the module before.

In this module, you will:

Open a DDS member for edit with CODE Designer
Show file-level keywords and record keywords

View the details of records, record-level keywords and field-level keywords
View the design of the payroll application main menu
Create a group from an existing record format

Create a new group and add a subfile record and a subfile control record
Add columns to the subfile record

Add fields to the subfile control record

Copy existing fields

Set indicators to handle field errors

View and update record and field properties

View keywords and the properties of a keyword
Insert a keyword

View help for a keyword

Check there are no semantic errors in the DDS source
View help for an error

Launch the editor in read mode from the error list
Launch the editor in write mode to fix the error

Find a keyword in the source

Save source changes

Compile your source changes

Close the Designer

Exercises

The exercises within this module must be completed in order:

“Exercise 7.1: Opening a DDS member in the Remote Systems view” on page]
126

[“Exercise 7.2: Viewing the DDS tree” on page 127]
[“Exercise 7.3: Selecting the DDS object” on page 128|
[“Exercise 7.4: Designing the DDS screen” on page 129|

[“Exercise 7.5: Creating groups from existing records” on page 130|

[“Exercise 7.6: Creating new screens” on page 132|
[“Exercise 7.7: Adding fields to the subfile record” on page 134|
[“Exercise 7.8: Switching between multiple records” on page 137]

[“Exercise 7.9: Adding field error handling” on page 139
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+ |“Exercise 7.10: Accessing field properties” on page 141

* |“Exercise 7.11: Adding new keywords” on page 143|

» [“Exercise 7.12: Verifying the source changes” on page 145|
* [“Exercise 7.13: Switching between designing and editing the screen” on page 147
* |“Exercise 7.14: Compiling your source changes and closing the Designer” on|

page 148|

Time required

This module will take approximately 30 minutes to complete.

Exercise 7.1: Opening a DDS member in the Remote Systems view

Using an editor to create and maintain DDS source for your display, printer and
physical files can be a frustrating and difficult task. What would be great is a
graphical design tool that let’s you design your screens and reports visually and
then generate the DDS source for you. Well, that’s exactly what CODE Designer
does for you.

CODE Designer helps the novice DDS programmer create screens, reports and
databases quickly and easily without worrying about the details of the DDS
language, while at the same time letting the expert DDS programmer get access to
all the features and power of the language.

Note: Make sure MSTDSP is closed from the previous LPEX Editor exercises.

To open a DDS file member from the Remote Systems view:
1. Expand the Library List filter if it is not already expanded.
2. Expand the QDDSSRC file in library RSELABXX.

W [ EVFEVENT *fle.pf-cta =]
[+ 58 MSTDSP, *file. dspf

& MSTDSP2, *file, dspf

®- 5] PRIMST *file.pf-dta

& E) QCBLLESRC *file.pf-src

- E) QCLSRC *file pf-src

i+ E) QCMDSRC *file, pf-src

B Eﬂ QDDSSRC. *file.pF-src

# Remote Systems LPEX, Editor

3. Right-click the MSTDSP member.
4. Click Open with > CODE Designer on the pop-up menu.

The member MSTDSP will be downloaded to the workstation and loaded into
CODE Designer. CODE Designer is a separate tool not integrated into the
workbench.
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You have opened the DDS source member MSTDSP in the Remote Systems view
using CODE Designer and you are ready to begin |“Exercise 7.2: Viewing the DDS|

Exercise 7.2: Viewing the DDS tree

Before you begin, you must complete [“Exercise 7.1: Opening a DDS member in the|
[Remote Systems view” on page 126

What you are looking at now is basically an explorer view of the DDS. The DDS
Tree view on the left-hand side of the Designer displays the DDS source in its file,
record, field, and keyword hierarchy. It is a familiar and intuitive way to see the
overall structure of the DDS source and to navigate through it quickly. Don’t worry
if you're not a DDS expert, everything will be explained to you.

The DDS Tree shows groups of records, which represent the screens or reports you
are designing, as peers of the file in the tree hierarchy.

In this view, you can create groups, and copy or move keys, keywords, fields, and
records. If any DDS object contains an error, the icon representing it displays a red
X.

To show file-level keywords and the record SELECT in the DDS tree:
1. Expand the <Servername>RSELABXX/QDDSSRC(MSTDSP) folder.
2. Expand the File Keywords folder.

Expand the SELECT record.

Expand the Record Keywords folder.

Expand the EMESS field.

o bk w

[=1-fe= Fils Keywards
. e PRINT
e INDARA
e CAD3
e CADG
| B SELECT
[ Record Keywords
i - T BLINK
: O ALARM
. [#-A 'PRGOY
. @A TimeR...System’
- @@ *oatE
. @A Mainte, . .ection’
- (B rTvE
- B A Enter ...inkain’
. [ EMPARL
- @A ‘Employ...enance’
L3 PRIAPL
- E-A Projec...enance’
[ RSNAPL
. #-A 'Reason...enance'
B EMESS
| Gae DSPATR
. @A F3-End of Job'
[#-48% EMPSEL
-4 EMPMNT
G-4@% PRISEL
-4 PRIMNT
| -4 RSNSEL
| B4 RSNMNT
-3 MaIn_MENU
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The DDS tree now shows you a summary of the file-level keywords and of the
record SELECT.

You have seen the file-level keywords and the record SELECT in the DDS tree and
you are ready to begin [“Exercise 7.3: Selecting the DDS object.”|

Exercise 7.3: Selecting the DDS object

Before you begin, you must complete [“Exercise 7.2: Viewing the DDS tree” on page|
127.

In the upper right-hand side of the Designer is the Workbook with several different
tabbed pages. The Workbook is the area of the CODE Designer where you design
display files, printer or physical files. You can view this notebook on the top
right-hand side of the CODE Designer window. The top page is called Details and
it provides a detailed view of the DDS objects selected by the DDS Tree. You can
view this page in either details mode or list mode by clicking View > List from the
CODE Designer menu.

In the Details page columns display information about the selected DDS object.
You can use this page to display for example, details of all the fields in the record
SELECT or keywords and conditions of a field or record.

The Listing page is a listing of the source statements generated by the Program
Verifier.

In the bottom right-hand side of the Designer is the Utility notebook. This
notebook contains several pages: Selected DDS, Web Settings, Comments and Error
List. The Selected DDS page in the notebook shows the actual DDS source for the
currently selected item.

Note: The Web Settings page allows you to specify attributes that are used by the
WebFacing tool.

To work with the DDS record SELECT:
1. In the DDS tree click the SELECT record.

The Details page lists all the fields in the record SELECT and summarizes some
of their properties. The Selected DDS page shows the DDS for the SELECT
record.

Detalls | MaIN_MENU | Source | Listing|

FRecord SELECT fields
Field | Positi. | Len.. | Type | Shift | Usa... | Sample -
A FRGOT 2.5 5 Text const... PRGOT
A Time R.. System’ 2,30 21 Text const... Time Reporting Spste
[@"DATE 270 6 Date const... MMODAY
A Mairite.._ection’ 330 A Text const... taintenance Selectic
@"TIME 370 6 Time const... HH:MM:55
A Enter .intair 614 54 Text const... Enter an ¥ beside the
[ EMPAPL 9.25 1 Alphanumenc A - Alphanum... Both B
A Employ.. enance’ 9,28 27 Text const... Employee Master Mai
[ PRJAPL 10,25 1 Alphanumenc A -Alphanum.. Both B
A Frojec. enance' 10,28 26 Text const... Project Master Mairte
lﬁl RSNAPL 11,285 1 Alphahumeric A - Alphanum... | Both B . >

2. In the DDS tree click Record keywords immediately below SELECT.
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The Details page shows the current record-level keywords. The Selected DDS
page still shows the DDS for the SELECT record.

Detals IMAIN_MENLI I Source | Listing |
Record SELECT keywords

Kewword | Canditioni... | |
S~ BLINK
T pARM BD

Selected DDS | Create keywoids | Web Settings | Comments | Eror list |

A® 89-03-02 12:07:25 DOUG REL- -
A% THE SELECT FORMAT ALLOWS SELECTION OF
A* MASTER FILE THE OPERATOR WANTS TO MAIL

A R SELECT

A BL]

A& 60 ALZ

A 2 5'FF

A

2 30'Tis
4| | LI_I

3. In the DDS tree click the EMESS field.

The Details page shows its field-level keywords. The Selected DDS page now
shows the DDS for the EMESS field.

Selected DDS | Create kepwords | Web Settings | Comments | Eror lst |

]

A EMESS 502 0O 21 16 ..‘_I
4 B0 DSPATR(HI)

< o

Even this relatively small and simple DDS source member demonstrates how
much easier it is to use the Designer to navigate through your DDS source. The
syntax is being interpreted in intuitive graphical ways making it an ideal tool
for learning DDS. But to get orders of magnitude improvement in your
productivity what you really need is to work with your screens and reports in
a WYSIWYG fashion, completely independent of the DDS required to make
things appear the way they do. You need the Design Page.

You have seen the details of the record SELECT, the record-level keywords and the
field-level keywords and you are ready to begin |“Exercise 7.4: Designing the DDS|

Exercise 7.4: Designing the DDS screen

Before you begin, you must complete [“Exercise 7.3: Selecting the DDS object” on|
iae 128.

You will spend most of your time creating, updating, and designing your DDS
screens and reports in the Design page. The Design pages allow you to design
your screens or reports visually using an intuitive graphical user interface. The
Design page shows the DDS source as it would appear on either a screen (for
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display files) or a printed page (for printer files). It allows you to design your
application’s screens or reports by laying out records and fields in a graphical user
interface.

On the Design page, you can easily create, edit, resize, and move DDS objects
graphically. You can create new records, fields, and constants directly on the
Design page by using the palette push buttons to the left of the Design area or
from the pop-up menus. The toolbar above the Design area allows quick access to
many of the editing features as well as information about the currently selected
object.

1. Click the MAIN-MENU tab in the workbook.

Detais AN MENDY Souce | Listing |
(&) Eserec MERD

| %i Ignore all indicators -

Enter an W beside the ation you vant to naintain

a5k

A
-

In order to understand where MAIN_MENU came from, you need to understand
the concept of a group. A group is simply a collection of one or more DDS records
that represent how a screen or report would be assembled at runtime. It allows
you at development time to work with screens or reports as they would appear
when they get assembled by your programs at runtime. To work with groups in
CODE Designer you need to tell CODE Designer which record formats make up a
screen. In this case this has been done for the screen you see in the Design page. A
group MAIN_MENU has been created for you and CODE Designer has saved this
information in the DDS source in comment lines. Any groups that you create are
persisted as comment lines in the DDS so you can re-use these groups in
subsequent CODE Designer sessions.

5

The groups you create will appear in the tree view as well as in the workbook as a
Design page tab for each group defined, to allow quick access to each group of
records.

You have seen the concept of a group, specifically the MAIN_MENU group and
you are ready to begin [“Exercise 7.5: Creating groups from existing records.”]

Exercise 7.5: Creating groups from existing records

Before you begin, you must complete [“Exercise 7.4: Designing the DDS screen” on|
iae 129,

If you are working with existing DDS, you will want to create groups that will
correspond to how the records are being used. In this example you will create a
group for the next screen, where the user selects which employee in the payroll
database to maintain. The screen is made up of the record format EMPSEL.
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To create a new group:

1.

Scroll to the bottom of the DDS tree and expand the MAIN_MENU group.
The SELECT record appears as the only record in this group.

-8 MAIN_MENU

= @ B

Right-click the MAIN-MENU group.
Click Insert group on the pop-up menu.

A Group Properties notebook opens and a blank Design page for the group
SCREENT also opens.

|| Detas | mane_waen S SEREER P e | Liting |

Group |SEHEEN'I

Available

PRJSEL

Selected

Fat

PRJMNT
= |psN =
Selected DDS | Web Settings | Comment HENE{ENLT _I

o

i i i i

The Properties notebook lets you view and update the properties of the
currently selected DDS object. You can open this notebook from any view,
pop-up menu, or menu of the CODE Designer. The Properties notebook is
modeless. When you change an object’s properties, the selected object changes
immediately.

In the Group Properties notebook, select the EMPSEL record from the Available
list and click the il button.

For simplicity this is the only record you will add for now. The Design page
now shows you what the record EMPSEL looks like.

@EMPSEL EERD .

|gnore all ndicalors

5. In the group field, type EMPL_SELCT over SCREEN1 to rename the group.
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[ Group properties

Basics I Styles |

Group IEMF‘L_SE LCT

21

Available gy, Selected
SELECT EMPSE
EMPMNT "\J
PRJSEL
PRIMNT
RSNSEL
ASHMNT

6. Close the Group properties notebook. Click the X in the top right corner of the

Group properties notebook.

You have finished creating a group. You could now work in the Design page
with the record formats contained in this group. Instead you’ll create a new

record format.

It appears that this is one of those unusable applications where you have to
know the employee number ahead of time instead of being able to browse
what is in the database. What we really need is a subfile. But aren’t those
difficult to code, you ask? Not with CODE Designer.

You have inserted a new group using the existing record EMPSEL and you are

ready to begin [‘Exercise 7.6: Creating new screens.”|

Exercise 7.6: Creating new screens

Before you begin, you must complete [“Exercise 7.5: Creating groups from existing|

[records” on page 130

To create a new record screen on the Design page you need to create a group that

will create an empty page you can work with.

To create a new group:

1. Right-click the new EMPL_SELCT group in the DDS tree.
2. Click Insert group on the pop-up menu.
A Group properties notebook appears and a blank Design page for the group

SCREENT also appears.
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Dot | MAIN_MENU | evP_seLCTCSEREERT)
@y il

j{i arore

[SCREENT
Avvailable Selected
SELECT
PRJSEL 5 |
PRJMNT
RSNSEL
Py RSNMNT _I"<

= e
= i

| i
A

3. Rename the group to EMPL_LIST and close the Group properties notebook.

4. You can create things on the Design page by selecting the appropriate tool from
the palette on the left-hand side and then click on the Design page where you
want it to be created. Right now, most things are disabled in the palette
because there is no record in which to create fields. The only two buttons
available are Create standard record and Create subfile record. If you leave
the mouse over a button for a second or two, flyover help will appear
describing the indicated button.

5. Click the Create subfile record button and then click in the dark gray area.
A subfile and a subfile control record pair are created.
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Details| MAIN_MENU | EMP_SELCT EMPL_UIST | Source | Listing
(&) (Erecorot RED O
@ Ignore all indicators j g

You have created a new record screen and you are ready to begin m
[Adding fields to the subfile record.”|

Exercise 7.7: Adding fields to the subfile record

Before you begin, you must complete [“Exercise 7.6: Creating new screens” on page]

Now you add some columns to the subfile using the Design page. The subfile
should be positioned on row eight. You use the cursor to specify the location of the
part you want to put on the screen, in this case your subfile.

To add fields on the subfile:

1. Click the Create named field button =] and then click somewhere on row 8.

Six fields appear in a vertical column. This is because the subfile you created,
currently specified a SFLPAGE (visible list size) of six.

2. Click the top field and hold the mouse button down and move it to row 8,
column 5.

Note the current row and column appear just above the field as you move it.

3. Move the cursor over to the right edge of the field. It turns into a
double-headed arrow. Hold down the mouse button and move it to the left.
The size of the field will be reduced. The current size will appear just above the
field. When the size is 3, let go of the mouse button.
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The toolbar at the top of the Design page is a very convenient place to monitor
and manipulate the currently selected parts.

4. Rename the record from RECORD1 to EMPLSTSFL and the field from FIELDI to
OPCODE by typing over the text in each list.

@ EERD N EleERE R
‘Z'Igmreall indicatars .El gg@ Y | 0 E Eaﬁﬁ. 4

5. Click the Color palette Bl button and select pink to change the color of the
field.

6. Click the [Z] button to change the usage of the field to input.

[

Now you will create an additional column in the subfile.
Creating an additional output column
Now you want to create an output column.

To create an additional output column:
1. Position the cursor at row 8, column 9.

Note: The bottom right of the CODE Designer window shows the current

83 .

If you can’t see the field with the cursor position on your screen, click the
Maximize button in the top right corner of the screen. You can use the cursor
keys or the mouse to move the cursor.

cursor position

2. If you are creating a long field with an exact length, the SDA syntax can be
easier. Type:

+0(30)

and then press the back arrow (not Backspace!) to select the text you created.
Notice from the Selected DDS page that you have created a text constant
containing +0(30).

3. Click the Convert string to field & button on the toolbar or press F11 to
convert the SDA syntax into a character output field of length 30.

JemPLSTSFL x|l <=

Ilgnue all indicators

|
4. Rename the new field to ENAME using the toolbar. This will show the name of
the employee.
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Details | MAIN_MENU | EMP_SELCT EMPL_LIST |swme] Listing |
7[5 RS R E B ENE E|I|0]B| | ]
‘ﬁl]gﬂorealindicalms = g A [T el

M ([ S — e e e e e e

5. Position the cursor to 8, 41.
6. Now you will add a field for the employee’s salary. Type
$666,666.66

and then press the back arrow.

Now wouldn’t it be better if we could just tell the Designer what we wanted
the number to look like and then have Designer generate all the cryptic
EDTCDESs to make it happen?

7. Press F11 to convert this field into an output numeric field with comma
delimiters, two decimal positions, a currency symbol and no sign. Look at the
Selected DDS page to see what was generated for you. Impressive!

@ @EMF‘L_STSFL

Yl larore allindicators

§6|Ed8d DDgl Web Sel‘lhgs] D:ln'meris] Emor Iisl]
| EA SALARY 8Y 20 8 41EDTCDE(1 Si S

8. Rename the field to SALARY and change its color to yellow, using the toolbar.

9. The subfile seems compacted to the left. It would be better to space it out

evenly. Just select a field and click the space horizontally ¥ button on the far
right side of the toolbar. The other alignment buttons will align fields, left,
right, center and top.

@MEMPLSTSFL =& |4|»| SALARY] . 8 = :[o|B =]
Ellgmreallhdicaturs E@E. | 2 E bt i

™ B
]
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Just below the palette on the left there are three spin buttons. The top one,
Subfile size, specifies the total number of entries in the list that will be filled
in by the application. The second one, Subfile page size, is how many entries
appear on the screen.

10. In the Subfile size field, type 300.

11. In the Subfile page size field, type 9.

12. Click in the Design page.

Delais | MAIN_MENLU | EMPL_SELCT EMPL_LIST iswme| Listing |

@E SEER s (B O
[Z;'Igwc-le all indicatons _'i__;l ’_E

SRR 4--

The Design page is updated accordingly.

You have added some columns to the new subfile record screen and now you are
ready to begin [“Exercise 7.8: Switching between multiple records.”|

Exercise 7.8: Switching between multiple records

Before you begin, you must complete [“Exercise 7.7: Adding fields to the subfile]
[record” on page 134

Now let’s fix up the Subfile control record. The group you created contains 2
records. You can verify this by looking at the record list in the toolbar:

EMPLSTSFL

RECORD1CTL

1. Change the current record by selecting RECORDICTL from the record list or
click next record L] or press Alt+End.

The fields in the subfile still appear so that column heading can be lined up,
but they appear at half-intensity so that they can be distinguished from the
fields of the current record.
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2. Rename the record to EMPLSTCTL using the toolbar. Let’s provide a "Position to’
entry in the subfile control header.

3. Position the cursor at 4, 9 and type:
Position to:

-

Now you need an employee name field.

You could create a named field with the right characteristics like you did in the
subfile, or you could create a source reference using the Create source reference

field 2] button in the palette, or you could reference the original database field
using either the Create database reference field button or the El Create
database reference field(s) by selection &% button. But there is an even simpler
way. Use copy and paste!

Copying the employee name field

To copy the employee name field:
1. In the DDS tree expand the EMPMNT record.
2. Click the ENAME field and press Ctrl+C.
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El L!l <ROS4004 =R SELABXX/QDDSSRC{MSTDSP
[+ o= File Keywords
[+-43% SELECT
eywords
#-A 'PrRGOL
#-A 'Time R...Systen’
1[4 *oaTE
() TE
#-A 'Employ...enance’
#-A 'Number'
I;'_L, EMPNO

B0y
EMCAT
'Department’
EDEPT
‘Location’

ELOCH
'UsSRID!
USRI
‘Mormal, ., hours'
NHRS

ei

=

Time R,
‘Curren..,
' Month.,

Jistory’
. Priot’
. Year

[+ +5H_{f+|¥~¥ ] ¥-}|} +

’hhhlﬁ:’mﬁ:"hﬁ“hﬂﬂ’lﬁj

'Project Related'

(The pop-up menu or Edit menu shows the Copy menu item as well).
3. Position the cursor to 4, 23 and press Ctrl+V. Now that was easy!
4. Click the field and change the name from ENAME to POS_TO.

Detas | MAIN_MENU | EMP?SELE’Fchl Listing |
mL’é!EMPLSTCTL =[=] =] Pos 1JJE3| o H([z]o (=1 i
- E[Z R [BE BT IC(EN |

You have fixed up the subfile records to add an employee name field with a
position to entry opposite this field and you are ready to begin
[Adding field error handling.”]

Exercise 7.9: Adding field error handling

Before you begin, you must complete [“Exercise 7.8: Switching between multiple]
[records” on page 137

Let’s put in some error handling for the ‘position to employee name’ field. If the
employee name is not found in the database, the program will set on indicator 60.
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In this case the field should turn red, reverse image and position the cursor to it.
Now wouldn’t it be better if you had something easier to remember than some
arbitrary number from 1 to 99.

To set indicators:

1. Click the Change named indicator sets #| button on the Design page toolbar

(or press F7.)

The Named indicator sets window opens.

Click Create.

Named indicator sets

)
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In the Settings name field, type: Not Found.
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Select the check box next to 60 and click OK.

The Not found indicator set is now in effect. The Design area is shown as if
indicator 60 was on and all other indicators were off. The Design page toolbar
shows the current indicator set in the Select named indicator set list on the

bottom left.

@EMPLSTCTL

[Fosto =[]
A -

|7 ot Found

:”sﬁldll'
[ = = ) P

Now select the POS_TO field.
On the toolbar, select the color red and the display attributes reverse image

and position cursor. (The set of toolbar buttons representing the current
display attributes is found just below the color button).

The toolbar should look as follows:

E]ms_m v|| El=]

7. Examine the DDS generated in the Selected DDS page.
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Selected DDS |W‘eb Settings | Comments | Erorlist |

A POS_TO R B 4 23
& 60 COLOR(RED)
& REFFLD ( RCEMP~ENAME *LIBL/El
& 90 DSPATR(FR)
& &0 DSPATR(RI)
i 60 DSPATR(PC)
Kl

Notice that all the new keywords were created with a condition of 60. (The
DSPATR(PR) was pasted with the field originally).

8. Now let’s try it out! From the Select named indicator sets list, select All
indicators are off.

@@EMPLSTCTL ~l[E«]#])Pos0 =[] [ & [z]o]8]
e E—-| A~ B |

Wow! This really works!
9. From the Select named indicator sets list, select Not found.

The field appears red and reverse imaged.

You have added error handling to the position to employee name field and you are
ready to begin [“Exercise 7.10: Accessing field properties.”|

Exercise 7.10: Accessing field properties

Before you begin, you must complete [“Exercise 7.9: Adding field error handling”]

Second to the direct manipulation and the toolbar on the Design page, the easiest
and quickest ways of getting access to the properties of a field, record, or entire file
is the Properties notebook.

The Properties notebook lets you view and update the properties of the currently
selected DDS object. You can open this notebook from any view, pop-up menu, or

menu of the CODE Designer.

The Properties notebook is modeless. When you change an object’s properties, the
selected object changes immediately.

You can get to a Properties notebook from the Selected menu, by pressing F4, or
double-click on anything in the DDS tree or the Details page or Design page.

To open the Properties notebook:
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1. In the DDS tree, click the record SELECT and press F4 to see the Record
properties.

20X

| *€ Record properties

,,,,, | CA/CF | Styles |
Record |5ELECT
Type |Standard

Modified ||:BJ"291'92
Mumber of fields [T4 [ Inawindow
Description |

As you select different items, the Properties notebook will continuously update
itself to show you the properties of the selected item.

2. Click the *DATE field in the SELECT record. (You may have to move the
Properties notebook out of the way.) This field has a different set of pages
describing its properties.

= 1_-:_] <R154004 =R SELABKXIC
. 2 File Keywords
{ S s PRINT
G~ INDARA
Lo CADE
i -~ Ome CADG
. -4 SELECT
=] Record Keyword:
O BLINKE
O BLARM
#-A 'PRGOL
A Time R...System
# @
#-A 'Mairte,,.ection’
() *TIME

3. Change the year from 2 to 4 digits. Select the Length of year check box.
4. Select 4 digits from the list.

i Field properties

Basics | Ntthutesl Colar | Ecﬁling| indicatusl

[~ Source of date
v Length of year (&N

Sample
|HM£DDN‘r’~r’Y

~ Position
Size Row  Calumn

2axg0 [ 2E4[ 70
il Hl B

Description |

|

Notice how the sample is updated on the Properties notebook.

5. To test the Design page, click the MAIN_MENU tab in the workbook and look
at the upper right corner of the screen. The year now has 4 digits.

6. Click the EMPAPL field in the SELECT record. On the Field properties
notebook click the Basics tab.
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On this page you can change the field’s name, usage, length, type, and screen
position. The other pages give you quick access to other properties of this field.

g Field properties ) e B

Field
[EMPAPL

e
Lizage Shift
z]olBlHlrM] [a-Aphanmeic =l
Length Position
Total Dec Size  Row  Column

[ H[ & || a0 [ = 585
[~ Continved (CNTFLD) || s 2
=

Width

Description |

l

You have seen the record properties for the record SELECT and changed the length

of year to 4 digits and you are ready to begin [“Exercise 7.11: Adding new|

Exercise 7.11: Adding new keywords

Before you begin, you must complete [“Exercise 7.10: Accessing field properties” onl|
iae 141.

CODE Designer helps you manage the visual aspects of your displays and reports.
But you also need to access the full power of DDS. You need to access keywords.

To add keywords:
1. Click the EMPAPL field in the DDS tree.
2. Press F5 or right-click and click Insert keywords on the pop-up menu.

[ (@) <ROS400A>RSELABRXQDDSSRC(MSTDSP o ||| Details |Mﬁ
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Ler v

o Record Keywords Keypword
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- @[y *oaTE
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e Insert figld 3
] PRIAP

i gcification  Alk+H
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. ) RSMAF
| B-A Reasa Chri+¥
L@ 1 EMESS Copy Chrl+C

You see the Details page for the EMPAPL field and the Create keywords tab is
added to the Utilities notebook. This page shows you the subset of keywords
that are allowed for the selected file, record or field and it takes into account
the field’s type, usage, shift and what record it is in. It is very powerful to
know exactly what your options are. This information cannot be quickly
ascertained from the Reference manual.
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3. With the EMPAPL Properties notebook at the Basics page, click the numeric
field [& button to change the field to numeric type.

{Eﬂﬂ Ofﬂ Atttbutas] Color ] Indcalnrs] Styles]
Field Typ
|EMPAPL | | |
Uzage Shift .
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Notice that the list of keywords in the Create keywords page has changed.

4. Click the el button to change the field back to alphanumeric.

Notice that the list of keywords in the Create keywords page has changed
again.

5. Click the ALIAS keyword and press F1.
The DDS Reference help for the ALIAS keyword appears.
Tip: CODE Designer has lots of on-line help. Press F1 anywhere you want to
see help for an item, icon or notebook. You will see help relevant to what you

are currently trying to do. From the Help menu you have quick access to the
DDS Language Reference as well as several other useful sources of information.
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© Classic iseries tools inforr,
& Remote System Explorer

ALIAS (Alternative Name) Keyword for Display Files

Use this field-level keyword to specify an alternative name for a

field. When the program is compiled, the alternative name is

brought into the program instead of the DDS field name. The high-  —
level language compiler in use determines if the ALIAS name is 1
used. Refer to the appropriate high-level language reference manual
for information about ALIAS support for that language.

The format of the keywaord is:

ALILAS (alternative-name)

< | 2

B | =7 Referto DDS Syntax Rules for ALIAS naming conwventions. :l

6. Minimize the Help window.
7. In the Create keywords page, double-click the INDTXT keyword. (You may

have to scroll to the right to find it).

The keyword is created with default values which can be changed when you
want.

Double-click the INDTXT keyword again.

The keyword is created with the same default values creating a conflict.
_Keyword | Parame...| |

SwEDTCDE 3

Sw|NDTKT '
SwINDTKT '

9. Close the Keyword Properties dialog.

You have seen the help on the ALIAS keyword, added INDTXT keywords and you
are ready to begin [“Exercise 7.12: Verifying the source changes.”|

Exercise 7.12: Verifying the source changes

Before iou begin, you must complete [“Exercise 7.11: Adding new keywords” onl|
page 143,

You have just added a new record and some new fields to your DDS source.
Everything that the CODE Designer adds to your DDS source is certain to have the
correct syntax. Now you need to make sure that there are no semantic errors. You
just introduced one in the last exercise by creating two INDTXT keywords
describing the same indicator.

To verify your source:

1.

Click Tools > Verify file (or click the verify &/ button on the main toolbar) on
the CODE Designer menu.

m <R0OS400A >RSELABXX/QDDSSRC{MSTDSP) - CODE Designer

Fila Edit Wiew Insert Selected Tools Help

P E=0 @)
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The DDS source is checked using the same verifier that the CODE Editor or
LPEX Editor uses. A message appears on the status line at the bottom of the
Designer stating that the verify process completed with errors.

2. In the DDS tree, there is a trail of red x’s leading to the problem.
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T 0= File Keywords

- G EELECT

" om Record Keywords

@A PRGOL

- #-A Time R...System'
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) e

| & A Thploy.. enance'
£ PRIAPL

The file icon has a red x, as does the SELECT record, the EMPAPL field and
finally the second INDTXT keyword.

3. Click the MAIN_MENU tab in the workbook.
The EMPAPL field is highlighted in red.

4. Click the Listing tab in the workbook.
This page shows you the listing generated by the most recent program verify. A
warning message is buried somewhere in the listing but it’s not easy to find.

5. If there are problems, they will show up in the Error list page in the Utility
notebook. It behaves exactly like the Error list in the CODE Editor or LPEX
Editor. Click the Error list tab.

6. Double-click the warning DDS7861 in the Error list. (Press F1 to see detailed
help on the message).

The Source page appears and the cursor is placed exactly where the error is in
the source. The Source page is a tokenized read-only view of the current state
of the DDS source. Read-only? Wouldn't it be great if you could just clear the
error right here. There are some things that are just plain faster in the editor
and many others that are faster in the visual environment. It would be great to
switch between the two modes at the push of a button. Well, let’s just do that.
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You have verified your DDS source and have identified an error in the source and
ou are ready to begin [“Exercise 7.13: Switching between designing and editing the]
_

Exercise 7.13: Switching between designing and editing the screen

Before you begin, you must complete [“Exercise 7.12: Verifying the source changes”|

To switch between the Design mode and the Edit mode:

1. Click the Edit DDS source @1 button or click File > Edit DDS Source from the
Editor menu.
You now have access to the full power of the editor.

2. Explore the Edit and View menu items.

3. Press Ctrl-F to open the Find/Replace window.
4. In the Find field, type INDTXT and click Find.
Editor - Find and Replace _I __)ﬂ
Find £
Replace with |
' Replace this occurrence ¥ Case sensitive
" Replace, then find pext [~ Pattern match
" Replace all occurrences v ¥Yrap
ey
m Replace | Options... I Cancel I Help I

5. Press Ctrl-N to find the next occurrence.
6. Delete the second INDTXT line. Type D in the number column and press Enter.
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You have edited the source to fix the error by switching to the editor and you are
ready to begin [“Exercise 7.14: Compiling your source changes and closing the]

|Designer. ”|

Exercise 7.14: Compiling your source changes and closing the
Designer

Before you begin, you must complete [“Exercise 7.13: Switching between designing]
[and editing the screen” on page 147

Now you will compile the source on the iSeries just as you did in the Remote
Systems LPEX Editor and then close the Designer.

To compile your source:
1. Click File > Save from the Designer menu to save your source to the iSeries.
2. Click Tools > Compile from the Designer menu and then click No prompt (or

click the compile | button on the CODE Designer toolbar).

3. A message indicates when the compile is complete. Click OK in the Message
dialog. If you re-compile and run the payroll program, you will see the 4 digit
year change you made to the opening screen of the program.

Note: You will also see the message CPD7886W Field overlaps another field
with no conditions specified. You can ignore this message.

To close the Designer:
1. Click File > Exit from the Designer menu.

Now you are ready to review your knowledge of this module by taking the quiz.
You can also apply what you have learned in this module by completing the
practice tasks detailed in More practice.

Quiz

1. There is a graphical design tool that let’s you design your screens and reports
visually and then generate the DDS source for you. This tool is named:
a. Page Designer
b. CODE Designer
C. Screen Design Aid
d. None of the above

2. Match the item with its correct description.

Utility notebook

Design page

Properties notebook

Group

Contains several different tabbed pages

For visually designing screens

o ow®oo o

A collection of one or more DDS records that make up a single screen or
report

d. Access properties of a field, record, or entire file
3. The Utility notebook contains:
a. Selected DDS page
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Error List page
Web Settings page
Comments page

. All of the above

4. On the Design page, you can easily:
Create DDS objects
Edit DDS objects
Resize DDS objects
Move DDS objects
Create records
Create fields
Create constants

h. All of the above

5. Grouping records together allows you to work on one record while still seeing
the related records in the background. (T, F)

6. The Properties notebook is modeless. When you change an object’s properties,
the selected object changes immediately. (T, F)

7. The DDS source is checked using the same verifier that the LPEX Editor or
CODE Editor uses. (T, F)

8. You can switch between design mode and edit mode in CODE Designer. (T F)

©®aoo

@ "o o0 TP

9. You can compile source on the iSeries just as you do in the LPEX Editor. (T, F)
More practice

Given your experience in using the CODE Designer from the Remote Systems
view, try creating a printer report. You can use the physical file specification
REFMST in member QDDSSRC in library RSELABXX. Take time to explore the
fields and information for this physical file. You may want to refer back to the
exercises in this module as you create your report. When you are familiar with the
file REFMST, you can create your printer file. Use the product online help to assist
you in this task.

Module recap

You have completed [Chapter 7, “Module 7. Designing screens,” on page 125 You
have learned how to:

* Open a DDS member for edit with CODE Designer

* Show file-level keywords and record-level keywords

* View the details of records, record-level keywords and field-level keywords
* View the design of the payroll application main menu

¢ Create a group from an existing record format

* Create a new group and add a subfile record and a subfile control record

¢ Add columns to the subfile record

* Add fields to the subfile control record

» Copy existing fields

* Set indicators to handle field errors

* View and update record and field properties

* View keywords and the properties of a keyword
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* Insert a keyword

* View help for a keyword

¢ Check there are no semantic errors in the DDS source
* View help for an error

* Launch the editor in read mode from the error list

e Launch the editor in write mode to fix the error

* Find a keyword in the source

* Save source changes

* Compile your source changes

* Close the Designer

You have learned about various aspects of the CODE Designer while modifying a
display file and now can learn more about the product and how it is packaged.
This is an optional module. Continue to [Chapter 8, “Module 8. Introducing the]
[product and Remote System Explorer (optional),” on page 151
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Chapter 8. Module 8. Introducing the product and Remote
System Explorer (optional)

This modules teaches you about IBM WebSphere Development Studio for iSeries
and its relationship to IBM WebSphere Development Studio Client for iSeries. You
learn which product makes up the host components and which product makes up
the workstation components. You recognize the iSeries application development
tools included with Development Studio Client for iSeries programmers. You then
are introduced to Remote System Explorer the launching point for iSeries
application development tools.

In this module, you will:

* Know the goals of the product

* Know the editions of the product

* Identify the host tools and the client tools

 List and describe the iSeries application development tools

Exercises

The exercises within this module must be completed in order:

* |“Introducing Development Studio and Development Studio Client”]

* |“Introducing iSeries Application Development Tools” on page 152

Time required

This module will take approximately 15 minutes to complete.

Introducing Development Studio and Development Studio Client

Development Studio Client is the ideal set of workstation development tools for
creating, testing, deploying and maintaining traditional and e-business applications
for your iSeries server. Development Studio Client is included with the
compiler-based server product, WebSphere Development Studio. The following
diagram illustrates the interaction between host and client tools:
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Development Studio Client is designed to help you:

1. Develop and maintain iSeries applications using the Remote System Explorer.
2. Develop Web-enabled front-ends to iSeries business logic.

3. Create GUI front-ends to iSeries business logic.

Both Development Studio Client and Development Studio Client Advanced Edition
are built on the Rational Software Development Platform. This platform offers a
fresh look and feel for the Eclipse workbench, and helps make it easier for you to
build, integrate, and extend your applications. The Rational Software Development
Platform offers a tutorials gallery and a samples gallery, to help you get up and
running with the product as quickly as possible. The platform also offers user
roles, which you can select from bottom-right corner of the Welcome view, (and
from Window > Preferences > Workbench > Capabilities) that customize and
simplify the user interface according to your programming role. These are just
some of the new features provided in the Rational Software Development Platform.

The product comes in two editions for iSeries programmers. Both editions of the
product are packaged with an additional base Rational product:

* Development Studio Client is packaged with Rational Web Developer. Rational
Web Developer includes support for Web services, XML development tools, and
core support for Java and Web development tools.

* Development Studio Client Advanced Edition is packaged with Rational
Application Developer. This base product provides end-to-end support for the
creation and maintenance of J2EE applications and Web services. It also provides
extensive support for Enterprise JavaBeans, EGL, and for Java messaging
services

You have reviewed the goals of the product and the product editions and you are
ready to begin [“Introducing iSeries Application Development Tools.”]

Introducing iSeries Application Development Tools

Before you begin, you must complete [“Introducing Development Studio and|
[Development Studio Client” on page 151
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Now, you know what the two flavors are of Development Studio Client and why
you would want to use each one. Next let’s look at those next generation iSeries
server application development tools. What are they and what do they do?

Remote System Explorer

You can manage your development tasks in the Remote System Explorer. This is an
enhanced and more flexible workstation version of Program Development Manager
(PDM). You can create and manage development projects on your iSeries system
from your Windows-based workstation with the Remote System Explorer and
iSeries projects. With these tools, you can connect to an iSeries remote host, view
iSeries libraries, files, and members. You can also launch the host compilers, the
workstation editor, a program verifier and various debuggers all from the Remote
System Explorer. This tool also supports other system types, such as UNIX(R),
Linux, and Windows.

LPEX Editor

Your program editing tasks are simplified with the Remote Systems LPEX Editor.
This is a powerful language-sensitive editor that you can customize. Token
highlighting of source makes the various program elements stand out. It has
SEU-like specification prompts for RPG and DDS to help enter column-sensitive
fields. Local syntax checking and semantic verification for your RPG, COBOL and
DDS source makes sure it will compile without errors on an iSeries system. If there
are verification errors, an Error List lets you locate and resolve problems quickly.
On-line programming guides, language references, and context-sensitive help make
finding the information you need just a keystroke away.

Shells and commands in the Remote Commands view

You can use the Remote Commands view to run and interact with commands and
command shells on universal systems. A universal system includes Windows,
Linux, and UNIX system types. Specifically, you use the view to:

* Run commands in a command shell
 Display and interpret the output of a program
* Enter input to a program

¢ Display and manage different commands and shells from the same view.
Multiple commands can be run in a single shell (one command at a time per
shell), multiple shells may be run on a single system, and multiple systems may
be running shells.

Whenever a command shell is launched or a command is run from the Remote
System Explorer, the Remote Commands view displays the output and provides a
way to work with that output.

Program Verifier

One of the most powerful and unique features of the Remote System Explorer is
the Program Verifier. Before you compile your code on an iSeries system, you can
ensure that there are no errors by invoking the Program Verifier. The verifier
checks for semantic (compile) errors on your workstation so that you can
guarantee a clean compile on the iSeries. Think of the host cycles you'll save. It is
especially handy when you are writing code but you are disconnected from an
iSeries system. You can do this because Remote System Explorer ported the parsing
and checking code from the iSeries host compilers to the workstation. The Error
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List window lists the errors that are found and their severity, inserts the error
messages directly into the source and helps you to navigate between the errors.

iSeries Debugger

With the Integrated iSeries debugger you can debug an application that is running
on an iSeries system. It provides an interactive graphical interface that makes it
easy to debug and test your iSeries programs. It is fully integrated into the
workbench. You can also set breakpoints before running the debugger, by inserting
breakpoints directly in your source while editing. The Integrated iSeries debugger
client user interface also enables you to control program execution. For example,
you can run your program, set line, watch, and service entry point breakpoints,
step through program instructions, examine variables, and examine the call stack.
You can also debug multiple applications, which may be written in different
languages, from a single debug window. Each session you debug is listed
separately in the Debug view.

CODE Designer

Using an editor to create and maintain DDS source for your display and printer
files can be a frustrating and difficult task. What would be great is a graphical
design tool that lets you design your screens and reports visually and then
generate the DDS source for you. Well, that’s exactly what the CODE Designer
does for you.

The CODE Designer interface was designed to help the novice DDS programmer
create screens, reports and databases quickly and easily without worrying about
the details of the DDS language, while at the same time letting the expert DDS
programmer get access to all the features and power of the language. CODE
Designer is not fully integrated into the workbench, but you can launch it as a
separate tool from the workbench.

You have identified the host tools and the client tools as well as the iSeries
application development tools and now you are ready to review your knowledge
of this module by taking the quiz.

Quiz
1. WebSphere Development Studio for iSeries:
a. Includes all four host compilers

b. Includes all four host compilers and the workstation-based tools named
Development Studio Client

c. Includes only the workstation-based tools named Development Studio
Client

2. WebSphere Development Studio Client for iSeries includes:
a. Rational Web Developer

b. Cooperative development environment (CODE)
c. VisualAge® RPG

d. Java tools

e. Web tools

f. WebFacing tool
g. All of the above
3. WebSphere Development Studio Client for iSeries Advanced includes:
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10.

11.

a. Rational Application Developer

b. Cooperative development environment (CODE)
c. VisualAge RPG

d. Java tools

e. Web Tools

f. WebFacing Tool

g. All of the above

Rational Application Developer includes support for:
Creation and maintenance of J2EE applications
Creation and maintenance of Web services
Enterprise Java Beans

Java Messaging Services

All of the above

Rational Web Developer includes support for:

®© o 0 T o

. Web services
. XML development tools

. Web tools
. All of the above

The editor can access source files on your workstation or on your iSeries
system directly. When a compilation or verify action results in errors, you can
jump from the compiler messages to an editor containing the source. The
editor opens with the cursor positioned at the offending source statements so
that you can correct them. (T, F)

a
b
c. Java tools
d
e

You can debug your program running on the iSeries system from your
workstation using the Integrated iSeries Debugger. (T, F)

Before you compile your code on an iSeries system, you can ensure that there
are no errors by invoking the:

a. The Remote System Explorer

b. CODE Designer

c. The IBM WebFacing tool

d. The LPEX Editor

e. The Integrated iSeries Debugger

f. Program Verifier

You can use the Remote Commands view to:
. Run commands in a command shell

. Display and interpret the output of a program

. Display and manage different commands and shells from the same view
. All of the above
The Integrated iSeries Debugger enables you to run your program, set line,

watch, and service entry point breakpoints, step through program instructions,
examine variables, and examine the call stack. (T, F)

a
b
c. Enter input to a program
d
e

The graphical design tool that lets you design your screens and reports
visually and then generates DDS source for you is:

a. The Remote System Explorer
b. CODE Designer
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c. The IBM WebFacing tool
d. The LPEX Editor
e. The Integrated iSeries Debugger

Module recap

You have completed [Chapter 8, “Module 8. Introducing the product and Remote|
[System Explorer (optional),” on page 151 You should now understand:

* What components make up Development Studio and Development Studio Client
editions

* What components are included in Rational Application Developer and Rational
Web Developer

* What tools you use to manage your development cycle tasks
* What the benefits are of Remote System Explorer

Finish your tutorial by reviewing the materials in [Chapter 9, “Summary,” on page|
157.
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Chapter 9. Summary

This tutorial has taught you how to maintain a payroll application using the
Remote System Explorer. You learned how to start the product and open the
Remote System Explorer perspective and how to use tools and views in this

perspective to connect to an iSeries system and edit, verify, compile and debug the

payroll application.
Completed Learning Objectives

If you have completed all of the modules, you should now be able to:
e Start the product and open the Remote System Explorer perspective

* Create a connection to an iSeries and select iSeries objects from this connection

¢ Use the Remote Systems LPEX Editor to edit source

* Verify and compile source in the Remote Systems LPEX Editor

* Debug your interactive payroll application from the workstation
* Modify a display file

* Recognize the product features and packaging

More information

For more information on the product and the Remote System Explorer, see
http:/ /ibm.com/software/awdtools/iseries.

Quiz answers

Here are the answers to each module quiz.

1 2 3 4 5 6 7 8
1d 1c 1d 1d 1c 1d 1b 1b
2e 2e 2T 2d 2T 2¢c 2 aa, bb, |2g
cd, de
3b 3e 3a 3g 3e 3T 3e 3g
4 aa, bd, |4c 4T 4T 4c 4b 4h 4e
cb, dc
5e 5T 5d 5T 5¢ 5T 5T 5e
6T 6¢ 6d 6T 6T 6T 6T
7d 7b 7e 7e 7c 7T 7T
8c 8T 8T 8T 8T 8f
9c 9a 9T 9T 9e
10a 10a 10f 10T
11b 11T 11b
12T 12e
13d
14e
15d
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16c

17b

18c

19T

20T

158 Development Studio Client: RPG application




Appendix. Notices

Note to U.S. Government Users Restricted Rights — Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM Canada Ltd. Laboratory
8200 Warden Avenue
Markham, Ontario

Canada

L6G 1C7

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1992, 2005. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.
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However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks

IBM

iSeries
0S/400
RPG/400
Rational
VisualAge
WebSphere

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows
NT®, Win32, Win32s and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group.

Linux is a registered trademark of Linus Torvalds.

Other company, product, and service names may be trademarks or service marks
of others.
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